
Make sure you check for updates to this manual at the 
Oracle Technology Network (OTN) Web Site

Agile Analytics for
Product Portfolio Management &
Product Quality Management
User’s Guide
Release 2.1.1
Part Number: TP1654-2.1.1B  



Agile Analytics 2.1.1

ii PPM & PQM User’s Guide

Copyrights and Trademarks
Copyright © 1995-2007 Oracle. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information; they are provided 
under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other 
intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the 
extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the 
documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be 
expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted 
in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the 
United States Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal 
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and 
adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth 
in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, 
Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 
94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous 
applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to 
ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages 
caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their 
respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not 
responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of 
such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and 
the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms 
of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased 
products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any 
third party.

August 15, 2007   



-iii



iv

REVISIONS

Revision Date Pages Affected Description

A 07/13/2007 All Initial release of documentation. 

B 08/15/2007 Several Updated changes.



-v



Agile Analytics 2.1.1

vi PPM & PQM User’s Guide



vii

Preface
Agile PQM Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi

Readme . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi
Agile Training . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi
Developer Documentation and Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi

Chapter 1 Introduction

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Agile Analytics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Agile Analytics Window & Buttons Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Tips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

General Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
Workspace Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
Folder Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

Chapter 2 Agile PPM Analytics

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
PPM Analytic Measures and Dimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1

Discussion and Action Item Measures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Finance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3

How Cost Values are Calculated in the Finance Measures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Portfolio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Resource  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5
Time-to-Market  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

Sample Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Capital Cost Performance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Financial Overview — Budget Vs. Actual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Financial Overview — Cost Variances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10
Financial Overview — Portfolio Factors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Fixed Cost Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
Resource  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13

Portfolio Headcount Consumption  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13
Portfolio Trend Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-14

Resource Pools — Bill & Cost Rates Vs. Headcount . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15
Time-to-Market by Region & Quarter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-16

Chapter 3 Agile PQM Analytics

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
PRs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
NCRs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
CAPAs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Audits. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Predefined PQM Analytics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
PQM Analytic Measures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

Volume  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

CONTENTS



Agile Analytics 2.1.1

viii PPM & PQM User’s Guide

Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
Cycle Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5
Cycle Time Average . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5
Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

Measurement Name Mapping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Problem Report Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Number Of Requests  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
New Requests  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
In Process  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Closed  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-12
Failure Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13
Cycle Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14

Supplier/Customer Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
Activity  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
Overdue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-16
Expected Resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-17
Response Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-18
Breakdown By Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
Days Open. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20

Extending Agile PQM Analytics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21
Units Shipped . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21
Cost Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
Cost  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-23

Chapter 4 Setting Up Analytic Reports

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1
Data Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2

Disregarding Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Drill Down  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Custom Drill Down . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Drill Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Swap Axes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4
Pivot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5

Charting Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5
Formatting Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7

Legend . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-8
Title  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9
Footnote  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-10
X-Axis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-11
Y1-Axis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-12
Data Series. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-13

Undo/Redo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-14
Explore By. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-14
Chart Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-16

Trendlines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-17
Add Trendlines For A Series  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-19

Chart Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-20
Chart Types & Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-22

Chart Type Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-22
Axes Placement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-23
Data Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-24



Contents

ix

Types Of Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-24

Appendix A Workspaces
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Working With Workspaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

Viewing a Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Creating A Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3

Adding/Deleting Comments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
Adding A Recipient. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-5
Recipient Feature Access. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-6
Sharing Dimensions And Axes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7

Editing A Workspace  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-15
Organizing Workspaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-16
Sorting Workspaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-16
Deleting A Workspace  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17
Deleting Multiple Workspaces. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17

Configuring A Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17
Creating A Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-18

Workspace Summary Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-18
Edit Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-18

Create Selection Window Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19
Creating A Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-20

Selecting Dimension Members  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-21
Selecting Members By Applying Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-26
Defining Pane Properties And Previewing the Layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-57

Editing A Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-60
Editing Member Selections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-60
Editing Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-60
Editing The Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-62
Deleting An Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-62

Synchronizing A Workspace With Changes In The Agile Analytics Model  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-62
Runtime Grid Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-66

Working With Pages And Panes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-66
Inserting A Page/Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-67
Defining Pane Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-68
Modifying Page/Pane Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-70
Deleting a Page/Pane  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-70

Setting Printing Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-70
Working With Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-76

Creating an On-demand Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-76
Creating A Scheduled Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-77
Changing A Scheduled Report To On-demand Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-82

Defining Advanced Runtime Grid Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-82
Setting Page Filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-83
Showing Lookup Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-83
Showing Images On The Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-84
Selecting A Date  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-89
Working With Auto Execute Feature. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-89
Specifying Cell Value Colors And Cell Highlights . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-95
Viewing the Grid Based on Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-96
Improved Data Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-97
Creating Calculated Members . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-98
Selecting Cells Across A Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-99
Using Change Rules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-99

Creating A Dynamic Member . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-106
Working with Adding Members to the Database Using the RPM Application . . . . . . . . . . . . . . . . . . . . . . . . A-106

Custom Measures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-114



Agile Analytics 2.1.1

x PPM & PQM User’s Guide

Adding Custom Measures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-114
Using Arithmetic Functions in a Custom Calculation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-115

Grid Data Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-117
Working With Grid Data Filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-118
Applying A Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-118
Removing A Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-119
Example - Using RPM Grid Data Filters to Analyze Sales Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-119

Save Changes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-122
Canceling A Query . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-123

Toolbar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-124
Common Toolbar Buttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-125

Collaborate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-125
Execute . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-126
Export to Data File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-126
Export to Excel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-128
Export to PowerPoint . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-129
Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-129
Refresh All . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-132
Save. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-132
Save As . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-132
Workspace Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-132

Pane-Specific Toolbar Buttons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-132
Calculator  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-133
Create Alert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-134
Deleting an Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-135
Display Grid and Chart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-136
Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-138
Editing an Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-138
Execute Change Rule  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-138
Import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-138
Manage Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-141
Rank . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-143
Refresh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-147
Refresh Auto On/Off. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-147
Remove UEVs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-148
Sort . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-148
Toggle Report Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-154
Toggle Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-155



xi

PREFACE

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web 
site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on 
your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be 
downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web 
Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on 
the www.agile.com/support.
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assistance.
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number, which is located on the title page.

Readme
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CHAPTER 1
Introduction

This chapter provides an overview of workspaces and general functions of the reports associated with Agile 
Analytics for Product Portfolio Management  and Product Quality Management. It contains the following 
sections:
❑ Overview
❑ Agile Analytics
❑ Agile Analytics Window & Buttons Descriptions
❑ Tips

Overview
The Agile Analytics model is a multidimensional data source. It contains facts (data) organized by different 
dimensions to provide faster retrieval and drill-down capability.

A fact is a metric or a performance indicator associated with a given business process that is quantifiable and used to 
determine how well a business is operating. The aggregated data you need to examine are called facts — numeric 
values that are measurable and additive.

Just tracking facts isn't enough, however; you need to examine the facts under certain conditions. These “by” 
conditions are called dimensions. Dimensions are often time-based, for example, you can examine facts by month, 
quarter, or year. In addition, you can examine facts by geography or by product. Dimensions can have a hierarchy 
that allows you to perform drill down functions on the data. For instance, you can start by analyzing the number of 
problem reports by time such as year, quarter, month and day.

Agile Analytics
Agile Analytics is a Web-based client that allows users to analyze the Agile Analytics data measures by slicing various 
dimensions in producing data views and exploring models and reports.  

Appendix A in this guide also provides information about working with workspaces. It includes:     

❑ Drilling down and up

❑ Using the data filter display 

❑ Sorting, ranking, and exporting data

❑ Printing reports

❑ Collaborating with other users

❑ Toggling between grids and charts, report information, and other toolbars
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Agile Analytics Window & Buttons Descriptions
The Agile Analytics user interface easily allows you to filter values for the report, change the focus of the data, drag-
and-drop categories onto the report, change the active measure, drill deeper to underlying details, and adjust the 
display format.    

Figure 1-1: Agile Analytics Window           

Agile Analytics lets you view and work with model data in a Web browser. Figure 1-1 highlights the following areas 
of the Agile Analytics user interface:

❑ Dimension Line filters what appears or changes the focus of the report.  The dimension line appears at the top 
of the window, the display is in the middle, and the toolbar is across the bottom of the window. If you are using 
Microsoft Internet Explorer, a dimension viewer appears in the left pane. 

❑ Measures Area changes the way the active measure appear, as values or as a percentage of row or column totals.

❑ Toolbar changes the display format and apply more advanced features like expression highlighting, pareto 
filtering, or zero suppression.

Note For detailed information about how to use all Agile Analytics features, click Help  in the application 
window to open Agile’s Web Help. Use the contents or index to find the topic you want.

❑ Common toolbar - The common toolbar contains buttons that provide quick access to specific functions and 
commonly used features within the application. For details on the buttons on the common toolbar, see 
“Common Toolbar Buttons” on page A-125.

❑ Pane-specific toolbar  - The pane-specific toolbar contains a set of buttons that enable you to manipulate the data 
representation on the grid. For details on the functionality of the buttons, see the following table. For details on 
the buttons on the pane-specific toolbar, see “Pane-Specific Toolbar Buttons” on page A-132.

The following table provides a description for all buttons.      

Table A-2: Toolbar Buttons

Button Name Description

AutoSum  Summation of all the data values of the selected dimension member.

 
Calculator  Perform calculations

 
Collaborate  The Collaborate icon is displayed on the workspace grid. A new Message associated to 

the Workspace is launched with the workspace attached to the message.

 
Create Alert  Send a message to all Agile PLM users.
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Data Filter Display On/Off  Displays the filters on the grid. 

Display Grid and Chart  Display grid and chart

 
Edit Report  Allows you to change a report.

Execute  Run all formulas or retieve data. 

 
Export to Data File  Export the report data into a file that can be imported into a database.

 
Export to Excel  Exports the report data into an Excel spreadsheet. The formula associated to the report 

are not copied into the Excel spreadsheet. 

Export to PowerPoint  Exports the report data into Power Point.  

 Import  Retrieves data from a specified location.

 Print  Formats and prints the active report using the Print menu on the browser. You can also 
save the PDF and HTML file in your local computer. 

 
Rank  Rearrange the members of dimensions in a workspace grid by ranking.    

 
Refresh  Recalculates and reloads the grid/chart after entering UEVs. Any alerts triggered in a 

report also appear. 

 Refresh All  Refreshes all panes for a selected page in workspace runtime. 

 
Refresh Auto On/Off  Automatically fetches and refreshes the data values to the report after every operation on 

the grid. 

Remove UEVs  Removes user-entered values.

 Save  Saves the workspace with its current name. 

 Save As  Allows you to rename the workspace with a new name. 

 
Sort  Rearrange the members of dimensions in a workspace grid by sorting. 

 Text  Allows you to enter text into a specified location.

 Toggle Chart  Displays or hides the chart view. This button behaves in toggle mode. 

 
Toggle Grid  Displays or hides the grid view. This button behaves in toggle mode.     

  
Toggle Report Information  Displays report information on the grid. 

  
Toggle Toolbar  Enables you to show or hide the toolbar. 

 Workspace Properties  Defines the attibutes for the specified workspace.

Table A-2: Toolbar Buttons (continued)

Button Name Description
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The appearance of the buttons on the pane-specific toolbar is based on the editable nature of the grid. The following 
buttons appear on the pane-specific toolbar:

       

When the report is resized, all the pane-specific buttons may not appear in the toolbar. The hidden buttons are listed 
in the Hidden Tools drop-down list. Click the Hidden Tools drop-down list arrow  to view all the hidden pane-specific 
toolbar options.        

       

Click on the Hidden Tools drop-down list arrow  to view all the hidden pane-specific toolbar options.

Select the required option from the drop-down list menu.

Note Selecting the Toggle Toolbar option, will hide all the pane-specific toolbar buttons.

For more information about workspace windows, see “Working With Workspaces”on page A-1. For information 
about the buttons that appear in the windows, see “Toolbar Buttons”on page A-124.

Tips
There are several basic tips you should follow while working with Agile Analytics.

General Use

While working in the Workspace pane:

❑ Do not use the browser’s Back or Forward buttons

❑ Do not use the browser’s Refresh button or refresh by pressing the F5 function key

❑ Do not close the browser — always log out

Workspace Management

Workspaces can be assigned the same name. However, you should always try to keep workspace names unique to 
ensure that users are not confused about using the correct workspace. 
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Folder Management

General folder requirements are as follows:

❑ The rules for creating and using folders are the same as those that apply to other features of the application (such 
as alerts and collaboration).

❑ Folders are chronological. Keep this in mind while naming and organizing them. (“Various Reports” is a good 
folder to include at the bottom of the list.)

❑ Folders can only be edited or deleted by the user that created them.

❑ Folders must be empty before they can be deleted.

❑ Folder security is handled by the folder type:

• Public folders can be viewed by all users.

• Private folders can be viewed only by the assigned groups/users.
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CHAPTER 2
Agile PPM Analytics

This chapter introduces the models included with Agile PLM Analytics. It has the following sections: 
❑ Overview
❑ PPM Analytic Measures and Dimensions
❑ Sample Reports

Overview
The Agile Analytics model is a multidimensional data source. It contains measures (data) organized by different 
dimensions to provide faster retrieval and drill-down capability.

A measure is a metric or a performance indicator associated with a given business process that is quantifiable and 
used to determine how well a business is operating. The aggregated data you need to examine are called measures — 
numeric values that are measurable and additive.

Just tracking measures isn't enough, however; you need to examine the measures under certain conditions. These 
“by” conditions are called dimensions. Dimensions are often time-based, for example, you can examine measures 
by month, quarter, or year. In addition, you can examine measures by geography or by product. Dimensions can 
have a hierarchy that allows you to perform drill down functions on the data. For instance, you can start by analyzing 
the number of problem reports by time such as year, quarter, month and day.

Note This user guide discusses the Agile Analytics models and PPM Analytics reports. The models and PPM 
Analytics reports used at your company may have been modified to meet your company’s specific 
requirements.  

PPM Analytic Measures and Dimensions
Table 2-1 through Table 2-11 list the measures and dimensions that are available for clarifying data output.  

❑ Discussion and Action Items

❑ Finance

❑ Portfolio

❑ Resource

❑ Time-to-market



Agile Analytics 2.1.1

2-2 PPM & PQM User’s Guide

Discussion and Action Item Measures

Table 2-1 lists the Discussion and Action Items measures, the source (the Agile object attribute from which the 
measure is derived), or the calculation used to compute the measure. The Rollup column indicates the type of 
calculation, for example, whether the calculation is an average or a count.          

Table 2-2 lists the Discussion and Action Items dimensions, the source (the Agile object attribute that defines the 
dimension), and a comment, if appropriate.        

Table 2-1: Discussion and Action Item Measures       

Measure Calculation/Source Rollup

Discussion Time to Resolution For Discussions with status = closed:

(Program | Discussions | Close Date) - (Program | 
Discussions | Create Date)

Average

Number of Discussions This metric is the number of Discussions by 
dimension, such as root program or region. It does not 
include replies

Count

Number of Action Items This metric is the number of action items. When 
counting the number of action items on a program, it 
considers all levels of the hierarchy and includes action 
items related to discussions on the program as well as 
action items only created on the discussion tab’s action 
item component.

Count

Table 2-2: Discussion and Action Items Dimensions     

Dimension Source Comments

Root Program All Programs | General Info | Names where Program | 
General Info | Parent is NULL

Discussion Priority Program | Discussion | Priority

Activity Name Activity | General Info | Name  

Program Status Program | General Info | Status

Program Type Program | General Info | Program Type Dashboard field

Region Program | General Info | Region Dashboard field

Division Program | General Info | Division Dashboard field

Product Line Program | General Info | Product Line Dashboard field

Customer Program | General Info | Customer Dashboard field

Launch Year Program | General Info | Launch Year Dashboard field

Discussion Status Program | Discussion | Status

Discussion Create Date Program | Discussion | Create Date

Discussion Close Date Program | Discussion | Close Date

Discussion Creator Program | Discussion | Creator

Discussion Type Program | Discussion | Type To capture sub-classes of discussions for 
analysis.

Action Items Status Program | Action Items | Status

Action Item Assigned Program | Action Items | Assigned To

Action Items Due Date Program | Action Items | Due Date

Activities Type Program | General Info | Activities Classifies activities as programs, phases, 
tasks, gates or any sub-class.
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Finance

Table 2-3 lists the Finance measures, the source (the Agile object attribute from which the measure is derived) or the 
calculation used to compute the measure. For example, the Rollup column indicates the type of calculation and 
whether the calculation is an average or a count.      

Table 2-4 lists the Finance dimensions, the source (the Agile object attribute that defines the dimension) and, if 
appropriate, a comment.      

Table 2-3: Finance Measures        

Measure Calculation/Source Rollup

Revenue Forecast Flex Field for Revenue Forecast on root program Sum

Budgeted Labor Cost Program | General Info | Budgeted Labor Cost Sum

Estimated Labor Cost at 
Completion

Program | General Info | Estimated Labor Cost to Completion + Program | 
General Info | Actual Labor Cost

Sum

Actual Labor Costs Program | General Info | Actual Labor Cost Sum

Labor Cost Variance Budgeted Labor Cost - (Actual Labor Costs + Estimated Labor Cost to 
Completion)

Sum

Budgeted Fixed Cost Program | General Info | Budgeted Fixed Cost Sum

Estimated Fixed Cost at 
Completion

Program | General Info | Estimated Fixed Cost to Completion + Program | 
General Info | Actual Fixed Cost

Sum

Actual Fixed Costs Program | General Info | Actual Fixed Cost Sum

Fixed Cost Variance Budgeted Fixed Cost - (Actual Fixed Costs + Estimated Fixed Cost to 
Completion)

Sum

Budgeted Capital Cost Program | General Info | Budgeted Capital Cost Sum

Estimated Capital Cost at 
Completion

Program | General Info | Estimated Capital Cost to Completion + Program 
| General Info | Actual Capital Cost

Sum

Actual Capital Cost Program | General Info | Actual Capital Cost Sum

Capital Cost Variance Budgeted Capital Cost - (Actual Capital Cost + Estimated Capital Cost to 
Completion)

Sum

Total Budgeted Costs Budgeted Labor Cost + Budgeted Fixed Cost + Budgeted Capital Cost Sum

Total Actual Costs Actual Labor Cost + Actual Fixed Cost + Actual Capital Cost Sum

Table 2-4: Finance Dimensions  

Dimension Source Comments

Root Program All Program | General Info | Names where Program | 
General Info | Parent is NULL 

Schedule Start Date Program | General Info | Schedule Start Date  

Program Type Program | General Info | Program Type Dashboard field

Region Program | General Info | Region Dashboard field

Division Program | General Info | Division Dashboard field

Product Line Program | General Info | Product Line Dashboard field

Customer Program | General Info | Customer Dashboard field

Launch Year Program | General Info | Launch Year Dashboard field

Status Program | General Info | Status Workflow status

Actual Start Date Program | General Info | Actual Start Date

Actual End Date Program | General Info | Actual End Date
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How Cost Values are Calculated in the Finance Measures

Program costs and revenue forecasts are automatically multiplied by the number of program types, regions, 
divisions, product lines, and launch years specified for a program. The Program Type, Region, Division, Product 
Line, and Launch Year fields are MultiList data type, so multiple values can be selected for them. If you select 
multiple values for any of these fields, your costs increase proportionately. For instance, if you select two values for 
Region, your total costs are doubled. Keep this in mind when you enter costs and revenue forecasts for a program, 
and when you use the Financials model and any reports based on it.

For example, let’s say that three programs, A, B, and C, have the same revenue forecast, $1000. However, the total 
revenue forecast for the programs differ because different regions and divisions have been selected for each.

❑ Program A is in the North America region and the Automotive division, so its total revenue forecast is $1000. 

❑ Program B is in the Europe region and the Automotive and Electronics divisions, so its total revenue forecast is 
$2000.

❑ Program C is in the North America and Europe regions and the Automotive and Electronics divisions, so its total 
revenue forecast is $4000.

Table 2-5 illustrates how the revenue forecast values are calculated for the three sample programs.        

Note If you don’t want costs multiplied by the number of values selected for the Program Type, Region, 
Division, Product Line, and Launch Year fields, try to limit those fields to only one selected value.

Portfolio

Table 2-8 and  Table 2-9 list the Portfolio measures and dimensions, respectively.      

Table 2-6 lists the Portfolio measures, the source (the Agile object attribute from which the measure is derived) or 
the calculation used to compute the measure. The Rollup column indicates the type of calculation, for example, 
whether the calculation is an average or a count.       

Schedule End Date Program | General Info | Schedule End Date

Activities Type Program | General Info | Activities Type Classifies activities as programs, phases, tasks, 
gates or any subclass

Time Load date in the Datamart

Table 2-5: Revenue Forecast Per Region and Division

Revenue 
Forecast as 
Values

North America Europe All 
RegionsAutomotive Electronics All Divisions Automotive Electronics All Divisions

Program A 1000.00 0.00 1000.00 0.00 0.00 0.00 1000.00

Program B 0.00 0.00 0.00 1000.00 1000.00 2000.00 2000.00

Program C 1000.00 1000.00 2000.00 1000.00 1000.00 2000.00 4000.00

All Root 
Programs 2000.00 1000.00 3000.00 2000.00 2000.00 4000.00 7000.00

Table 2-6: Portfolio Measures

Measure Calculation/Source Rollup

Strategic Fit Program | General Info | Flex Field † Average

Days Effort Program | General Info | Days Effort Average

NPV Program | General Info | Flex Field † Average

Table 2-4: Finance Dimensions (continued) 

Dimension Source Comments
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Table 2-7 lists the Portfolio dimensions, the labels used in the Portfolio reports, the source (the Agile object attribute 
that defines the dimension) and, if appropriate, a comment.       

Resource

Table 2-8 and Table 2-9 list the Resource measures and dimensions, respectively. The Resource includes measures 
about resources and resource costs for each program.         

Table 2-8 lists the Resource measures, the source (the Agile object attribute from which the measure is derived) or 
the calculation used to compute the measure. The Rollup column indicates the type of calculation, for example, 
whether the calculation is an average or a count.      

Market Opportunity Program |General Info | Flex Field † Average

Technical Feasibility Program | General Info | Flex Field † Average

Number of Root Programs Count of root programs where activity type = program and 
parent program is null

Count

†These flex fields are defined on the Page Two component of the Program object. (For more information about configuring 
flex fields, see the Agile 9 Administrator Guide.) In the Agile Web client, Page Two attributes are displayed on the General Info 
tab.

Table 2-7: Portfolio Dimensions

Dimension Source Comments

Root Program All Program | General Info | Names where Program | 
General info | Parent is NULL

Region Program | General Info | Region Dashboard field

Status Program | General Info | Status Workflow status

Overall Status Program | General Info | Overall Status

Actual Start Date Program | General Info | Actual Start Date

Actual End Date Program | General Info | Actual End Date

Schedule Start Date Program | General Info | Schedule Start Date

Schedule End Date Program | General Info | Schedule End Date

Program Type Program | General Info | Program Type Dashboard field

Division Program | General Info | Division Dashboard field

Product Line Program | General Info | Product Line Dashboard field

Customer Program | General Info | Customer Dashboard field

Launch Year Program | General Info | Launch Year Dashboard field

Time Loaddate

Table 2-8: Resource Measures  

Measure Calculation/Source Rollup

Headcount Resource Pool | Users (count) Count

Resource Pool Bill Rate Resource Pool | Bill Rate Average

Resource Pool Cost Rate Resource Pool | Cost Rate Average

Resource Pool Overhead 
Rate

Resource Pool | Overhead Rate Average

Table 2-6: Portfolio Measures (continued)

Measure Calculation/Source Rollup
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Note When resources (users assigned as resources) are counted, if valid rate data is not entered in a user’s User 
Profile, that user is omitted from the Headcount. For example, if Mary, James, and Sam are the three 
members of the resource user group, and Sam does not have any valid rate data entered in his User Profile, 
Sam is omitted from the Headcount, therefore, the Headcount is 2 instead of 3.        

To compute the correct Headcount, make sure that each user has valid rate data entered in all three rate 
attributes on the User Profile (Bill Rate, Labor Rate, and Overhead Rate). All three rate attributes are 
required. Zero is not a valid rate; users with any rate data of zero are omitted from the Headcount.

The Agile administrator or a User Administrator can make modifications to these attributes of the General 
Info tab of the User Profile.      

Table 2-9 lists the Resource dimensions, the labels used in the Resources reports, the source (the Agile object 
attribute that defines the dimension) and, if appropriate, a comment.     

Time-to-Market

Table 2-10 and Table 2-11 list the Time-to-Market measures and dimensions, respectively. The Time-to-Market 
includes measures pertinent to computing time-to-market reports.           

Table 2-10 lists the Time-to-Market measures, the source (the Agile object attribute from which the measure is 
derived) or the calculation used to compute the measure. The Rollup column indicates the type of calculation, for 
example, whether the calculation is an average or a count.      

Table 2-9: Resource Dimensions 

Dimension Source Comments

Resource User | User Name

Resource Pool User | User Name

Resource Pool (User Group) Name

Pool Owner Resource Pool | Pool Owner

Region Resource Pool | Region Dashboard field

Division Resource Pool | Division Dashboard field

Product Line Resource Pool | Product Line Dashboard field

Table 2-10: Time-to-Market Measures

Measure Calculation/Source Rollup

Time-to-Market For Root Programs (Programs where General Info | Root 
Parent is null)

(General Info | Schedule End Date) - (General Info | 
Schedule Start Date)

Average

Actual Duration Program | General Info | Actual Duration (unit is days) Average

Schedule Duration Program | General Info | Schedule Duration Average

Number of Root Programs Program | General Info | Name where Root Parent is null Count of root programs

Percentage Completed On-Time Count (Activity/Gates where actual end date <= 
schedule end date) / Count

Average shall be computed for 
each program

Days Overdue Calculation for each Activity/Gate is (Activity/Gate | 
General Info | Actual End Date) - (Activity/Gate | 
General Info | Schedule End Date

Metric is computed for selected 
subclass within a program. For 
example, each Root Program 
where Activity.Type = Programs 
shall have an average computed 
for all gates within that 
program. This is the value 
reported.

Schedule Variance Program | General Info | Variance Average
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Table 2-11 lists the Time-to-Market model dimensions, the source (the Agile object attribute that defines the 
dimension) and, if appropriate, a comment.           

Table 2-11: Time-to-Market Dimensions

Dimension Source Comments

Region Program | General Info | Region Dashboard Field

Root Program All Program | General Info | Names where Program | 
General Info | Parent is NULL

and

General.Info | Activity.Type = Program

Activity Type Program | General Info | Activities Type Classifies activities as programs, phases, 
tasks, gates or any subclass.

Program Type Program | General Info | Program Type Dashboard field

Division Program | General Info | Division Dashboard field

Product Line Program | General Info | Product Line Dashboard field

Customer Program | General Info | Customer Dashboard field

Launch Year Program | General Info | Launch Year Dashboard field

Schedule Start Date Program | General Info | Schedule Start Date

Schedule End Date Program | General Info | Schedule End Date

Overall Status Program | General Info | Overall Status

Workflow State Program | General Info | Workflow Status

Owner Program | General Info | Owner

Time Loaddate
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Sample Reports

Capital Cost Performance 
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Financial Overview — Budget Vs. Actual
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Financial Overview — Cost Variances
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Financial Overview — Portfolio Factors
                  



Agile Analytics 2.1.1

2-12 PPM & PQM User’s Guide

Fixed Cost Performance

The following example provides budgeted fixed costs versus estimated fixed cost at completion (which is a calculated value 
per the Measure table).    
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Resource

Portfolio Headcount Consumption

The following example provides the days effort for headcount.      

                         



Agile Analytics 2.1.1

2-14 PPM & PQM User’s Guide

Portfolio Trend Analysis

The following example provides a view into the number of programs per division.       
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Resource Pools — Bill & Cost Rates Vs. Headcount
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Time-to-Market by Region & Quarter

The following example provides  the time-to-market that can be modified for gate completion metric (percentage 
completed on-time average is computed for each root program), task completion metric (percentage completed on-time for 
a task and the average is computed for each root program), days overdue on gates (a single average for each program is 
computed for the report wth these values are averaged across all programs in a region), and schedule predictability (schedule 
variance).     
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CHAPTER 3
Agile PQM Analytics

This chapter provides an overview of workspaces and general functions of the reports associated with Agile 
PQM analytics. It contains the following sections:
❑ Overview
❑ Predefined PQM Analytics
❑ PQM Analytic Measures
❑ Measurement Name Mapping
❑ Problem Report Examples
❑ Supplier/Customer Examples

Overview
Agile Analytics enables analysts to gain insight through fast, consistent, interactive access to different views of 
information that reflect the multidimensionality of the business. Using workspaces designed for analyzing processes, 
customers and suppliers, and product lines you can easily:

❑ Track the volume, rate, and status of new, open, closed, and overdue requests.

❑ Review the time to complete end-to-end processes.

❑ Provide relative comparisons. 

❑ Identify top performers. 

❑ Review failures over time to identify problems and review trends.

❑ Analyze the cost impact of quality.

Product quality is a key metric in all product-based companies. The quality of incoming parts is a reflection of 
supplier performance and the quality of outgoing products will impact customer satisfaction. By using the data in 
the Agile Datamart, Agile Analytics can create multidimensional views of data with the ability to slice, rotate, drill 
up, or drill down data for additional aggregation or detail views.

By using predefined Product Quality Management (PQM) analytics, you can eliminate the preparation time 
required to compile product quality reports (for example, weekly, monthly, quarterly, and yearly reviews). 

Predefined PQM analytics focus on seven areas:

❑ Problem reports (PRs) ❑ Supplier performance

❑ Non-conformance reports (NCRs) ❑ Customer impact

❑ Corrective and preventive actions (CAPAs) ❑ Product line quality

❑ Audits
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PRs

There is not an industry-standard name for incoming problem reports from customers, although they are typically 
called issues, failures, defects, complaints, problems, or returned material authorizations (RMAs). Companies track 
the rate of customer-related problems and the associated causes, and then compile these metrics into reports that 
provide a snapshot of product issues faced by customers.

NCRs

Incoming parts quality issues are typically managed through the non-conforming material report (NCMR) process. 
Other metrics that are tracked include the rate at which problems occur and the source of problems. This 
information can help determine the efficiency of internal operations and supplier performance.

CAPAs

Corrective and preventive actions (CAPAs) defines a process for resolving product quality issues, including the rate 
at which problems are being fixed and the cost associated with these fixes.

Audits

An audit is a method for validating that a CAPA fixed the problem associated with it. This is typically a back-end 
procedural check used in highly regulated environments to ensure processes are working as expected and where 
regulatory compliance is critical.  

Predefined PQM Analytics
Performing process analysis, failure mode analysis, cycle time analysis, product line comparative analysis, customer 
analysis, and supplier analysis allow you to measure the rate of requests and problems, time requirements, key 
product line metrics, and customer and supplier correlations. Agile PQM analytics are divided into two major 
categories, although there is overlap within the categories, as shown in the following diagram. 

      

Product Service Request Quality Change Request

Problem Reports Non-Conformance Corrective & Audits

Product Line

Customers

Suppliers

Reports Preventative Actions

Affected Items
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Agile Analytics allows you to create the following types of reports that apply to four of the quality processes.       

You can create any number of reports and customize existing reports or create custom reports for your unique 
requirements. Once you have defined your reports, you can save them in your workspace and continue to generate 
up-to-date and relevant information

A description for each Analytic report is provided in the following table.       

Table 3-1: Types of Reports

Purpose PRs NCRs CAPAs Audits

New requests

Open requests

Closed requests

Process overview

Process backlog

Failure mode analysis

Cycle time analysis

Comparative cycle time analysis

Product line activity analysis

Expected resolution

Days overdue

Problem reports by customer

NCRs by supplier

New requests by item

Cycle time normal distribution

Table 3-2: Descriptions of Analytic Reports

Report Type Description

New requests Track the volume, type, and rate of new reports.

Open requests Track the volume, type, and rate of open reports.

Closed requests Track the volume, type, and rate of closed reports.

Process overview Consolidated view of new, open, and closed reports with average cycle time to 
complete.

Process backlog Track number of open requests by workflow status with average time spent in status.

Failure mode analysis Track the type and rate of failure modes.

Cycle time analysis Track end-to-end process time as well as individual step process time.

Comparative cycle time analysis Compare cycle times of different process types.

Product line activity comparison Compare new activity against a series of product lines.

Expected resolution Provide forward looking view of what reports been committed to close based on 
“Expected Resolution Date”.

Days overdue Track the number of reports which are overdue and the cumulative days behind (based 
on “Expected Resolution Date”.

Problem Reports by Customer Correlate total number of problems to the number of customers reporting them.
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PQM Analytic Measures
Table 3-3 through Table 3-7 list the measures that are available for clarifying data output. The tables are separated 
according to the type of data the measurement is used to filter. 

❑ Volume

❑ Rate 

❑ Cycle time

❑ Cycle time average

❑ Performance

Volume  

Rate  

NCRs by Supplier Correlate total number of problems to the number of suppliers causing them.

New Requests by Item Display the top n items and the number of new requests to highlight key problem items.

Cycle Time Normal Distribution Graph each cycle time for month against a normal distribution curve to highlight 
outliers.

Table 3-3: Volume Measures   

Measure Formula Description

Number of [Object] Count Count of [Object].

Number of Items Count Count of Items on [Object] (Affected Items tab).

Number of Failure Mode Count Count of Items on [Object] (Affected Items tab) by Failure 
Mode.

Number of Customer Count Count of Customer by [Object].

Number of Supplier Count Count of Supplier by [Object].

NCRs Affected Item Total 
Quantity Suspect

Count of Total Quantity 
Suspect

Count of user input values on the Affected Items tab. This only 
applies to NCRs.

NCRs Affected Item Quantity 
Checked

Count of Quantity Checked Count of user input values on the Affected Items tab. This only 
applies to NCRs.

NCRs Affected Item Quantity 
Affected

Count of Quantity Affected Count of user input values on the Affected Items tab. This only 
applies to NCRs.

Number of [Object] in 
Workflow Status

Count For each workflow, count of [Object] currently in each 
workflow status (i.e. process step).

Table 3-4: Rate Measures    

Measure Formula Description

Number of [Object] Not 
Released

Date Released is null or 
Released Date is greater 
than selected time period

This is to enable tracking the backlog of “Open” [Object]. 
Customers will measure “Open” differently -- some will 
consider “Released” the final process step and some will 
consider “Final Complete” the final step. Two measures are 
being set up to accommodate both scenarios. [Object] can be 
open and new in the same month.

Table 3-2: Descriptions of Analytic Reports (continued)

Report Type Description
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Cycle Time  

Cycle Time Average  

Number of [Object] Not 
Complete

Final Complete Date is null 
or Final Complete Date is 
greater than selected time 
period

See above comment (this is the “second” approach).

Number of [Object] Released Date Released is not null This is to enable tracking the rate of “Closed” [Object]. 
Customers will measure “Closed” differently -- some will 
consider “Released” the final step and some will consider 
“Final Complete” the final step. Two measures are being set up 
to accommodate both scenarios. [Object] can be “New” and 
“Closed” in the same month, but cannot be “Open” and 
“Closed” in the same month.

Number of [Object] Final 
Complete

Final Complete Date is not 
null

See above comment (this is the “second” approach).

Number of New [Object] Date Originated (within 
defined time period)

This is to enable tracking the rate of creation of new [Object] 
by time period.

Table 3-5: Cycle Time Measures    

Measure Formula Description

[Object] Originate to Release 
Cycle Time

Date Released - Date 
Originated

This Cycle Time measurement does not require any workflow 
analysis as these dates are stored on the Cover Page.

[Object] Originate to Final 
Complete Cycle Time

Final Complete Date - Date 
Originated

This Cycle Time measurement does not require any workflow 
analysis as these dates are stored on the Cover Page.

[Object] Submit to Release Cycle 
Time

Date Released - Date 
Submitted

This Cycle Time measurement does not require any workflow 
analysis as these dates are stored on the Cover Page.

[Object] Submit to Final 
Complete Cycle Time

Final Complete Date - Date 
Submitted

This Cycle Time measurement does not require any workflow 
analysis as these dates are stored on the Cover Page.

[Object] Workflow Total Cycle 
Time

Final Status End Date - 
Initial Status Start Date

Workflows have a defined sequence of statuses and this needs 
to determine first and last step per workflow and measure 
accordingly.

[Object] Workflow Status Time 
to Complete

Status Complete Date - 
Status Enter Date

Individual Status has both a start data and complete date (this 
is required for each workflow).

[Object] Workflow Status Time 
in Process

Current Time/Date - Status 
Enter Date

Status has a start date but no complete date.

[Object] Workflow Status Time 
to Complete Avg

Sum(Workflow Status 
Time to Complete)/
Number of [Object]

Determine average cycle time using two existing measures.

[Object] Workflow Status Time 
in Process Avg

Sum(Workflow Status 
Time in Process)/Number 
of [Object]

Determine average cycle time using two existing measures.

Table 3-6: Cycle Time Average Measures    

Measure Formula Description

[Object] Avg Originate to 
Release Cycle Time

Sum(NCRs Originate to 
Release Cycle Time)/
Number of NCRs

Determine average cycle time using two existing measures.

Table 3-4: Rate Measures (continued)   

Measure Formula Description
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Performance  

[Object] Avg Originate to Final 
Complete Cycle Time

Sum(NCRs Originate to 
Final Complete Cycle 
Time)/Number of NCRs

Determine average cycle time using two existing measures.

[Object] Avg Submit to Release 
Cycle Time

Sum(NCRs Submit to 
Release Cycle Time)/
Number of NCRs

Determine average cycle time using two existing measures.

[Object] Avg Submit to Final 
Complete Cycle Time

Sum(NCRs Submit to Final 
Complete Cycle Time)/
Number of NCRs

Determine average cycle time using two existing measures.

Table 3-7: Performance Measures     

Measure Formula Description

[Object] Days Overdue - In 
Process

Current Date/Time - 
Expected Resolution Date

Where Date Released is null. This illustrates the cumulative 
'Days Behind' the customer is in customer commitments for 
“Open” [Object].

[Object] Days Overdue - 
Released

Current Date/Time - 
Expected Resolution Date

Where Date Released is within monthly time period. This 
illustrates the cumulative 'Days Behind' the customer was in 
customer commitments for [Object] closed during the 
month.

Number of [Object] Overdue Count of [Object] where 
[Object] is not complete 
and Current Date/Time > 
Expected Resolution

This is count of how many [Object] are overdue (based on the 
Expected Resolution date).

Number of Audits Passed Count of Audit Result = 
Pass

Audit Result is list field and customers can change the default 
list value from Pass / Fail to whatever values they please.

Number of Audits Failed Count of Audit Result = 
Fail

Audit Result is list field and customers can change the default 
list value from Pass / Fail to whatever values they please. 

Audit Effectiveness (Number of Audits Passed / 
Number of Audits) * 100

Determine percentage using two existing measures.

Expected Resolution Datamap Get the value from the Expected Resolution field on the Cover 
Page.

Monthly [Object] Cycle Time 
Standard Deviation

Standard deviation 
calculation based on 
individual object cycle 
times

To enable charting distribution of individual object cycle 
times with normal distribution curve.

Table 3-6: Cycle Time Average Measures (continued)   

Measure Formula Description
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Measurement Name Mapping
Table 3-8 lists the measurements and specified if the measurement is required or optional. 

    

Table 3-8: Measurement Name Mapping  

R = Required

O = Optional

Folder Measure Dimension Time Methods*  S

Volume

New R O O O O O O O O O R R O O O O O

Items R R O O O O O O O O R R O O O O O

Customer R O O R O O O O O O O R R

Supplier R O O O R O O O O O O R R

Not Released R O O O O O O O O O R R

Not Complete R O O O O O O O O O R R

Released R O O O O O O O O O R R

Complete R O O O O O O O O O R R

Overdue Released R O O O O O O O O O R R

Overdue Not Released R O O O O O O O O O R R

Expected Resolution R O O O O O O O O O R R

Target 
Delivery

Days Overdue - In Process R O O O O O O O O O R R

Days Overdue - Released R O O O O O O O O O R R

Cycle 
Time

Originate to Release R O O O O O O O O O R R O

Originate to Complete R O O O O O O O O O R R O

Submit to Release R O O O O O O O O O R R O

Submit to Complete R O O O O O O O O O R R O

Total CT R R O O O O O O O O R R O

Status CT R R O O O O O O O O R R O

Status - In Progress R R O O O O O O O O R R O

NCR

Qty Suspect R R O O O O O O O O O R R

Qty Checked R R O O O O O O O O O R R

Qty Affected R R O O O O O O O O O R R

Audit

Passed R O O O O O O O O O R R

Failed R O O O O O O O O O R R

Effectiveness R O O O O O O O O O R R

= N/A
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Open 
Process 
Aging

Days Open R O O O O O O O O O O

< 5 Days Open R O O O O O O O O O O

< 10 Days Open R O O O O O O O O O O

< 30 Days Open R O O O O O O O O O O

> 30 Days Open R O O O O O O O O O O

> 60 Days Open R O O O O O O O O O O

> 90 Days Open R O O O O O O O O O O

> 120 Days Open R O O O O O O O O O O

5 to 10 Days Open R O O O O O O O O O O

10 to 20 Days Open R O O O O O O O O O O

20 to 30 Days Open R O O O O O O O O O O

30 to 40 Days Open R O O O O O O O O O O

40 to 50 Days Open R O O O O O O O O O O

50 to 60 Days Open R O O O O O O O O O O

60 to 90 Days Open R O O O O O O O O O O

* When “R” is listed for time, either of the time dimensions needs can be included, both are not required

* Methods will not work when the Utility Time dimensions are used

* Methods always require that you include the “Default” method to represent the starting value

* Severity Dimension only applies to QCR (applying to PSR will return null values for measures)

* Disposition Dimension only applies to PSR (applying to QCR will return null values for measures)

S = Switch

Table 3-8: Measurement Name Mapping (continued) 

R = Required

O = Optional

Folder Measure Dimension Time Methods*  S

= N/A
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Problem Report Examples
Problem reports (PRs) are created when a customer has a problem with a product. Non-conformance reports 
(NCRs) are created when manufacturing or engineering have a problem with a product. (When a PR or NCR is 
validated, a corrective and preventive action (CAPA) is created as a means for eventually closing the PR or NCR. If 
the product definition is the problem, a CAPA will drive the creation of a product change order (for example, an 
ECO or MCO) to change the product definition. Once a CAPA is implemented, an audit can be performed to 
confirm the problem is fixed.

The following examples show only the Problem Reports workspace. However, the same functionality is available for 
NCRs, CAPAs, and audits. For general information on how to set up reports, refer to Chapter 4, “Setting Up Analytic 
Reports.”

Number Of Requests

The following example is tracking new, open, and closed processes over time, as well as how long it is taking to 
complete the process (cycle time is for processes completing that month). This information allows the quality 
process owner to identify trends and spikes in cycle times of a 5-day or 7-day work week.
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New Requests

The following example provides details of the new requests for different periods of time. This information allows the 
quality process owner or the person responsible for reducing incoming requests to identify trends, spikes, or other 
areas that require focus. 
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In Process

The following example shows the details for open processes. The report provides the number of open issues by 
disposition and by product line. The quality process owner can use this information to identify bottlenecks, problem 
areas, or other areas that require focus. 
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Closed

The following example provides details of closed requests for the given month. This information can help the quality 
process owner or engineering owner compare the rate of issues received to the rate of issues closed. Information can 
be disected with various dimensions.
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Failure Mode

The following example shows the breakdown of items by failure mode for the time period. The quality process 
owner, engineering owner, or product line owner can use the information to identify the failure mode for a 
particular item or to analyze the trends.
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Cycle Time

The following example shows how long each process is taking and the trends over time. The top panel provides the 
entire cycle time, independent of the selected workflow (by using cover page date attributes). The bottom panel 
shows the workflow cycle time. The quality process owner or manufacturing, engineering can use this information 
to identify trends, spikes, or other areas that require focus by comparing product lines (best and worst in class).
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Supplier/Customer Examples
The following examples show only the Supplier workspace. However, the same functionality is available for the 
Customer workspace. For general information on how to set up reports, refer to Chapter 4, “Setting Up Analytic 
Reports.”

Activity

The following example provides the number of new, open, closed, or total requests by supplier. The quality process 
owners, supply base owner, or engineering owner can use this information to identify the trend of reports by supplier 
across different dimensions.  
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Overdue

The following example shows overdue processes by supplier and a dial indicator if the process goals are being met. 
The quality process owner or manufacturing, engineering owner can use this information to identify trends, spikes, 
or areas that require focus in the product line.
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Expected Resolution

The following example provides a forward looking view of what is scheduled to close (based on the Expected 
Resolution date on the Cover Page). This information allows the quality process owner, the manufacturing owner, 
or engineering owner to set expectations based on changes in the customer, product line, or process type. 
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Response Time

The following example shows the length of each process and the trends over time. The top panel shows the entire 
cycle time, independent of the selected workflow (using Cover Page Date attributes). The quality process owner, 
supply base owner, manufacturing owner, or engineering owner can use this information to identify trends, spikes, 
or other areas that require focus in order to increase the ability of meeting defined targets (for example, comparing 
product lines to identify the best and worst in class).
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Breakdown By Type

The following example provides a breakdown of process activity by supplier for relative comparison. This 
information allows the quality process owner, supply base owner, or engineering owner insight into where the 
majority of time is spent. Information can be filtered by process and time period. 
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Days Open

The following example provides information on open processes. The top panel places open requests in time buckets 
to show how long they have been open. The quality process owner, supply base owner, or engineering owner can use 
this information to develop insight into bottlenecks, problem areas, or other areas that require focus by filter the 
process.
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Extending Agile PQM Analytics
Any Page 2 and Page 3 attribute in Agile PLM can be configured in the model as a dimension or measure.  The 
following reports provide examples of Page 2/3 attributes configured as measures in the model.  

Any data that is not part of Agile PLM can also be brought into Agile Analytics. Contact Agile Anayltics Services for 
additional configuration information.

Units Shipped

The following example shows the number of units shipped for a given item. The quality process owner, product line 
owner, or engineering executive can use this information to identify trends or spikes.
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Cost Analysis

The following example shows the cost of problem reports over time by type (for example, subclass). This 
information helps the quality process owner, product line owner, or business unit owner identify issues that have a 
high cost impact and the root cause of those issues. 
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Cost

The following example shows the cost of problems by supplier over time (cost is assumed to be a P2 field on process, 
but it could also be external data). The quality process owner, manufacturing owner, or engineering owner can use 
this information to identify trends, spikes, and other areas that require focus using the Change Time value.
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CHAPTER 4
Setting Up Analytic Reports

This chapter explains how to use and modify analytic reports. In includes the following sections: 
❑ Overview
❑ Data Filters
❑ Charting Data
❑ Formatting Charts
❑ Undo/Redo
❑ Explore By
❑ Chart Settings
❑ Chart Options
❑ Chart Types & Configuration
❑ Types Of Charts

Overview
Agile Analytics enables analysts to gain insight through fast, consistent, interactive access to different views of 
information that reflect the multidimensionality of the business. Using workspaces designed for analyzing processes, 
customers and suppliers, and product lines you can easily:

❑ Track the volume, rate, and status of new, open, closed, and overdue requests.

❑ Review the time to complete end-to-end processes.

❑ Provide relative comparisons. 

❑ Identify top performers. 

❑ Review failures over time to identify problems and review trends.

❑ Analyze the cost impact of quality.

By using analytics, you can eliminate the preparation time required to compile product quality reports (for example, 
weekly, monthly, quarterly, and yearly reviews). In addition, you can modify any reports or create custom reports 
for your unique requirements. Once you have defined your reports, you can save them in your workspace and 
continue to generate up-to-date and relevant information.
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There are six predefined areas:

❑ Problem reports (PRs)

❑ Non-conformance reports (NCRs)

❑ Corrective and preventative actions (CAPAs)

❑ Audits

❑ Customer

❑ Supplier

       

PRs, NCRs, CAPAs, and audit workspaces use a similar analysis structure, as do the customer and supplier 
workspaces.

The chapter provides information on using and modifying analytic workspaces. Refer to the chapter entitled 
“Working With Workspaces” for general workspace functionality and usage. Refer to the chapter entitled “Agile 
Analytics Application Administration” for information about using all application modules.

Data Filters
Refining the output of the resulting data allows you to interpret its value. Agile Analytics provides several types of 
data filters to improve: 

❑ Analyzing trends over sequential time periods, including forecasts into the future that are based on exact 
calculations as well as trends

❑ Creating slices of data for on-screen viewing which can be ad hoc or predefined

❑ Drilling down or up to any levels of aggregation or detail

❑ Rotating to change the dimensional orientation in the viewing area, including using data and user defined 
dimensions

❑ Multidimensional views of data

❑ Calculation-intensive capabilities

Disregarding Data

You can filter data according to several criteria. For example, you can disregard high and low values for cycle time 
analysis if one record disproportionately skews the entire result set. You can throw out n% of the high and low values 
to more accurately reflect the true average. For instance, do not include the top 2% and bottom 2% of cycle times 
when computing the overall average. 

Drill Down 

Drill Down option enables you to breakdown down the hierarchy of the dimension member. This operation is valid 
only when the selected member has child members. You can also Drill Down on a member by double-clicking on the 
desired dimension member. A sample grid before Drill Down appears as follows:
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Note that the dimension member 1996appears without its child members. Double-click the member 1996 or select 
the member 1996, right-click, and select Drill Down. The grid appears as follows:

          

Note that drill-down enables you to move down the member hierarchy to the immediate child level in the dimension 
hierarchy. You can view the Product Sales for all the Quarters of the year 1996.

A system property will define the maximum number of child members to be returned during drill down action. By 
default this value is set to 1000.

If the number of resulting members returned on drill down is greater than the maximum value defined, then a drill 
down advisory message is displayed as follows:

‘Drilling down on the member will return ‘<member count>’ members and may affect 
the report performance. Are you sure you want to drill down?’. 

Click OK to continue with the drill down action. Else, click Cancel to abort the drill down action.

Custom Drill Down

Drill Filters can be applied on a workspace grid to perform a custom drill down operation. All the filters defined as 
drill filters during the report creation process will be available for selection on the workspace grid. You can select the 
filters that you require and apply them on the report while drilling down to a specific level.

Drill Up 

Drill Up option enables you to move up on the hierarchy of the dimension member. This operation is valid only when 
the selected member has a parent member. A sample grid before Drill Up on dimension All Time appears as follows:
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Note that the dimension All Time shows all its child members. Select any of the child members of All Time, right-
click, and select Drill Up. The grid appears as follows:

        

Note that Drill Up enables you to move up on the hierarchy of the dimension member to the immediate parent level 
in the dimension hierarchy. The Product Problems reported for all the years listed under All Time will be 
consolidated under All Time.

Swap Axes

You can swap axes to move all the dimensions on the row axis to the column, and the column axis to the row. Right-
click anywhere on the grid and select Swap Axes. All the dimensions on the row axis are moved to the column axis 
and the dimensions on the column axis are moved to the row axis. A sample grid before the Swap Axes action appears 
as follows:

      

Select a cell, right-click, and select Swap Axes. The grid appears as follows:
      

Note that the dimensions Time and Product Sales have swapped the axes.
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Pivot

The Pivot option enables you to view grid information for a single dimension. For example, to view information for 
a product dimension while in a grid, right-click on any of the members that fall under the product dimension and 
select Pivot. The Pivot option enables you to view the different views of the data based on a selected dimension. A 
sample grid appears as follows:

      

Select any member that falls under Product dimension (such as Accessory, Adult), right-click Accessory, and select 
Pivot. The grid appears as follows:

      

Note that the grid appears with the Sales dimension with all other members being accorded secondary status. 

Charting Data
By default, a chart displays all the data in a grid. You can select data cells in the grid and use Actions > Chart Selected Data 
option to display selected data in the chart. To chart selected data in a grid:

1 Select one or more cells in the grid. 

2 Right-click in the highlighted area of the grid and select Actions > Chart Selected Data.

3 Click Toggle Chart button to view the chart for the Chart Selected Data.

For example, the sample report shows both the grid and chart view side-by-side.
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The sample report shows the sales for the year 1996 to the year 1999. If you want to chart data for the year 1997 
only, select the dimension member 1997, right-click, and select Actions > Chart Selected Data. The report appears as 
follows:
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Note that only the selected data is charted. If you want to revert to the previous state, click Show All Data button 
that appears on top of the chart. 

Note The Show All Data button on the chart appears only when partial data from the grid is currently showing. 
You can select multiple dimension members pressing the SHIFT key.       

         

The chart member and nonmember chart areas behave differently when you right-click on them. The table lists 
the options in a chart for chart members and non-member chart areas.

Note Chart member is a member that constitutes the chart. For example, a bar in a bar chart or a point in a 
scatter chart. When you move the mouse pointer over a chart member, a blue dotted line appears around 
the chart member. 

Formatting Charts
Format allows you to set the legend, title, footnote and configure the data series in the chart. The Format menu provides 
the following options:

❑ Legend 

❑ Titles 

❑ Footnotes 

❑ X and Y axis 

❑ Y1 axis 

❑ Data series 

Note All of the steps used to format a chart result in the following example. 
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Legend

You can choose the font face, font style, size, and color for the legend labels. 

1 Right-click in the chart area and select Format > Legend. The Font tab of the Format Legend dialog box opens as shown:

           



Chapter 4 Setting Up Analytic Reports

4-9

2 You can select the font, font style, size of the font and color of the legend font in the Font tab of the Format Legend 
dialog box.

3 You can also see a preview of your font settings in the Preview field.

4 Select the Placement tab to define the alignment of the legend or the placement of the legend label. The available 
options are:

• Bottom

• Right

• Top

• Left

5 You can also choose to hide the legend labels. by selecting the Hide Legend option.

6 Click Apply and OK to save the changes. Click Cancel to exit from the Data Options dialog box without saving the 
changes.

A sample chart with Legend Color set to Blue and Legend Placement set to Right appears in the example on page 4-7.   

Title

You can enter the text you want to see as the title of the chart in the field provided. You can choose the font style, 
size, and color for the title. 

1 Right-click in the chart area and select Format > Title. The Format Text dialog box appears as follows:

          

2 You can select the font, font style, size of the font and color of the legend font in the Font tab of the Format Legend 
dialog box.
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3 You can also see a preview of your font settings in the Preview field.

4 Click Apply to save the changes. Click OK to save the changes and close the dialog box. Click Cancel to exit from the 
dialog box without saving the changes.

A sample chart with Title as Product Sales, Font Face set to Arial, Font Style set to Bold, Foreground Color set to Red, 
and Size set to 18 appears in the example on page 4-7. 

Footnote

You can enter the text you want to see as the Footnote of the chart in the field provided. You can choose the font 
face, font style, size, and color for the title. 

1 Right-click in the chart area and select Format > Footnote. The Format Text dialog box opens as shown:

          

2 You can select the font, font style, size of the font and color of the legend font in the Font tab of the Format Legend 
dialog box.

3 You can also see a preview of your font settings in the Preview field.

4 Click Apply to save the changes. Click OK to save the changes and close the dialog box. Click Cancel to exit from the 
dialog box without saving the changes.

A sample chart with Footnote labeled From 1996 to 1999, Font Face set to Arial, Font Style set to Bold, the Foreground 
Color set to Red, and Size set to 18 appears in the example on page 4-7.  
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X-Axis

You can choose to enter a title for X-axis and the label orientation of the X-axis. 

1 Right-click in the chart area and select Format > Axis. The Format Axis dialog box opens as shown:

        

2 You can enter a title for the axis in the Axis Title field.

3 You can select and set the orientation of the label from the Label Orientation section.

4 You can set the right and left margins for the chart in the End Margins section.

5 Click Apply to save the changes. Click OK to save the changes and close the dialog box. Click Cancel to exit from 
the dialog box without saving the changes. Click Help for further assistance.
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Y1-Axis

You can choose to enter a title for Y-axis, display a range of Y-axis values and add an appropriate mask to the values 
displayed along the Y-axis.

1 Right-click in the chart area and select Format > Y1 Axis. The Format Axis dialog box opens as shown:

         

2 Select Use log scale to generate the graph based on a logarithmic scale. 

To view the graph based on a pre-set band of values along the Y-axis, type the minimum and maximum values 
in the Minimum and Maximum fields, respectively. You can also define the maximum value of the Y-axis. Type 
the maximum value in the Scale text box.

3 You can set a mask for the values along the Y-axis using the Mask drop-down list.

4 Click Apply to save the changes. Click OK to save the changes and close the dialog box. Click Cancel to exit from the 
dialog box without saving the changes.
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Data Series

Data Series formatting allows you to format the data series. You can color code the data series, show data labels and 
series borders and display the chart values as absolute on the chart. It also allows you to add 3D depth to the chart. 
You can format data series in two ways:

❑ Right-click on the chart member. The Format Data Series dialog box opens up that enables you to format a specific 
member. 

❑ Right-click on the non-member chart area. You can choose to format any of the data members. The Format Data 
Series dialog box opens as shown:

           

Perform the following steps to format data series:

1 Select the color for the data series using the Color option.

2 If you want to create a 3D effect for the data series, select the depth for the 3D effect from the 3-D Effect Depth field.

3 Select Show Data Labels if you want to display the data labels.

4 Select Show Series Border if you want to display the data series border.

5 Select Make chart values absolute to make all values positive before creating the chart. It ensures that all data values 
are represented when creating the chart.

6 When you click Apply, the changes are saved but the dialog box remains open. Click OK to save the changes and 
close the dialog box. Click Cancel to exit from the dialog box.

A sample report with the dimension Accessory’s Color equal to Yellow and 3-D Effect Depth equal to 2 appears in the 
example on page 4-7.   
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Undo/Redo
When you perform any grid operation on a report and want that operation to be reverted to the previous or the 
original state, you need the option of un-doing or re-doing the operation. Agile Analytics enables you to perform 
multiple levels of undo/redo operations. With multiple levels of undo, you can undo any number of changes to the 
report, in reverse order, until you have the report in the desired state. You also have the redo feature that reverses an 
undo.            

You can right-click in a grid to undo or redo the following:

❑ Drilling up

❑ Drilling down

❑ Pivoting

❑ Swapping the axes

❑ Moving across the axes

❑ Changing order of the dimensions

❑ Keep or remove only

❑ Sorting and ranking

By right-clicking on any cell or area, you can undo the previous actions you performed on the report. The first time 
you perform this action, it reverses the most recent change made to the report. Each additional undo action reverses 
the next most recent change. If you decide you do not want to undo an action, you can revert back the undo action 
using Redo. 

Note You can only undo or redo actions in order from the most recent backward. You cannot undo or redo an 
action without undoing more recent actions.    

The undo/redo actions do not impact the report when the grid is reloaded or after you save the report. 

Explore By
The Explore by option allows you to focus on specific data while working with charts. It enables you to easily inspect 
chart data and focus on the data that pertains to the area of your interest. The Explore by option is supported only in 
the following types of charts:

❑ Bar

❑ Line

❑ Waterfall

❑ Area

❑ Pie 

The Explore by option facilitates the following tasks:

❑ Pivot

❑ Drill down on a selected member
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To explore data in the chart:

1 Right-click on a chart member, and select the Explore by option. The Explore by dialog box opens. 

   

2 The Dimension list drop-down lists the dimensions present on the page axis. Select a dimension on the page axis. 

3 Click OK to apply your selections or click Cancel.

4 On clicking OK, the selected page axis dimension member is drilled down to its next level. The results are displayed 
on the x-axis on the chart. 

The dimension that was present on the x-axis is moved to the page axis. Basically, the selected page axis 
dimension is pivoted with the dimension on the X-axis.

You can also double-click on a member on the chart and drill down to its child members.

The following is a sample grid on which the Explore by feature will be illustrated.
          

1 Right-click on a member on the chart and select the Explore by option from the right-click menu. 

The Explore by dialog box opens. 

2 From the Dimension list, select Product, and click OK.
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Note that the Product dimension which was previously on the page filter has now moved to the X-axis on the chart. 
Measures, which was on the X-axis has moved to the page filter.Also note that All Products is drilled down to its child 
members, Accessory, Adult, and Child, as seen on the X-axis.

Chart Settings
The Chart Settings menu provides the following options:

❑ Trendlines 

❑ Data options 
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Trendlines

Use this option to display charts based on the trendlines set in the application. 

1 Right-click in the chart area and select Chart Settings > Trendlines from the right-click menu. The Edit Trendlines dialog 
box opens as shown:

          

2 To set trendlines, choose the trend/regression type by selecting one of the options:

• Linear — A linear trendline is a best-fit straight line that is used with simple linear data sets. Your data is linear 
if the pattern in its data points resembles a line. A linear trendline usually shows that something is increasing 
or decreasing at a steady rate.

• Logarithmic — A logarithmic trendline is a best-fit curved line that is most useful when the rate of change in the 
data increases or decreases quickly and then levels out. A logarithmic trendline can use negative and/or 
positive values.

• Polynomial — A polynomial trendline is a curved line that is used when data fluctuates. It is useful, for example, 
for analyzing gains and losses over a large data set. 

• Power — A power trendline is a curved line that is best used with data sets that compare measurements that 
increase at a specific rate— for example, the acceleration of a race car at one-second intervals. You cannot 
create a power trendline if your data contains zero or negative values. 

• Exponential — An exponential trendline is a curved line that is most useful when data values rise or fall at 
increasingly higher rates. You cannot create an exponential trendline if your data contains zero or negative 
values.

• Moving Average — A moving average trendline smoothens out fluctuations in data to show a pattern or trend 
more clearly. A moving average trendline uses a specific number of data points, averages them, and uses the 
average value as a point in the trendline.

3 The Based on [Product Measures] series lists all the measures used in the chart. Select the measure based on which you 
want to set the trendline from the list.
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4 If you want to format the trendline, click Style tab. The style attributes appear.

         

You can choose the color and style of the trendline.

5 Click Options tab. The Edit Trendlines dialog-box opens as shown:

         

6 By default, the trendlines will be named such as Trend_1, Trend_2, and Trend_3. 
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You can choose to rename the trendline. Click Rename and the Rename Trendline dialog box opens:
   

7 Click Add to add a new trendline. An entry for the new trendline will be listed under Available Trendlines.

8 To delete a trendline, select the trendline, and click Delete.

9 When you click Apply, the changes are saved but the dialog box remains open. Click OK to save the changes and 
close the dialog box, or click Cancel to exit from the dialog box.

Add Trendlines For A Series

This option enables you to add trendlines for a selected series. Select Chart Settings > Add Trendlines for this Series from the 
right-click menu. The Edit Trendlines dialog box opens.

For information on Trendlines, see “Trendlines”.
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Chart Options 
The option enables you to set the chart preferences in different ways. 

1 Click Chart Options from the right-click menu, a Chart Options dialog box opens as shown:

       

2 The dialog options are as follows:

• Title and Footnote applies to all chart types. You can enter any title or footnote information for the chart. The 
title appears at the top center of the chart. The footnote appears at the bottom center. The character limitation 
for titles and footnotes is 50.

• Use Dwell Labels applies to all chart types and displays labels for chart data. When this option is enabled, a label 
identifies the contents of the chart object when the cursor passes over it. If this option box is not selected, dwell 
labels do not appear.     

• Must include zero applies to all chart types and enables the chart to begin measuring at a point other than zero. 
If this option is selected, the chart axes will begin at zero, regardless of the actual starting point of the chart 
data. If this option is not selected, the dimension axes begin at the point closest to the actual chart data value.

• Legend gives you a visual cue and description for each data object. The legend is very useful if you are quickly 
glancing through the data on a chart. 

≈ Bottom places the legend at the bottom of the chart.

≈ Right places the legend at the right side of the chart.

≈ Top places the legend at the top of the chart.

≈ Left places the legend at the left side of the chart.

≈ Hide Legend hides the legend. You can hide the legend if it is occupying more space in the chart.

• Generation Filter
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≈ Showing All Generations displays data for each dimension member as well as the total for all generations. By 
default, all generations are shown. Generation filters are mutually exclusive; only one can be selected at a 
time.    

≈ Showing the Last Generation displays data for only the last (most detailed) generation visible in the grid.

≈ Showing a Specified Generation displays a specific generation.

A sample report with Generation Filter set to Show All Generations appears in the example on page 4-7.  

If you set Generation Filter to Show just the Last Generation, the report appears as follows:
       

• Label Orientation specifies the position of the chart's X-axis labels. The X-axis label positioning can be used to fit 
labels that cannot be viewed in a very large or complex chart. X-axis labels can be positioned in the following 
different ways:

≈ Normal positions the labels in the standard horizontal, side-by-side placement.

≈ 90 degrees positions the labels in a vertical, side-by-side placement. 

≈ Staggered positions the labels in a horizontally staggered placement. 

≈ Auto-skip skips the labels.

≈ Custom Angle positions the labels in the angle you specify. 

• Make Chart Values Absolute makes all values positive before creating the chart. It ensures that all data values are 
represented when creating the chart.

• Pie Charts is one of the more commonly used chart types. You can use the following options to control pie chart 
appearance.

≈ Group Small Values allows the combination of smaller values into a single value.

≈ Begin grouping at (0-50%) determines the point at which grouping starts in a chart. Grouping can begin at any 
point between 0 and 10%. Starting grouping at 0% performs the same action as disabling this option.

Chart options do not affect the grid or data layout panel. 

3 Select the options and click Apply and OK to save the changes. Click Cancel to exit from the Chart Options dialog 
box.  
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Chart Types & Configuration
The Chart Types option allows you to view all of the available chart types for your application. Additionally, the four 
most common chart types can be selected using shortcut buttons on the application toolbar. 

1 Click Chart Types from the right-click menu, a Chart Types and Configuration dialog box opens as shown:

       

The Chart Types and Configuration dialog box contains three tabs:

• Chart Types  

• Axes Placement  

• Data Configuration    

Chart Type Options

The Chart Types tab in the chart types dialog box allows you to view all of the available chart types for your report. To 
select a chart type:

1 Click the Chart Types tab.       

2 In the Chart Type drop-down list, select a chart type. The Chart Type list contains the following chart types. A preview 
of the chart appears in the dialog box.  

Note For more examples and details on the types of charts that are available, see “Types Of Charts” on page 4-24.  



Chapter 4 Setting Up Analytic Reports

4-23

Axes Placement

The Axes Placement tab in the chart types dialog box allows you to assign dimensions to chart axes. 

1 To assign dimensions to chart axes, click the Axes Placement tab in the chart types dialog box. The Chart Types and 
Configuration dialog box appears as follows:    

   

2 Select Automatically Assign Chart Axes to assign the axes automatically. Clear this checkbox if you want to assign the 
axes manually. 

3 From the drop-down lists, select the axes for each dimension member. With bipolar and dual-axis chart types 
you can split the Y-axis into the First and Second Y-axes. 

4 Click OK to close the dialog box and save the changes. Click Apply to save the changes without closing the dialog 
box.
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Data Configuration

The Data Configuration tab in the chart types dialog box allows you to display different chart types for every selected 
dimension. To display different chart types for every selected dimension:

1 Click the Data Configuration tab in the chart types dialog box, a dialog box appears as follows:

    

2 For each of the selected measures, a drop-down list with the following options is displayed:

• Default

• Bar 

• Line

• Area

3 Select 2nd y-axis option if you want to display any of the dimension members along a second Y-axis.

4 Click OK to save the changes. Click Cancel to exit without saving the changes. Click Apply to save the changes 
without closing the dialog box.

Types Of Charts
In this chart, the X-axis label identifies the categories (or qualifiers) and the Y-axis label identifies the measurements 
for the data point values. The chart legend identifies the different series being graphed. Charts can also have titles, 
tick marks, and footnotes.

In addition to the items shown in the previous illustration, 3D charts can have walls and additional axes as shown in 
the following illustration.
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The following table provides descriptions and examples for all of the available chart types.          

Table 4-1: Chart Types

Chart Type Description

3D Bar              

3D Bar chart displays several 2D data series as an array of 3D bars. Each bar 
series can be displayed using different color attributes. Also, each bar can be 
assigned individual color. 

Use Bar charts to compare discontinuous events, showing the differences 
between events, rather than trends.

Vertical Bar, Side-by-Side, 3D Effect   

Side-by-side groups of bars with 3D visual effect.

Vertical Bar, Side-by-Side  

Side-by-side groups of bars. The standard type of two-dimensional bar 
chart.
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Vertical Bar, Stacked   

Stacked groups of bars. Each stack comprises a series in this group, added up 
to get a total. The axis is the total value of the cumulative points.

Vertical Bar, Side-by-Side, Dual-Axis    

Also called a dual-Y chart. Any series can be assigned to either of the two 
axes.

Vertical Bar, Stacked, Dual-Axis    

Also called a dual-Y stacked chart. Separate stacks will be created for the data 
on each of the two axes.

Vertical Bar, Side-by-Side, Bipolar   

A dual-Y chart with the two axes physically split into separate sections, so 
that each can be seen independently of the other.

Table 4-1: Chart Types (continued)

Chart Type Description
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Horizontal Bar, Side-by-Side   

Side-by-side groups of bars. The standard type of two-dimensional bar 
chart.

Horizontal Bar, Stacked    

Stacked groups of bars. Each stack is comprises a series in this group, added 
up to get a total. The axis is the total value of the cumulative points. 

Horizontal Bar, Side-by-Side, Dual-Axis    

Also called a dual-Y chart. Any series can be assigned to either of the two 
axes.

Horizontal Bar, Stacked, Dual-Axis   

Also called a dual-Y stacked chart. Separate stacks will be created for the data 
on each of the two axes.

Table 4-1: Chart Types (continued)

Chart Type Description
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Vertical Line, Absolute, 3D Effect   

Lines drawn on top and under each other to show the absolute relationships 
between data series with 3D effect.

Vertical Line, Absolute    

Lines drawn on top and under each other to show the absolute relationships 
between data series.

Vertical Line, Stacked   

Lines stacked on top of each other. The axis is the cumulative total of all the 
groups.

Vertical Line, Absolute, Dual-Axis    

Also called a dual-Y line chart. Any series can be assigned to either of the two 
axes.

Table 4-1: Chart Types (continued)

Chart Type Description
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Vertical Line, Stacked, Dual-Axis   

Also called a dual-Y stacked line chart. Separate stacks will be created for the 
data on each of the two axes.

Vertical Line, Absolute, Bipolar  

A dual-Y chart with the two axes physically split into separate sections, so 
that each can be seen independently of the other.

Vertical Line, Percentage   

A line version of a pie chart. Each group calculates the percent of the total 
required for each series. The axis goes from 0 to 100%.

Vertical Area, Absolute   

Areas draw on top of each other to show the absolute relationships between 
data series. Use when some data “pokes up” behind other data.

Table 4-1: Chart Types (continued)

Chart Type Description
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Vertical Area, Stacked   

Areas stacked on top of each other. The axis is the cumulative total of all the 
groups.

Vertical Area, Absolute, Bipolar   

A dual-Y chart with the two axes physically split into separate sections, so 
that each can be seen independently of the other.

Vertical Area, Percentage   

An area version of a pie chart. Each group calculates the percentage of the 
total required for each series. The axis goes from 0 to 100%.

Vertical Area, Absolute, 3D Effect   

Areas draw on top of each other to show the absolute relationships between 
data series with 3D effect.

Table 4-1: Chart Types (continued)

Chart Type Description
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Pie 

In a pie chart, each pie segment can be configured independently. Each 
segment has an assigned label. Pie charts use a custom label layout algorithm 
to make sure no labels overlap and that they are well distributed.

Pie chart shows data as percentages of a whole.

Scatter 

A scatter chart shows the degree of relationship between values in several 
series. It plots to groups of numbers as one series of x-y coordinates.

Bubble Chart               

A bubble chart is a type of scatter plot. The size of the data marker (bubble) 
indicates the value of a third variable (the X and Y axis are used for two other 
variables).

Use a bubble chart instead of an X-Y chart, if your data has three 
dimensions, rather than two.

Radar, Line   

A circular line chart. Excellent for cyclical data, such as hourly or monthly 
figures.

Table 4-1: Chart Types (continued)

Chart Type Description
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Radar, Area Chart   

Radar chart shows distribution of several parameters and their relation 
between each other. Several radar areas are drawn and each area is powered 
by a different data model. 

Radar charts are also referred to star or spider graphs. They are used 
primarily as a means to compare the data sets.

Waterfall   

Waterfall charts show components of a total with positive and negative 
values in different colors. It is used for specialized applications such as price 
analysis in manufacturing.

Pareto   

A pareto chart is used to graphically summarize and display the relative 
importance of the differences between groups of data.

Dial   

A dial chart represents one or more values as needles on a circular or 
semicircular surface.

Table 4-1: Chart Types (continued)

Chart Type Description
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Histogram, Vertical   

A histogram bar chart represents a frequency distribution. The height of the 
bars represent observed frequencies.

This chart gives the Vertical representation.

Histogram, Horizontal    

A histogram bar chart represents a frequency distribution. The height of the 
bars represent observed frequencies.

This chart gives the Horizontal representation.

Table 4-1: Chart Types (continued)

Chart Type Description
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APPENDIX A
Workspaces

This chapter describes the features and functionality of the Workspaces. It includes the following topics:
❑ Overview
❑ Working With Workspaces
❑ Configuring A Report
❑ Creating A Report
❑ Runtime Grid Operations
❑ Deleting A Workspace

Overview
Workspaces are a collection of objects corresponding to a functional unit of work. A workspace can contain any 
number of objects arranged across panes on a single page or across multiple pages depending on the functional 
requirements of the workspace user. A workspace is the primary run-time object for user interaction.

The Workspace module enables you to create and store any number of reports and panes across pages. The 
workspaces that you create can be stored in specific folders. You can replicate a workspace by saving a copy of the 
workspace. You can also collaborate the reports that you create and perform UEVs on them. These reports can then 
be sent for approval and implemented.

Working With Workspaces
To access the Workspaces summary page:

From the left navigation area, click Workspaces. The Workspaces summary page opens showing a list of all the defined 
workspaces available in the application.

      

You can perform the following actions on the Workspaces summary page:
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❑ View workspace properties. See “Viewing a Workspace”.

❑ Create workspaces. See “Creating A Workspace”.

❑ Organize workspaces by storing them in specific folders. See “Creating A Workspace”.

❑ Sort workspaces in ascending or descending order. See “Creating A Workspace”.

❑ Deleting workspaces. See “Deleting A Workspace”.

Viewing a Workspace

You can view a workspace in one of the following ways:

❑ In the left navigation area, all the workspaces available in the application appear. Click on the workspace that you 
want to view. The workspace page opens.

❑ The workspace title on the summary page functions as a link. Click on the workspace title for which you want to 
view the grid. The workspace page opens.

        

This section describes the structure of the workspace view. 

The workspace page contains the following:

❑ Workspace title - The workspace title shows the name of the workspace.

❑ Workspace pages  - The workspace pages appear as tabs on the runtime view. There are as many tabs as the 
number of pages that you inserted. The title of each of these tabs is what you specified in Page Properties while 
inserting a page. If the page titles are truncated, move the mouse pointer over the tab to see the complete title in 
a tool tip.

You can have any number of pages in each workspace.
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❑ Navigation buttons  

• Next  - Proceed to the next set of pages in the workspace run-time view

• Previous - Return to the previous set of pages in the workspace run-time view

❑ Workspace Panes - The workspace panes appear on the runtime view and there are as many panes as you 
inserted. The title of each of these panes is what you specified in Pane Properties while inserting a pane. If the 
pane titles are truncated, move the mouse pointer over the tab to see the complete title in a tool tip.

You can have a maximum of four panes in each Workspace page.

❑ Grid - The grid contains a tabular representation of the data defined while creating a workspace. The data is 
presented in rows, columns, page (filter), and other axes.

❑ Chart - The chart is a graphical representation of the data shown in the grid. The data is presented in various 
types of charts.

Creating A Workspace

The Workspaces module enables you to create workspaces. 

To create a workspace:

1 Click Create on the Workspaces summary page. The Workspace Properties page opens:

       

The Workspace Properties page shows the following two panes:

• Properties

• Comments

Setting Properties for a Workspace
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2 Enter a title for the workspace in the Title field. The title that you enter is displayed as the workspace title on 
subsequent visits to this workspace.

3 Provide a description for the workspace in the Description field.

4 The Share dimensions field allows you to share filter dimensions across pages and panes. To share dimensions, see 
“Configuring A Report”.

5 The Created by field shows the username with which you logged in to create the workspace. (name of the user 
creating a workspace).

6 The Changed by field shows the user name of the user who has made changes to the workspace definitions.

7 The Status field allows you to select a status for the workspace. The available options are:

• Finalized

• Draft

• Proposed

The status is only indicative and does not have a bearing on other processes in the application. Change the status 
as necessary. 

8 The Access type field enables you to choose the audience of the workspace contents. The available options are:

• Public - Select Public if you wish to share the contents of the workspace with other selected users or groups.

• Private - Select Private if, only you as the owner, want to view the contents of the workspace.

9 The Publish field allows you to add recipients who can view the workspace contents. To add recipients, see 
“Adding A Recipient”.

10 The Allow edit by recipients option allows you to grant ‘Read’ or ‘Read&Edit’ privileges to the recipients for a public 
workspace. Select Yes to grant ‘Read&Edit’ access to the recipient, or click No to grant only ‘Read’ access to the 
recipient. By default, No is selected. To view the different scenarios based on privilege of recipients, see “Recipient 
Feature Access”.

Note For private workspaces, this option is disabled.

11 The No of pages field shows the number of pages that the workspace contains. If you are creating a new workspace, 
this field shows numeral 0 as this is the first page you are creating. This field is not editable.

12 The Allow query cancellation option allows you to hide or show the Cancel Query dialog box. Select Yes show the 
Cancel Query dialog box, or select No to hide window.

13 The Date created field shows the date when you create the workspace.

14 The Due date field shows the date by which decisions taken on workspaces need to be implemented. The current 
date is displayed by default in the Due date field. You can change the due date as required. To change the due date, 
use the Calendar button beside the Due date field. 

15 The Comments pane facilitates adding and deleting comments in a workspace. For details, see “Adding/Deleting 
Comments”.

16 Click Close to return to the workspace page without saving your changes, or click Apply to save your changes and 
return to the previous page.

Adding/Deleting Comments

The Comments pane allows you to add comments to a workspace.

The Add comment field enables you to provide additional comments for the workspace. You can enter a comment that 
contains not more than 100 alphanumeric characters.
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To add comments, enter your comments in the Add comment field and click Add. The comments get added to the 
Comments field.

The Comments field shows the comments that were previously entered by the workspace owner. The comments are 
preceded by the user ID of the owner and the date on when the comment was added. You cannot delete comments 
entered by other users.

To delete previous comments:

1 Select a comment in the Comments field and click Delete. The application shows the following message:

Are you sure you want to delete comments?

2 Click OK to confirm deletion, or click Cancel to cancel your selection. Both the operations close the message 
window.

Adding A Recipient

The owner of the workspace can add recipients who will be allowed to view the workspace contents. The same will 
be enabled when you grant access to public workspaces. The recipients' dialog box will display the groups that the 
folder under which the workspace is being created has access to.

The Workspaces module enables you to add recipients who can view the workspace contents. You can add recipients 
to only public workspaces. 

1 To add recipients, click Add Recipients. The Add Recipients window opens showing a lists of all groups that the folder 
under which the workspace is being created has access to.

      

2 To add recipients from the Groups' list, select one or more groups from the respective list.
Alternatively, enter the group name in the field where the text cursor is visible. That particular group name gets 
highlighted in the list. 
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3 Click Add . The selected groups get added to the recipients list on the right.

4 To remove a recipient from the recipients list, select one or more recipients and click Remove . The selected 
recipients are removed from the list.

5 Click OK to save the changes and to exit from the Add Recipients dialog box. The Recipients field shows the updated 
list of recipients.
Click Cancel to exit from the Add Recipients window without saving the changes.

Recipient Feature Access

The access rights assigned to recipients plus the selection of the Allow edit by recipients option determine the availability 
of the following features to recipients:

Example 1:

If you select No for the Allow edit by recipients option and the recipient has ‘Read&Edit’ privilege for Workspace, then 
the recipient would not have access to the following features:

❑ Save State 

❑ Workspace Properties

❑ Standard Selector 

❑ Further, the Page/Pane right-click options that would not be accessible are:

❑ Pane Properties

❑ Insert Page

❑ Page Properties

❑ Delete Page

❑ Insert Pane

❑ Delete Pane

Also, the recipient would not be able to edit or delete the workspace.

Example 2:

• If you select No for the Allow edit by recipients option and the recipient has only ‘Read’ privilege for the workspace, 
then the recipient would not have access to the features listed above in Example 1. Additionally, this recipient 
would not be able to edit or delete the workspace.

Example 3:

• If you select No for the Allow edit by recipients option and the recipient makes a private copy of the workspace by 
clicking Save As, then the recipient could make changes to his copy of the workspace (depending upon the 
‘Read’ or ‘Read&Edit’ privilege privileges to Workspaces module). The changes in the private copy would not 
be reflected the original public workspace.

Note The Save As of a workspace to a public folder will be available only to recipients who have the ‘Publish’ 
privilege.Without the ‘Publish’ privilege, the ‘Save As’ operation will only allow a workspace to be saved to 
a private folder. 

Example 4:

• If you select Yes for the Allow edit by recipients option and the recipient has ‘Read&Edit’ privilege for the 
Workspace, then the recipient can edit or delete the workspace.
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Sharing Dimensions And Axes

The Workspace module allows you to share dimensions as well as axis(axes) across pages and panes in a workspace. 
You can click Share  in the Workspace Properties page to perform the same. 

The Share feature enables you to selectively share the dimensions and/or axis(axes) from a pre-defined pane across 
pages and panes. When you share a dimension or axis across a set of pages and panes, at any given point in time, all 
the selected pages and panes reflect a common dimensional view inherited from the pre-defined pane. 

The pane with all the pre-defined dimensions is termed as Master pane and the panes which share these dimensions 
are termed as Linked panes. Grid operations and functionalities like Top/Bottom, Rank, Sort performed on the Master 
pane are reflected in all its Linked panes, but not vice versa. 

For example, consider a report with three panes namely: Pane 1, Pane 2, and Pane 3 containing the dimensions 
Product, Region, and Customer, along with Time dimension. Select Pane 1 as your Master pane and share 
the Time dimension with Pane 2. The Time dimension in Pane 3 is not shared from Pane 1. If you perform a Drill 
Down operation on Time dimension member, 2002 in Pane 1, Pane 2 is refreshed to display the corresponding 
changes and Pane 3 would not have any impact. For more illustrations on sharing dimensions, see “Examples”.

The changes due to the shared dimensions across the panes and pages of a workspace can be saved with a single save 
state operation. When you re-open this Workspace, the Workspace is loaded with the changed dimensional view 
across all the shared pages and panes of the Workspace.

The Master pane is highlighted in a pale yellow color to demarcate it from the other panes as shown below:
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To share dimensions,

1 Click Workspace Properties  on the common toolbar. The Workspace Properties page opens.

2 Click Share  on the Workspace Properties page. The Share Dimensions dialog box opens. The Share 
Dimensions dialog box contains the General and the Advanced tabs.

The General tab of the Share Dimensions dialog box window is displayed as shown:
      

In the General tab of the Share Dimensions window, 

3 The Select model drop-down list shows a list of models you have access to. Select a model from the drop-down list. 
By default, the first model in the list is displayed.

4 The Master pane drop-down list shows a list of all the report panes available in the workspace. 

The Master pane shows the pane names in the following format:

<PageName - PaneName>

Select the pane that you want to set as the Master pane. The axes and/or dimensions of this pane can be shared 
across all panes and pages in the workspace. 

The grid operations performed on the selected Master pane are also reflected in all the other panes which share 
the axes and/or dimensions from the Master pane.

5 Select the Select the Axes to Share option to share the required axes across panes.

The following options are enabled:

• Row - Select Yes to share the Row axis, else select No.

• Column - Select Yes to share the Column axis, else select No.

The Row and Column options are enabled only when you select the Select the Axes to Share option.
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The Linked panes reflect or inherit the exact dimensional state of the shared axes from the Master pane. The pre-
existing axes or the dimensions of the selected axes on the Linked pane are lost.

For an illustration on the same, see “Example to illustrate the sharing of Axis across panes”.

6 Select the Select the Dimensions to Share option to share the required dimensions across panes.

• The Available Dimensions list shows all the dimensions available in the selected model.

Select one or more dimensions from the list and click Add  to add the selected dimensions to the Shared 
Dimensions list.

The selected dimensions are shared across all linked panes in which these dimensions are used.

• To exclude dimensions from the shared list, select the dimensions that you do not want to share and click  
Remove . 

The Select the Dimensions to Share section is enabled only when you select the Select the Dimensions to Share option.

For an illustration on the same, see “Example to illustrate sharing of Dimensions across panes”.

Note You can share both axis(axes) and dimensions across panes and pages. 

7 Click OK to save your selections and exit, or click Cancel to cancel your selections and exit from the Share Dimensions 
window.

To continue the selective sharing of dimensions and/or axes or linking of panes to the Master pane, click the 
Advanced tab in the Shared Dimensions window. The Advanced tab is displayed as shown:
     

The Advanced tab of the Share Dimensions window has two sections namely, Shared Axis and Shared Dimensions. 

Use the Shared Axis (  and ) buttons to expand and collapse the two sections. The Shared Axis Collapse  button 
indicates that the section is collapsed and theShared Dimensions Expand  button indicates that the section is 
expanded and contents appear. The Shared Axis section expands only when an axis is shared and the Shared 
Dimensions section expands only when a dimension is shared.
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In the Shared Axis section,

8 The Select shared axis drop-down lists the axis(axes) that are shared in the General tab of the Shared Dimension 
window. Select the required axis for which you want to link the report panes, from the drop-down list. 

9 Select the required panes you want to link to the Master pane from the Available Panes column using the 
corresponding checkbox in the Linked panes column. 

The Available Panes column shows all the available report panes. By default, the checkbox corresponding to the 
Master pane name is disabled and all the existing report panes are linked to the Master pane.

10 Click  to expand the Shared Dimensions section and view the contents. The Advanced tab opens as shown:

        

In the Shared Dimensions section,

11 The Select shared dimension drop-down lists the dimensions that are shared in the General tab of the Shared 
Dimension window. Select the required dimension that you want to share across the specified report panes, from 
the drop-down list.

12 Select the required panes you want to link to the Master pane from the Available Panes column using the 
corresponding checkbox in the Linked panes column. 

The Available Panes column shows all the available report panes for the given workspace. By default, the checkbox 
corresponding to the Master pane name is disabled and all the other existing report panes are linked to the Master 
pane.

Note By default, a new pane added to the report after setting the master and Linked panes, will not be linked to 
the master pane.
You have to explicitly link this pane to the master pane using the Linked panes checkbox.
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13 The option Enable page filter sharing through Linked panes allows the propagation of any member selection change 
made to the shared dimensions present on the page-filter axis of a Linked pane to all the shared panes, including 
the Master pane.

For example, assume that you have a workspace with three shared panes, Pane1 (Master pane), Pane2 (Linked 
pane), and Pane3 (Linked pane) respectively, with the Product dimension, present on the Page-filter axis of 
Pane2, shared across the Panes. You can select the Enable page filter sharing through Linked panes option to enable the 
propagation of a member selection change performed for the Product dimension (shared dimension) on the 
page-filter axis of Pane2 to the corresponding page filter axis on the Master pane (Pane1), as well as to the other 
Linked pane (Pane3).

The page-filter axis dimensions, if shared, contain the More option in all the Linked panes that enables you to add 
new members to the existing dimensional selections as well to share the corresponding changes across all the 
Linked panes, including the Master pane. If you select members using the More option on a Linked pane, the 
selected members are reflected for the corresponding dimension in all the other Linked panes as well. 

14 Click OK to save your selections and exit, or click Cancel to cancel your selections and exit from the Share Dimensions 
window.

Examples

Example to illustrate the sharing of Axis across panes

Consider a report with four panes namely: Pane1, Pane2, Pane3, and Pane4. Let the four panes have the dimension 
member set as shown:

        

Sharing the row axis of Pane1 with Pane2, Pane3, and Pane4 results in changes in the row axis of all the Linked panes 
as shown:
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Note that the previously existing dimension members of Pane2, Pane3, and Pane4 on the row axis are replaced by 
the shared axis members of Pane1.

Similar changes occur when you share axis(axes) across pages in a workspace.

Example to illustrate sharing of Dimensions across panes

Consider a report with four panes namely: Pane1, Pane2, Pane3, and Pane4. Let the four panes have the dimension 
member set as shown:
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Sharing the Time dimension of Pane1 results in changes in the Time dimension members in Pane2, Pane3, and 
Pane4 as shown:

        

Note that the existing member set of Time dimension on the respective axes of Pane2, Pane3, and Pane4 have been 
replaced by the member set of Pane1. 



Agile Analytics 2.1.1

A-14 PPM & PQM User’s Guide

The shared dimension member set of the Master pane is reflected in all the Linked panes. with the changes occurring 
in the respective axes.

Similar changes occur when you share dimensions across pages in a workspace.

Points to remember while sharing dimension:

❑ When you do any changes to the Linked pane and try to save the changes using the Save feature, the following 
message is displayed:

The changes to the Linked panes cannot be saved. Linked panes can only be 
changed through master pane.

Click OK to continue.

❑ Removing a share from a master pane results in reversing the applied share operation on the Linked pane. The 
Linked pane grid reverts to the state that it was in, prior to the application of the share operation.

❑ The following functionalities are not available for Linked panes:

• Edit button on the pane-specific toolbar

• Selector through the right-click options

• Data Filter Display on the pane-specific toolbar

• Custom Measures

❑ Only the creator of the Master pane can delete the same. 

When any other user tries to delete a Master pane, the following error message is displayed:

The selected pane is a master pane and cannot be deleted. Deselect this pane as a master pane from the Shared 
Dimensions dialog box.

Click OK to continue.

❑ Shared Dimension functionality is not supported for Asymmetric reports. The impact of shared dimensions on 
Asymmetric reports is as follows:

• If the master pane has shared dimensions on the asymmetric axis, operations performed on such members are 
not propagated to the Linked panes.

• If the Linked pane has shared dimensions on the Asymmetric axis, operations performed on such members in 
the master pane are not propagated to the Linked pane.

• When you change an existing Symmetric report to an Asymmetric report, the following message is displayed:

Shared dimensions would not be available for asymmetric report. Are you 
sure you want to continue?

Click OK to continue, else click Cancel to exit without making the changes.

❑ Shared Dimension functionality is not supported for Scheduled reports. The impact of shared dimensions on 
Scheduled reports is as follows

• When you change a Linked pane from an on-demand report to a scheduled report, the changes in the master 
pane are not propagated to the Linked panes.

• When you change a Linked pane from a scheduled report to an on-demand report, the changes in the master 
pane are updated to the Linked panes.

❑ The Share Dimension button is disabled in the workspace run-time page in the following cases:

• For workspaces attached to collaboration

• For workspaces that are opened from an unapproved decision

❑ A user with read privilege to workspaces cannot share and remove share functionality.
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❑ The shared dimension functionality is not applicable when you upgrade the application from any of the older 
version. You have to explicitly share the dimensions after you upgrade.

Editing A Workspace

You can edit reports in a workspace from the Workspace Summary page. 

To edit workspaces,

1 On the Workspace Summary page, select a workspace and click Edit. The Edit Workspace dialog box opens showing 
the reports in a workspace.

       

Note The Edit button is not available to users with Read privileges to the Workspace module.
You can select only one workspace on the summary page to edit.
The application does not permit you to edit a workspace for which the Allow edit by recipients 
property is set to No.

The report details are displayed in the following two columns: 

• Page view - shows all the reports and their respective panes from the selected workspace. 

• Pane type - shows the type of the report against the panes. The type of reports include:

• Report 

• Text 

• Member creation 

• Master report 

• Linked report 

• Indicator 

• Not configured

• Scheduled report

2 Select the pane that you want to edit in a workspace and click Edit. The RPM Selector opens. For details on editing 
a report, see “Editing A Report”.

You can select only one pane to edit. You cannot select pages to edit. Selecting pages is only applicable for a delete 
operation. If you select a page and click Edit, the application prompts you to launch the workspace to edit a page.
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You cannot edit an Application pane, Indicator pane, or a Linked pane. If the pane that you selected to edit is any 
of these panes, the application shows a message indicating that you cannot edit such a pane.

3 To delete one or multiple panes and pages, select the panes or pages that you want to delete and click Delete. The 
application prompts you to confirm deletion. Click OK to confirm deletion, else click Cancel. The selected panes 
or pages are deleted.

Deleting a page also removes all the panes that exist in the page that you selected to delete. Note that a Master 
pane cannot be deleted.

Organizing Workspaces

The Workspaces module enables you to organize workspaces into specific folders.  

To move your workspaces into specific folders,

1 Select one or multiple workspaces by clicking on the corresponding checkbox. 

2 Click Move to Folder  on the top right corner of the Workspaces summary page. The Select Folder window 
opens showing the available folders.

       

You can drill down on a main folder to view the sub folders within that main folder.

3 Select a folder or sub folder into which you want to move the workspaces.

4 Click OK to accept your selection, or click Cancel to cancel your selection.

Sorting Workspaces

This feature in the Workspaces module facilitates sorting workspaces in the list either in ascending or descending 
order. You can sort the workspaces by Status, Title, Description, Due Date, Owner, or Created Date. A sort operation 
performed on objects in a workspace folder is saved for that folder.



Appendix A Workspaces

A-17

The workspace objects in a folder are, by default, listed alphabetically in ascending order in the Title column. The 
default sort order also applies to workspaces that are renamed or moved across folders according to the prevalent 
sort order of workspaces in that folder. 

If you choose to sort by title, description, or owner, the workspaces are listed alphabetically either in ascending or 
descending order.

If you choose to sort by status, the workspaces are listed in the following manner:

❑ Ascending Order

• Draft

• Proposed

• Finalized

❑ Descending Order

• Finalized

• Proposed

• Draft

The columns in the page provide a sorting button. To sort the workspaces:

Click  to put the items in ascending order and click  to put the items in descending order. When you 
reverse the order of the items, the button changes so that only the applicable button is displayed. The header area of 
the field that you are sorting is highlighted in a darker color.

Deleting A Workspace

You can delete workspaces from the Workspace summary page.

To delete a workspace:

1 Select one or more workspaces by clicking the corresponding checkboxes. 

2 Click Delete. 

The following message appears:

Are you sure you want to delete the selected report?

3 Click OK to confirm deletion, else click Cancel.

Deleting Multiple Workspaces

If a recipient selects multiple workspaces and clicks Delete, and then clicks Yes to confirm the deletion, the selected 
workspaces will be deleted. However, if any of the selected workspaces have the ‘Allow edit by recipients’ property set to 
No, then they cannot be deleted, and the following message is displayed:

‘Some of the selected workspaces could not be deleted since you do not have the permission to delete published 
workspaces’. 

Workspaces for which the recipient is the owner (private workspaces) or where the ‘Allow edit by recipients’ property is 
set to Yes will be deleted.

Configuring A Report
The Analytics application enables you to design and configure a report using workspaces. The functionality of the 
workspace is described in:

❑ Creating a report
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❑ Accessing the Create Selection window

❑ Create Selection window elements

Creating A Report

Reports are extensively used to perform what-if analysis in a business environment. For example, you can design 
reports to sort and analyze sales activity, results, and projections based on your business requirements. Typically, in 
an organization, managers would require the following kinds of reports to analyze business performance in their area 
of responsibility:

❑ Store Manager – Space planning reports

❑ Category Manager – Category sales reports

❑ Account Manager – Retail chain account performance/Category comparison 

❑ Marketing Manager – Sales forecast

❑ Sales Manager – Order booking and revenue

❑ Production Manager – Component availability and Production status reports 

❑ CEO – Exception reports and management by exception – Overall performance

The Create Selection window allows you to specify the position, sequence, hierarchy of the members on a report to 
suit your reporting needs.

From the Create Selection window you can:

❑ Create a report

❑ Edit a report

❑ Synchronize a workspace with changes in the Agile Analytics model

Workspace Summary Page
1 To create a report, log on to the RPM application and select Workspaces. 

2 Click Create and enter the workspace properties details. For details, see “Creating A Workspace”.

3 Click OK. A blank workspace page opens.

4 Click Click here to create report.

The windows opens listing the available reports.

Edit Report 

Click Edit Report  on the pane-specific toolbar. The window showing reports opens.

Right-click Menu

1 Right-click on the grid. The right-click menu appears. 

2 Select Selector >Standard. The Create Selections windows opens.   
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Create Selection Window Components

The following table lists the user interface elements on the Create Selection window:
       

Table A-1: Buttons, and Common Fields    

Item Description

Buttonss

Move Up - moves a selected item up in the selected axis list. The workspace grid of the report updates 
immediately to reflect the changes. The selected members will appear on the report grid in the same order 
as they appear in the RPM Selector.

Move Down - moves a selected item down in the selected axis list.

Search - opens a dialog box where you can search for a member by providing a search criteria.

Add - moves the selected members to the Member Selections list.

Remove - removes selected members from the Member Selections list. Removing a member from the list 
prevents the member and its associated data from being displayed in the application.

Function based selections - adds members selected on the basis of relationships with each other to the 
Selected axis list.

Remove All - removes all the members from the Selected axis list.

Step 1 2 3 - indicates the current page in the RPM Selector that the user is working on by highlighting the 
page number.
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Creating A Report

Creating a report is structured into the following three step process: 

1 Selecting members - allows you to select members individually and/or according to their relationship with each 
other in the dimension hierarchy. 

2 Refining the scope of the member selections - allows you to refine member selections using the following 
functions: 

• Filter - Attribute/Data value

• Sort 

• Top-Bottom

• Group by 

3 Defining pane properties - allows you to define the workspace pane properties.
Previewing the report layout - allows you to modify the placement of dimensions on the different axes of the 
report.

You can see visual step indicators all through the report creation process.

Expand/collapse buttons are associated with axes listed in the first page and the Type drop-down list in the 
second page of the RPM Selector. 

 indicates that the axes listed and the function operation details are expanded. Click the expand button 
to expand the axes listed in the first page and to view the operation details in the second page of the RPM 
Selector.

 indicates that axes listed and the function operation details are collapsed. Click the collapse button to 
collapse the axes listed in the first page and the operation details in the second page of the RPM Selector. 
When in a collapsed state, summary text on the operation performed is displayed on the second page of 
the RPM Selector.

Buttons

Shows the previous page.

Advances to the next page.

Applies changes and closes the page.

Cancels a task and returns you to the workspace grid without applying your changes.

Resets the Member List view to the default all root level tree view of the members. This is particularly useful 
after performing a Search, when the search returns a flat view of matching members.

Updates the report with the changes done in the model.

For more information, see “Synchronizing A Workspace With Changes In The Agile Analytics Model”.

Restores the axes listed to the default expanded view.

Common Field

Model drop-
down list

Lists all the models that the user has access to. The first model in the list is selected by default. This drop-
down list is editable only in the first page (Create Selections) of the RPM Selector if the report is being 
created.

Table A-1: Buttons, and Common Fields (continued)   

Item Description
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The report creation process is described in the following sections:

❑ “Selecting Dimension Members”

❑ “Selecting Members By Applying Filters”

❑ “Defining Pane Properties And Previewing the Layout”

Selecting Dimension Members

You can select dimension members on the first page Create Selections.

The basic structure of the Create Selections page is as follows:
          

❑ Report Name - is displayed on the top of the page in the following format: Workspace title>Page title>Pane title.

❑ Pane Title - allows you to enter a name for the report pane.

❑ Dimension List - contains a list of available dimensions from the selected model. By default, the dimensions of the 
first model in the Model drop-down list appear.

❑ Member List - provides a hierarchical view of the members in the dimension you select in the Dimension List drop-
down list. By default, the member hierarchy of the first dimension in the Dimension List drop-down list appears.

❑ Member Selections - lists all the selected members in any of the following four axes:

• Row

• Column

• Page Filter

• Other
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❑ Selection Buttons - allow you to place the dimension members into individual axis, remove the dimension 
members, and move up/down the selected dimension members.

You can add dimension and measure members individually and/or according to their relationship to each other in 
any of the following methods: 

❑ “Adding Members to the Axes Individually”

❑ “Adding Members to the Axes by Relationship”

❑ “Using Custom Hierarchies in Reports”

❑ “Using Saved Selections in Reports”

❑ “Searching for a Member”

Adding Members to the Axes Individually

To add individual members to the required axes:

1 Select a model from the Model drop-down list. 

2 Select a dimension from the Dimension List drop-down list. The members of the selected dimension are displayed 
in a hierarchical view in the Member List field.

3 Select a member from the Member List field. You can use Shift-Click or Ctrl-Click to select multiple members in the list.

You can also select members by searching for the members. See “Searching for a Member”.

4 Click Add. A dialog box opens showing the following menu options:

       

• Row - adds selected members to the row axis.

• Column -adds selected members to the column axis.

• Page - adds selected members to the page axis.

• Other - adds selected members to the other axis.

Select the option that you require.

Alternatively, you can select the member and drag and drop to place it in the required axes in the Member Selections 
list. See “Drag and Drop” in the following section.

Drag and Drop

Members can be dragged from the Member List and dropped into the required axes lists. You can select multiple 
members and drag them simultaneously. When a member is selected to drag, only the member gets added and the 
children, if any, of this member are not dragged.

You cannot use the drag and drop feature to move dimension members across axes or within an axis list and also to 
remove members from the Member Selections list.

Adding Members to the Axes by Relationship

You can add dimension and measure members to a selection which are ordered by relationship. You can add these 
members in terms of children, leaves, descendants, and siblings relationships, or by directly specifying the level. 
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For example, if we have two years' data for 2001 and 2002, and the hierarchy has years > quarters > months > weeks 
with an outline resembling the following: 

       

The results of member selection of Q1-2001 by relationship are shown below:       

Table A-2:    

Option Select Level Select Children Select Descendants Select Siblings Select Leaves

Results of Selected 
members for Q1-
2001

Q1-2001 JAN-2001 Q2-2001 Wk01-2001

Q2-2001 JAN-2001 Wk01-2001 Q3-2001 Wk02-2001

Q3-2001 FEB-2001 Wk02-2001 Q4-2001 Wk03-2001

Q4-2001 MARCH-2001 Wk03-2001  Wk04-2001

Wk04-2001 Wk05-2001

Wk05-2001 Wk06-2001

FEB-2001 Wk07-2001

Wk06-2001 Wk08-2001

Wk07-2001 Wk09-2001

Wk08-2001 Wk10-2001

Wk09-2001 Wk11-2001

MARCH-2001 Wk12-2001

Wk10-2001 Wk13-2001

Wk11-2001

Wk12-2001

Wk13-2001
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To add members by relationship:

1 Select a model from the Model drop-down list. 

2 Select a dimension from the Dimension List drop-down list. 

3 Select a member from the Member List. You can use Shift-Click or Ctrl-Click to select multiple members in the list.

4 Click Function based selections . A dialog box opens showing the following menu options:

       

• Select children

• Select level

• Select leaves

• Select descendants

• Select siblings

Note These options are dynamically displayed based on the members selected.

When you mouse over any of these options, another dialog box opens showing the following menu options:

• Row - adds selected members to the row axis.

• Column adds selected members to the column axis.

• Page adds selected members to the page axis.

• Other adds selected members to the other axis.

Select an option you require from function based selections and then select an option from the axes for the 
selected members.

Note You cannot use the drag and drop feature for function based member selections. 

The selected members appear in the Member Selections list in the specified axes. To re-order them as needed click 
Move up and Move down.

Using Custom Hierarchies in Reports

You can use custom hierarchies in the reports that you design. All the created custom hierarchies are available in the 
to the users who have access to these custom hierarchies. The custom hierarchies are displayed only if the selection 
of model and the dimension matches with the custom hierarchies definitions. 

Click on the Custom Hierarchies folder to view the contents, such as, the root level child folders and the leaf level 
custom hierarchies. Calculated members in the custom hierarchies are displayed in italics to visually distinguish 
them from other members in the custom hierarchy. Calculated members are displayed as non-editable cells on the 
workspace grid.

You can now select a custom hierarchy or its members to add to the report. The procedure to add members remains 
the same as adding dimensional members. 
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All the function based selections, except the Level function, can be used for adding custom hierarchies or its 
members. The Level function would not be available for use for calculated members in a custom hierarchy.

Using Saved Selections in Reports

You can use saved selections in the reports that you design. All the saved selections created for a dimension are 
available in the to the users who have access to them. 

For more information on Saved Selections, see the section on Creating and managing saved selections in the Right-
Click option chapter.

Click on the Saved Selections folder to view the sub folders and saved selection objects. 

You can view the definition of a saved selection object by clicking  for that saved selection object.

You can select a saved selection object to add to the report. The procedure to add the object remains the same as 
adding dimensional members. 

Note Function based selections cannot be used while adding saved selection objects to the report.

If the selected saved selection object had dimension functions like, Attribute, Top/Bottom, in its definition, these 
functions do not appear in the second page.

Searching for a Member

The Search feature in the enables you to locate a specific member of a hierarchy quickly and efficiently without having 
to drill down on the members in the hierarchy. You can search for members using part or all of the member name, 
and then easily add them to the Member Selections list. This is useful when you have a large number of members.

To search for dimension members:

1 Click the Search button on the Member List. The Search window opens.   

       

2 The Hierarchy drop-down lists the hierarchies of the dimension that you selected from the Dimension List drop-
down list. Select the hierarchy that you require from the Hierarchy drop-down list.

For example, if you are searching for the member Q1 -1997, you should select AllTime.

3 Optionally, you can further filter down to the level in the selected hierarchy in which the member that you are 
searching for exists.

The Level drop-down lists the levels of the hierarchy for the selected dimension.

For the above example, select Quarters from the Level drop-down list.

4 Use the search operators listed in the Member Name drop-down list to search for members.
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The available operators are:        

5 Enter the search criteria in the Search field. The application performs a search depending on the search operator 
that you selected.

For example, to search for Q1 - 1997, enter the text required depending on the search operator that you specified. 

If you have specified Begins with, then enter Q in the Text field.

Entering a search text is mandatory, else the application shows the following message:

Enter a search text.

Click OK to continue.

6 Click Search. Matching members are displayed in the Members List. If matching members are not found, then the 
application shows the following message in the Member List:

No matching members found. Refine the search.

All the members whose names start with Q are displayed in the Member List. This list would include Q1 -1997, the 
member that you were searching for.

You can now add the resultant members to the required axes in the Member Selections list using the drag and drop 
or Add/Functions buttons.

Navigate to the second page by clicking Next on the first page to further refine your selections by applying filters 
and also narrow down the scope of your selections using function based selections on the second page.

Selecting Members By Applying Filters 

The second page (Filter, Sort, and Rank) allows you to refine member selections for a report. 

Table A-3: Search Operators    

Search Operator Function

Contains returns all members whose names contain the entered text.

Does not contain returns all members whose names do not contain the entered text.

Begins with returns all members whose names begin with the entered text.

Does not begin with returns all members whose names do not begin with the entered text.

Ends with returns all members whose names end with the entered text.

Does not end with returns all members whose names do not end with the entered text.

Equals returns all members whose names exactly match the entered text.

is not equal to returns all members whose names that do not match the entered text.
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The basic structure and features of the second page are as follows:

❑ In addition to facilitating function based member selections, the second page also functions as a summary page 
that shows the operations defined for a report.

❑ The functions are displayed in the order in which they are applied. The results from the first operation will be 
made available as data for the next operation. For example, if the first operation is a filter and the second is a Top/
Bottom, the results of the filter operation will be available as data for performing the Top/Bottom operation.

❑ The Type drop-down list contains functions based on which you can define criteria to select members. If the 
report does not contain any existing defined operations, then the Type drop-down list is preceded with First to 
indicate that it is the first operation to be performed on the report. 

After an operation is selected, the Type drop-down list with the same options is displayed below the first set, 
preceded with Then.

You can refine member selections based on the following functions:

• “Filtering Members Based on Attributes”

• “Filtering Members by Data Value”

• “Selecting Top/Bottom Members”

• “Sorting Dimension Members”

• “Grouping Dimension Members”
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Filtering Members Based on Attributes

Dimension members in the database tables are often stored with other pertinent information that qualifies the 
members. For example, a customer table might contain customer names and also the street address, city, state, zip 
code, and phone number for the customers. These additional pieces of information are called member attributes. 

Attribute based filtering can help you narrow down on the range of selected members. For example, you might have 
millions of customers and you can use a zip code attribute to query for only those customers with a certain zip code. 

To select members based on attributes and their values:

1 Select Filter from the Type drop-down list. The Filter operation details are displayed. 

       

2 The Filter drop-down list shows a list of all the dimensions selected on the first page. 

Select the dimension for which you want to filter the members by their attribute values.

If the dimension selected for the filter operation does not have any attributes defined, then the application shows 
the following message:

The selected dimension does not have any attributes defined. Select a 
different dimension for the filter operation. 

Click OK to proceed.

3 The drop-down list preceded with by shows the following options:

• Attribute

• Value

To filter members based on attributes, select Attribute.

To filter members based on data values select Value. For details, see “Filtering Members by Data Value”.

4 The where drop-down lists all the attributes defined for the selected dimension. Select an attribute.

You can select multiple attributes to specify the filter condition. See “Defining Filters based on Multiple 
Attributes”.

5 Use the operators listed in the Operators drop-down list to filter for members.

The available operators are:          

Table A-4: Operators    

Search Operator Function

is equal to returns all members that exactly match the specified attribute/value combination. 

is not equal to returns all members that do not match the specified attribute/value combination.

is greater than returns all members greater than the specified attribute/value combination. 

is greater than or equal to returns all members greater than or equal to the specified attribute/value combination.

is less than returns all members lesser than the specified attribute/value combination.

is lesser than or equal to returns all members lesser than or equal to the specified attribute/value combination.

begins with returns all members whose value begins with the specified attribute/value combination.
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• If you select the following values from the Operator drop-down list:

* begins with

* does not begin with

* ends with

* does not end with

* contains

* does not contain

then the Filter operations details are displayed as below:
        

Provide an attribute value in the field next to the Operator drop-down list.

6 If you have selected any of the following operators, you need to select attribute values by clicking :

• is equal to

• is not equal to

• is greater than

• is greater than or equal to 

• is less than

• is less than or equal to

The Select Attribute Values dialog box opens.

does not begin with returns all members whose value does not begin with the specified attribute/value combination.

ends with returns all members whose value ends with the specified attribute/value combination.

does not end with returns all members whose value does not end with the specified attribute/value combination.

contains returns all members whose value contains the specified attribute/value combination.

does not contain returns all members whose value does not contain the specified attribute/value combination.

Table A-4: Operators (continued)   

Search Operator Function
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7 The Available Values list shows all the available values for the selected attribute. 

Select a value from the list.
You can use Shift-Click or Ctrl-Click to select multiple values in the list.

8 To add values to the Selected Values list, use the Add button. 

To remove values from the Selected Values list, use the Remove button.

9 The Selected Values list shows all the selected values for the selected attribute.

You can select multiple values in the list.

10 Click OK to save your selections. The selected attribute values are displayed in the filter criteria definition.

To return to the second page without applying your selection, click Cancel.

11 To know the count of resultant members that match the filter criteria would retrieve, click . 
Click OK to close the dialog box that shows the number of resultant members.

Note The validate functionality supports only attribute filters. If a value filter is present, the application shows 
an error message.

12 The Drill Filter checkbox allows you to specify a defined filter as a drill filter. For information on drill filters, see 
“Working with Drill Filters”. 

Note If you have specified a filter as a drill filter, and you then click , The application retrieves the 
count of matching members across the entire dimension.

13 To select multiple attributes for a dimension, click  . See “Defining Filters based on Multiple Attributes”.

14 To delete a defined filter condition, click Delete  associated with the respective filter condition.

15 To return to the previous page, click Back.

To proceed to the Layout page of the Selector, click Next 

To save the applied filter operation with the new condition and refresh the grid with members that match the 
new filter condition, click OK.

To return to the workspace grid without applying your changes, click Cancel 
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Defining Filters based on Multiple Attributes

You can use multiple attributes to filter members in a dimension. This includes attributes defined at the same 
hierarchical level or at multiple levels. Using multiple attribute based filtering, you can filter dimension members 
that match a combination of attribute criteria. 

To select multiple attributes:

1 Select the first attribute by following the procedure described in the earlier section.

2 Click .

3 Select either of the following two options to specify your filter criteria:

• And (default selection) - the attribute values available for selection are based on the previous attribute filter 
value selections. See the example given below.

• Or - the attribute values available for selections are not based on previous attribute selections.

4 Select an attribute as described in the earlier section.

5 Click  to define further attribute filter criteria as required.

Example

This example illustrates specifying multiple attributes for a filter criteria.
       

Attribute 1 (Product Group Number= 30, 80) AND Attribute 2(Product Family Member=1,7).

The application shows the expected number of members that match the filter criteria on clicking . 

Consider a case where the filter criteria definition includes a combination of attribute and value filters in the same 
definition block.
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For example, Attribute 1 (Product Group Number= 30, 80) AND Data Value (Net Sales>1000) AND Attribute 
3(Product Family Member=1,7),

The application does not consider the data value filter, if used, while cascading the filter criteria across these multiple 
attributes. 

Examples

The examples in this section illustrate retrieving members based on an attribute filter criteria previously defined.

Example to illustrate filtering members based on attributes

Consider a business case where the business analyst of Wheeling Cycle, a fictitious company, intends to analyze the 
influence of market trends and customer preferences on the sales of a product. The analyst uses the filter feature in 
the RPM selector to design a report that shows the sales for a product based on customer preference, for example, 
an attribute value. 

The analyst selects the dimensions and members required to generate the sales report on the first page as shown 
below:

Product: Avenger, Bighorn, Cougar, Diana, Grizzly, Competitor

Time: 2002, 2003

Measures: Sales

Region: United States

Customer: Bike Emporium, Crown Cycles, Michele’s Cyclery

The report on the workspace grid is generated as shown below.
       

Now, the analyst intends to generate a report by defining a filter criteria that would project sales of black colored 
bicycles. On the second page of the selector, the analyst defines the following filter criteria:
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After designing the report, the report on the workspace grid is displayed as below. The product Competitor matches 
the defined filter condition. The analyst uses the data in the report to evaluate the sales of a product based on 
customer preferences.

      

Working with Drill Filters

Drill Filters can be applied on a workspace grid to perform a custom drill down operation. All the filters defined as 
drill filters during the report creation process will be available for selection on the workspace grid. You can select the 
filters that you require and apply them on the report while drilling down to a specific level.

For example, if an attribute filter is defined for a dimension during design time, and if it is selected as a drill filter, 
then on the runtime report on doing a custom drill down, the application retrieves only those members that match 
the attribute filter criteria definition.

Working with drill filters includes the following steps:

❑ Defining a drill filter

❑ Selecting a drill down level

❑ Specifying a default drill filter

❑ Applying a custom drill down

Defining a Drill Filter

You can define drill filters for the following operations:

❑ Value filter

❑ Attribute filter 

❑ Top/bottom 

To define a drill filter, 

1 Define the filter criteria for any of the above mentioned operations that you require. Follow the procedure 
described in the earlier section.

2 To specify a defined filter as a drill filter, select the Drill Filter checkbox for that filter. 

This filter would be defined and saved along with the report but would not be applied by default on the workspace 
grid. 

Using Drill Filters on the Workspace Gird

Drill filters are defined for a particular dimension. You can apply a drill filter to specific levels in that dimensional 
hierarchy. 

To apply drill filters, do the following:

❑ Select the required level in the dimensional hierarchy to which you want drill down. 

❑ Select a filter that you might want to apply while performing the above drill down operation.

If attribute filters are used in the drill filter criteria, the application applies the custom drill down operation in the 
following way:

❑ checks the level at which the filter is defined at design time;
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❑ checks the member or level selected to perform a filtered drill down;

then,

❑ If the level information matches for both the cases, then the application applies the attribute filter to the matching 
level to which the drill down is specified. The members that match the filter condition are retrieved and 
displayed.

❑ If the level does not match, then the application drills down to the immediate next hierarchical level and returns 
the child members. The filter condition is not applied in this case.

To apply custom drill filters,

1 Select a row/column header of the dimension member to which you want to apply the filter and right-click. The 
right-click menu opens. 

2 Select Manage>Custom Drill Down. The Drill Options window opens showing the drill filters defined for that dimension.

3 The Drill to drop-down list shows the following hierarchy functions: 

• Leaves

• Children 

• Descendants 

• Sibling

• Level 

Select the hierarchical level to which you want to apply the filter from the Drill to drop-down list.

When a filter is applied to the selected member by using any of these hierarchy functions (for example, Children) 
the selected member is drilled down to the specified hierarchy level (Children) and the filter is applied at that 
particular level.

For example, if you have selected to apply a filter on the Children of the member Accessory, the filter is applied 
to the members Add-on, Maintenance, and Safety which are the child members of Accessory.

All the levels that are present in the selected dimension are displayed under the Level grouping in the drop-down 
list.

For example, the product dimension contains the levels, Family, Group and Product and these are displayed in 
the drop-down list.

Note The level information is not displayed for instances where it is not applicable; for example for root 
members and calculated members.

See the example provided in the section “Adding Members to the Axes by Relationship” for information on how 
members are positioned in a dimensional hierarchy based on hierarchy functions.

4 Select one or multiple filters which could be used as default filter while performing the custom drill down 
operation.

5 Click OK to save your selections or click Cancel and return to the workspace grid.

Applying a Custom Drill down Filter

After specifying the drill option and the default filters, you can apply the drill filter to a member or multiple members 
on the workspace report.

To apply a custom drill down filter,

1 On the workspace report, select a dimension member or multiple members and right-click.

The right-click menu opens.

2 Click Custom Drill Down.
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The default filter is applied to the selected members at the specified level in the dimensional hierarchy.

If a default filter or drill option is not selected, then on clicking the Custom Drill Down option, the children of 
the selected member are retrieved.

Example

Consider the following grid. 
      

The following filter condition is defined as a drill filter.
      

On the workspace grid, let us apply the defined filter to the children of the member Accessory.

1 On the workspace grid, select Accessory and right-click. The right-click menu opens.

2 Select Manage>Custom Drill Down. The Drill Options dialog box opens.
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3 From the Drill to drop-down list, select Children (current member).

4 Under Drill Filters, select the drill filter that you defined and click OK.

5 On the workspace grid, right-click and select Custom Drill Down.

The filter is applied to the child members of Accessory and all the child members that contain values greater than 
120000 for the Sales measure are retrieved and displayed on the grid as below. 

      

Filtering Members by Data Value

You can refine your selections by defining a data value filter based on which a subset of the hierarchy members can 
be retrieved in a resulting report. You can also define filters and apply them dynamically on the workspace grid for 
a specific member group. 
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To filter members based on data values,

1 Select Filter from the Type drop-down list. The Filter operation details are displayed. 

2 The Filter drop-down list shows a list of all the dimensions selected on the first page. 

Select the dimension you want to filter by data value.

3 The drop-down list preceded with by shows the following options:

• Attribute

• Value

4 Select Value from the drop-down list. 

5 You need to specify a metric using the values of which you would retrieve the dimension members. The measure 
drop-down lists all the members of the measures dimension you selected in the first page. Select a measure 
member that you require from the drop-down list. 

Use the More option in the drop-down list to select measure members other than those selected on the first page 
of the Selector. 

6 Select an operator from the drop-down list.

7 Enter a value in the field. 

The text based on first cell appears when there is no explicit based on criteria selection.

The text based on custom selection appears when there is an explicit based on criteria selection.

8 To specify a based on criteria, see “Specifying a based on Criteria”. Use the More option in the drop-down list to 
select dimension members other than those selected on the first page of the Selector. 

If you do not select a member for specifying the based on criterion, then the selected dimension is treated as a 
dynamic dimension. The members of a dynamic dimension are selected dynamically on the workspace grid based 
on the defined filter expression. The value filter operation on dynamic dimensions is explained using examples.

See “Examples”.

9 To know the number of resultant members that the match filter criteria, click Validate. Click OK to close the dialog 
box that shows the number of resultant members.

10 The Drill Filter checkbox allows you to specify a defined filter as a drill filter. For information on drill filters, see 
“Working with Drill Filters”. 

11 To select multiple value filters for a dimension at the same level, click More. 

12 To delete a defined filter condition, click Delete (  ).

13 Click Back to return to the previous page, or click Next to proceed to the Layout page of the Selector, or click OK to 
save the applied filter operation with the new condition and refresh the grid with members that match the new 
filter condition, or click Cancel to return to the workspace grid without applying your changes.
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Specifying a based on Criteria
1 Click Edit. The Based on Criteria dialog box opens.

      

2 The Select dimension drop-down list shows the dimensions present on the row and column axes. Select the 
dimension that you require. This list does not include the Measures dimension and the dimension you selected 
to perform the filter by data value operation

3 The Select Member list shows the following options based on the operation you choose to perform:

• First member - applies the Top/Bottom, Filter, and Sort criteria to the first member of the selected dimension. 

• For each member - This option is visible for dimensions that exist on the same axis as the one that is being filtered. 

The application applies the top/bottom and value filter criteria to every member of the selected dimension.

• All selected members - this option is visible when the based on dimension is on the same axis as the dimension 
on which the top/bottom operation is performed.

• List of Members - all the members of the selected dimension are visible.

These members are the ones that you selected on the first page. Select a member that you require. 

• More.. - allows you to select dimension members other than those that are already selected on the first page. 

4 Use the Add/Remove buttons to move your selections from the Select Member list to the Complete Criteria list.

5 The Complete Criteria list shows your selections for each dimension listed in the Select dimension drop-down list.

6 Click OK to save your selections or click Cancel to return to the second page.

Examples

Case1: This example illustrates the value filter operation when a member is explicitly selected while defining the 
based on criteria 

Consider the following workspace grid. Let us define a filter based on a data value to retrieve members that match 
the filter criteria.
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The filter criteria is defined as shown below. Notice that the member 1996 is selected explicitly for the based on 
criteria.

            

          

The members on the grid are filtered according to the specified filter criteria and the resultant grid appears as follows.
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Case 2: This example illustrates a value filter operation when a dynamic dimension present on the same axis as the 
dimension that is being filtered.

The application considers all possible combinations of the based on and filter dimensions while determining the 
match criteria for the defined value filter.

The following filter condition is defined for the value filter operation.
            

          

Notice that all members containing a value greater than 115000 for the Sales measure are displayed on the resultant 
grid.
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Selecting Top/Bottom Members

You can retrieve members in a report according to their cell values. For example, you might retrieve the top10 
products by sales amounts, or the bottom 5 states by revenue. A report that meets such a criteria can be generated 
using the Top/Bottom function selection. Options for ranking include Top or Bottom.

The Top/Bottom operation can be performed 

❑ only on dimension members selected in the first page,

❑ only if at least a single dimension and measure member are selected in the first page, and 

If there are multiple dimensions on a single axis, and a top/bottom operation is defined for any one of these 
dimensions, then the resulting grid would display the top/bottom dimension members of the specified dimension.

To select dimension members dynamically based on Top/Bottom function:

1 Select Top/Bottom from the Type drop-down list. The Top/Bottom operation details are displayed.

2 The Top/Bottom drop-down list shows the following options:

• Top

• Bottom

Select an option as necessary.

3 Type a number in the field beside the Top/Bottom drop-down list. This option allows you to specify how many 
members to keep in the final list. The default specification is 1. 

For example, to retrieve the top/bottom 5 customers, type 5. 

4 The next drop-down lists all the dimensions whose members you selected on the first page in all the axes. Select 
a dimension the members of which you want to retrieve using the Top/Bottom operation.

5 Select the type of values on which you would want to perform the Top/Bottom operation. The available options 
are:

• Absolute

• Percent

For example, if your Top/Bottom criteria specifies to retrieve the top/bottom five absolute product members 
based on net sales, the application calculates the data value of each product and the net sales combination and 
returns the top/bottom 5 members. 

If the criteria specifies to retrieve the top/bottom five percent of product members based on net sales, application 
calculates the data values of each product and the net sales combination and then computes the top/bottom five 
percent of product members.
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6 You need to specify a metric using the values of which you would retrieve the top/bottom dimension members. 
The measure drop-down lists all the members of the measures dimension you selected in the first page. Select a 
measure member that you require from the drop-down list. 

Use the More option in the drop-down list to select measure members other than those selected on the first page 
of the Selector. 

7 To specify a based on criteria for the top/bottom operation, click Edit. For information on how to specify a based 
on criteria, see “Specifying a based on Criteria”. Also, see the section “Examples to illustrate supported cases in 
specifying a based on criteria”.

The text based on first cell appears when there is no explicit based on criteria selection.

The text based on custom selection appears when there is an explicit based on criteria selection.

8 You can retrieve top/bottom members for a unique group of the selected dimension by using the Group by 
function. For details on using the Group by function, see “Grouping Dimension Members”. 

To retrieve top/bottom members for a unique group, select a dimension on which you want to preserve 
grouping. If you do not select a dimension to preserve grouping on, then the dimension grouping will not be 
maintained and the top/bottom members are retrieved from across the groups.

9 Use the More button to define further top/bottom criteria as required.

The dimension selected in the first condition cannot be changed and is displayed as read only in further top/
bottom criteria.

Nested Top/Bottom - You can specify a condition wherein you would want to retrieve the top 10 products and the 
bottom 10% of these products. To do this, specify the top 10 condition on the Product dimension. Then select 
OR and specify the bottom 10% condition. Use the More button to define a nested criteria.

10 The Drill Filter option allows you to apply filters dynamically on the workspace grid. You can specify a defined filter 
as a drill filter by selecting the Drill Filter checkbox for that filter. For more information on drill filters, see 
“Defining a Drill Filter”.

Examples to illustrate supported cases in specifying a based on criteria

All selected members

This section explains with an example the behavior of a top/bottom operation when you do not select an explicit 
member for the based on criteria; in other words if you have selected the option All selected members from the Select 
Member list in the Based on Criteria dialog box.

Prerequisite Task

As a prerequisite to performing a top/bottom operation using the option All selected members, you need to create a 
surrogate member for the based on dimension using which you want to perform a top/bottom operation. Create the 
surrogate member in the Agile Analytics model using the Agile Analytics Workspace. 

For instructions on how to add a member using the Analyticworkspace, refer the section Adding a Member in the 
chapter Working with Dimensions and Members in Building Models with AnalyticWorkspace Guide. This guide is part 
of the Agile Analytics documentation set.

Case 1 - All selected members option selected for the based on dimension. The based on dimension is on the same axis 
as the dimension on which the top/bottom operation is performed.
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The sample grid contains the following dimensions and members on the row and column axes.

Row Axis

Product: Add-on, Maintenance, Safety, Mountain, Racing, Specialty, Touring

Time: 1996, 1997, 1998, 1999

Column Axis

Region: California

Measure: Sales

This grid represents the sales for the region California for the years 1996, 1997, 1998, and 1999. 

To retrieve the top 3 products in California based on sales for the years 1996, 1997, 1998, and 1999, the following 
filter criteria is defined:
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The application performs a aggregation of the values (1996, 1997, 1998, 1999) for each member. See the table below 
for aggregated values for each product member.        

The top three members are Racing, Mountain and Specialty. The application retrieves these three members and 
shows them on the resultant grid. Note that the Time members (1996, 1997, 1998, and 1999) and their values for the 
top three members are displayed in the resultant grid and the aggregated value is not displayed.

Table A-5: Aggregated Values    

Member Sum Rank

Add on 800200.99 5

Maintenance 650477.21 7

Safety 713096.18 6

Mountain 11682893.5 2

Racing 1421476235 1

Specialty 3485925.03 3

Touring 1186487.56 4
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For each member

This section explains with an example the behavior of a top/bottom operation when you select the option For each 
member from the member drop-down list.

In such a case, the application would apply the top/bottom filter criteria to every member of the selected dimension 
and a union of the top members for each group is retrieved.

In some cases, based on the tuple combination, even if you have specified top 3 members, the application could 
retrieve more than 3 members.

Example 1

Consider the following sample grid.
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A top filter is defined to retrieve the top 3 members from the sample grid. The filter will be applied to every member 
of the based on dimension.

          

         

The application determines the top 3 members by applying the filter to all the time members (1996, 1997, 1998, and 
1999) for every product member sequentially. For example, the member with the greatest value for 1996 will be 
displayed on the resultant grid. Similarly, the operation is performed for all the time members and the resulting top 
members are displayed on the grid.
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Example 2

Consider the following sample grid. 
        

A top filter is defined to retrieve the top 2 members from the sample grid. The filter will be applied to every member 
of the based on dimension.
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In the following grid, note that the application retrieves 3 members while the filter conditions specifies to retrieve 
the top 2 members. The application determines the top 2 members for every selected member of the based on 
dimension and picks the union of the resulting top members. Observe that in the sample grid, the top 2 members 
for the following time members are:

2000 - Other, Veracruz

2001 - Other, Sonora

2002 - Other, Veracruz

The union set of these members is Other, Veracruz and Sonora. These members are retrieved and displayed in the 
resultant grid.

            

Member Selection

This section explains with an example the behavior of a top/bottom operation when you select an explicit member 
from the member drop-down list.

In such a case, the application applies the top/bottom filter to the specified based on dimension member.

The following top filter is defined to retrieve the top 3 product members based on sales for the Time member 1996.
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The resultant grid shows the following top three members for the year 1996. Note that the grid also shows the 
complete tuple set for each member.

        

Example to illustrate the top/bottom operation based on Percent value

Consider the cross section of the following grid:



Agile Analytics 2.1.1

A-50 PPM & PQM User’s Guide

          

The values of Sales are displayed in the first column. ‘Percentage Contribution’ for each ‘Sales’ cell is displayed under 
‘Percentage Contribution’ column and also ‘Cumulative Percentage’ is displayed under the ‘Cumulative Percentage’ 
column.

Now, if you perform a ‘top 10 percent of sales’, only the cell containing 590 as the value is returned as the value 590 
contributes upto 22.26% of the total sales.

If you now perform ‘top 42 percent of sales’, the cells containing the values 590 and 500 are returned as both of these 
add up to 41.12 percent of the total sales (see the ‘Cum. Percentage ‘column) and so on and so forth.

Sorting Dimension Members 

You can facilitate rearranging members of dimensions while configuring the grid such that an appropriately sorted 
grid is rendered on the workspace grid.

You can perform only a single sort operation for an axis. If you try to sort more than once on an axis by selecting a 
dimension present on the same axis on which a sort was already performed, the application shows a message 
prompting you to select a dimension present on a different axis.

The sort operation is applied on the selected dimension members on the workspace grid in the order in which you 
specify the sort operation. The sort button is displayed on the workspace grid.

To sort dimension members on an axis:

1 Select Sort from the Type drop-down list. The Sort details appear.

2 The Sort drop-down list shows a list of all the dimensions whose members you selected for the row and column 
axes on the first page. 

Select the dimension whose members you want to sort.

3 Select the type of sort you want to perform on the dimension members from the by drop-down list. The available 
options are:

• Datavalue

• Alphabetic

4 Select the order in which you want to sort. The available options are:

• Ascending

• Descending

If you have selected to sort alphabetically, go to step 8. To sort by data value proceed to the next step.
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5 You need to specify a metric using the values of which you would sort the dimension members. The Measure drop-
down lists all the members of the measures dimension you selected in the first page. Select a measure member 
that you require from the drop-down list. If you do not select a member, then the application sorts based on the 
first measure member displayed in the drop-down list. 

Use the More option in the drop-down list to select measure members other than those selected on the first page 
of the Selector. 

6 To specify a based on criteria for the sort operation, click Edit. For information on how to specify a based on 
criteria, see “Specifying a based on Criteria”. 

The text based on first cell appears when there is no explicit based on criteria selection.

The text based on custom selection appears when there is an explicit based on criteria selection.

7 You can choose to preserve grouping on dimension members while performing a sort operation by using the 
Group by function. For details on using the Group by function, see “Grouping Dimension Members”.

8 Use the More button to define further sort criteria as you require.

9 Click OK to save your sort definitions and to refresh the grid with members that match the new filter condition, 
or click Cancel to return to the workspace grid without applying your changes, or click Next to proceed to the Layout 
page, or click Back to view the first page.

Grouping Dimension Members

You can preserve grouping of members in specific dimensions while sorting or ranking members from multiple 
dimensions by using the Group by function. 

To apply the Group by function:

1 Select Group by from Type drop-down list. The Group by operation details are shown.

        

2 The Group by details dialog box shows the following lists:

• Rows

• Columns

Make your selections in the required list.

3 The Available Dimensions field lists all the dimensions of members you selected for the row/column axis on the 
first page. To preserve grouping, select a dimension on which you want to preserve grouping while performing 
a sort or rank operation. Move your selections to the Selected Dimensions list by using the appropriate arrows.

4 Click OK to save your Grouping definitions and to refresh the grid with members that match the filter condition, 
or click Cancel to return to the workspace grid without applying your changes, or click Next to proceed to the Layout 
page, or click Back to view the first page.

Important Notes on workspace grid behavior for a Sort operation
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❑ If a sort operation in the Selector is not already applied on an axis and if a workspace grid sort operation is applied 
on the workspace report, a new sort operation is introduced in the sort operation details in the Selector and will 
display as the last operation.

❑ If a sort operation in the Selector is applied on an axis, and if a workspace grid sort operation is applied on the 
same axis, then the application removes the previously applied operation in the Selector and applies the new 
workspace grid sort operation.

❑ If preserve grouping feature is applied on a sort operation on the workspace grid, and if a Group by operation 
has not been previously applied in the Selector, then the application introduces a new Group by operation in the 
Selector.

❑ If a Group by operation already exists in the Selector, and if preserve grouping feature is applied on the workspace 
grid, then the application removes the previously applied Group by operation in the Selector and applies the new 
workspace grid preserve grouping criteria in the Group by operation in the Selector.

Examples

The examples in this section illustrate sorting members based on the filter criteria you defined.
All the examples display a cross section of the ChangeCAST workspace to provide a focused view. 

Example to illustrate sorting without preserving grouping on dimensions members

Consider the following grid. This grid represents the Average Sales Price for the regions California and Washington 
for Q1 and Q4 of the year 2003. The Time, Product, and Customer dimension members are placed on the row axis, 
while the Region and Measure dimension members are placed on the column axis.

       

Let us sort the values of Q1-2003 and Q4-2003 without maintaining the grouping of the dimensions on the row axis.
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The values of Q1 and Q4 2003 are sorted in ascending order based on Average Sales Price. Observe that the members 
on the dimensions have lost their grouping and are now placed in the order of their respective values which are 
sorted in ascending order.

        

Example to illustrate sorting while preserving grouping on dimensions members

On the following sample grid, let us sort the values of Customer dimension members while maintaining the 
grouping of the Product dimension on the row axis.

      

Access the second page to define the sort criteria that you require and to apply the Group by function. Define your 
settings as shown below.
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Observe that the values of Avg Sales Price are sorted in the descending order while maintaining the grouping of the 
Product dimension on the row axis. 

Using a Combination of Operations

You can combine a top/bottom operation with a filter to produce queries such as “show me the top ten products where 
the color is blue.” Note that the first applied operation should always be the filter operation. The results from the filter 
operation will be made available as data for the next operation.

The example provided below illustrates the usage of the following combination of filter operations:

❑ Attribute based filter operation

❑ Top/Bottom operation

❑ Sort operation

The results of the attribute filter operation will be available as data for the Top/Bottom operation and the results of 
this operation will be available as data for the sort operation.

The criteria for the attribute based filter operation is defined as below:
       

The resultant grid shows all product members that contain the values Black and Blue for the attribute Color.
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The Top/Bottom operation is now applied on these resultant members. The criteria for the top/bottom is defined as 
below:

      

The member that is selected for the based on dimension is Ultra Distance.

The resultant grid shows the top three regions, United States, Brazil, and Canada, based on Sales of the product Ultra 
Distance.

       

The sort operation is then applied on this resultant grid. The criteria for the sort operation is defined as below:
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The sales values for the product member Ultra Distance are sorted in descending order for the region dimension 
members.

      

Impact of Workspace Grid Operations on Applied Operations 
❑ Drill down 

A Drill down operation on the workspace grid results in the applied operations being removed without the 
application showing a warning to this effect.

When a Drill down operation is performed the application appends a ‘Drill down on <member>’ text in the 
selector.

❑ Drill up

A Drill up operation on the workspace grid results in the applied operations being removed without the 
application showing a warning to this effect.

When a Drill up operation is performed the application appends a ‘Drill up on <member>’ text in the selector.

❑ Keep only

A Keep only operation on the workspace grid results in the applied operations being removed without the 
application showing a warning to this effect.

The Selector shows the absolute members.
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❑ Remove only

A Remove only operation preserves the applied operations.

When a Remove only operation is performed the application appends a ‘Remove only <member>’ text against 
the member removed in the selector.

❑ Move across axis

A Move across axis operation preserves the applied operations. All the applied operations are preserved if move 
to page axis and move to other axis operations are performed.

If a swap axis or pivot operation is performed on the grid, these operations are reflected.

❑ Basic Selector

The basic selector resolves all the members resulting from Filter/Top/Bottom operation. The basic selector 
behaves similar to the RPM selector when member additions, removals and move up, move down operations are 
performed.

Notes on Applied Operations
❑ If a dimension in a row/column axis is removed by removing all the selected members from the axis, then any 

operation performed on the removed dimension is also removed. However, if a dimension specified as part of 
the based on criteria is removed, the applied operation is not affected.

❑ Removing a selected member which is also specified in the based on criteria does not affect the applied operation.

❑ Renaming a member does not affect the applied operation.

❑ If a member is deleted from the model and is the same member is specified in the based on criteria, the report 
would fail to execute. The user has to edit the report to delete the member.

Defining Pane Properties And Previewing the Layout

The Third page of the selector opens as displayed below:
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Click Expand ( ) to view the Pane Properties and Layout dialog boxes. 

Click Collapse ( ) to collapse the Pane Properties and Layout dialog boxes.

You can do the following on the third page of the RPM Selector:

❑ Define Pane Properties. See “Defining Pane Properties”.

❑ Preview the layout of the grid. See “Grid Layout”.

Grid Layout

You can previewing the layout of the grid after defining the members and their arrangement on the grid on the 
Layout page. You can change the layout to suit your reporting needs and the change will be reflected in the report 
on the workspace grid.

To view the layout of the report that you are configuring, navigate to the third page of the RPM Selector. The Layout 
page opens.
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The layout shows a schematic of the grid (no data display) and reflects the dimensions (not members) and measures 
members selected and placed in the specific axes in the RPM Selector.

Indicators of operations performed on a dimension are displayed on the dimension name. 

Refer to the table below for a representation of the operation indicators.        

Rearranging the Layout

You can move the dimensions across axes by using the drag and drop feature. You can also change the order of the 
dimensions in the axes using the drag and drop feature. The changes done in the Layout page are also reflected in 
the RPM Selector.

To move a dimension to a different axis:

Click and drag a dimension name from one axis to another.

To rearrange the order of the dimensions in an axis:

Table A-6: Operation Indicators    

Indicator Operation

Filter

Top/Bottom

Sort 



Agile Analytics 2.1.1

A-60 PPM & PQM User’s Guide

Click and drag the dimension name and drop it in the position that you require.

Points to note while moving or rearranging dimensions 

If you move a dimension, on which an operation is applied, across axes or try to change the order of the dimension 
in the same axis, then the application behaves in the following ways:

❑ removes the applied operation on moving the dimension to page or other axis.

❑ removes the applied grouping on moving across row or column axes or changing the order of the dimension. 

❑ changes the asymmetric report into a symmetric report on moving across axes or changing the order of the 
dimension. 

Editing A Report

You can edit an existing report according to your requirements using the RPM Selector.

The editing operations are described in the following sections:

❑ “Editing Member Selections”

❑ “Editing Functions”

❑ “Editing The Layout”

❑ “Deleting An Operation”

You can also change the model associated with the report. For more information on changing the model and 
synchronizing the report for the changes, see “Synchronizing A Workspace With Changes In The Agile Analytics 
Model”.

Editing Member Selections

You an edit member selections on an existing report to suit your requirements. Follow the procedure described in 
the section “Selecting Dimension Members” to select and arrange members as they would appear on the workspace 
grid. 

Editing Functions

Editing functions involves the following operations:

❑ “Editing Attribute Operations”

❑ “Editing a Top/Bottom Operation”

❑ “Editing a Sort Criteria”

Editing Attribute Operations

You can edit the attribute filter criteria that you specified for a report. 

To edit a filter criteria:

1 Click the Edit Report button on the workspace grid of the report that you want to edit. 

2 Navigate to the second page of the RPM Selector. 

3 You can change the dimension you want to apply the attribute on. If you change the dimension to sort on, the 
selected data in the rest of the filter criteria details would be removed and the default selections would be restored. 
The application shows a message to this effect and prompts you to confirm your action. 
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4 You can change the attribute if you require. If you change the attribute, the attribute values would be removed 
and the default selections would be restored. The application shows a message to this effect and prompts you to 
confirm your action.

5 You can change the attribute values as required. Edit the fields as necessary by following the procedure described 
in the section “Selecting Members By Applying Filters”.

6 Click OK to proceed with the change, else click Cancel.

Notes on summary information of defined attribute filter conditions

In the edit mode, summary information on the defined attribute filter conditions would appear as a header title 
when in a collapsed state.

The content of the summary information depends on the type of filter criteria defined. The following examples 
depict some of the summary header titles that appear based on the filter criteria specified:

❑ If more than one filter condition has been defined, using the And/Or operator, for a single attribute involving 
more than one attribute values (example - Black, Blue for a Color attribute), then the summary information is 
displayed as below:

First, Filter members of Product where Color is equal to Black or Blue.

❑ If more than one filter condition has been defined, using the And/Or operator, for a single attribute member with 
different filter operator (example- contains, does not equal, etc.), the summary information is displayed as below

First, Filter members of Product where Color contains B and Color does not equal BLUE

❑ For all cases where positive operands, for example, is equal to, is greater than, is less than, begins with, end with, 
contains, are used in multiple attribute value definition, the summary information is displayed as below:
First, Filter members of Product where Color is equal to Black or Blue.

❑ For all cases where negative operands, for example, is not equal to, does not begin with, does not end with, does 
not contain, are used in multiple attribute value definition, the summary information is displayed as below:
First, Filter members of Product where Color is equal to Black and Blue.

❑ If more than one filter condition has been defined, using the And/Or operator, for a single attribute member with 
more than one attribute values (example - Green and Blue) and with the same filter operator (example - equals/
does not equal, etc.), the summary information is displayed as below:

First, Filter members of Product where Color does not equal GREEN and BLUE

Editing a Top/Bottom Operation

You can edit the top/bottom criteria that you specified for a report. 

To edit a top/bottom criteria:

1 Access the RPM Selector from a workspace report that you want to edit. 

2 Navigate to the second page of the RPM Selector. 

3 You can change the top operation to a bottom operation or vice versa. If you change the operation, the selected 
data in the rest of the top/bottom criteria details would be removed and the default selections would be restored. 

4 You can change the dimension from the Dimension drop-down list. If you change the dimension, the selected 
data in the rest of the top/bottom criteria details would be removed and the default selections would be restored. 

5 Edit the other fields as necessary by following the procedure described in the earlier section.

Editing a Sort Criteria

You can edit the sort criteria that you specified for a report. 
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To edit a sort criteria:

1 Access the RPM Selector from a workspace report that you want to edit. 

2 Navigate to the second page of the RPM Selector. 

3 You can change the dimension you want to sort on. If you change the dimension to sort on, the selected data in 
the rest of the sort criteria details would be removed and the default selections would be restored. 

4 Edit the other fields as necessary by following the procedure described in the earlier section.

Editing The Layout

To change the placement of the dimensions on the grid, you can edit the layout page of that report. Follow the 
procedure described in the section “Rearranging the Layout”.

Deleting An Operation

The RPM Selector provides you with the option of deleting the operation that you specified.

To delete an operation:

1 Click Delete ( ) associated with the operation details. 

When you delete an operation, the next available operation, if any, is positioned at the deleted operation’s place. 
You can even delete a partial or an incomplete operation.

2 The application shows the following message when you click Delete ( ):

Are you sure you want to delete the selected operation.

Click OK to confirm deletion, else click Cancel.

Synchronizing A Workspace With Changes In The Agile Analytics Model

The changes done in the Agile Analytics model like deletion and/or renaming of members, causing changes in the 
member sets or the hierarchy functions, are not automatically updated in an existing workspace’s member selection 
list. Also, while editing a report, if you change the model associated with the report, the respective changes in the 
member list is not updated by default.

RPM application provides the ability to update the member selection list for such changes that are done in the model 
using the  Reconcile button in the RPM Standard Selector. Updating the report thus synchronizes the report definition 
to reflect the current state of the model. 

For more information on models in Agile Analytics, refer the Agile Analytics documentation suite.

Following are the use-cases where you might need the Reconcile feature:

❑ “Changing the Model Associated With the Workspace”

❑ “Deleted Members in the Model”

❑ “Renamed Members in the Model”

Also see, “Important Notes on Updating the Workspace”.

Changing the Model Associated With the Workspace

You can retain the existing report definition and change the model associated with the report during design-time. 
The member list of the newly selected model has to be synchronized with the existing report’s Member Selection list. 

Members present in the currently selected model and not there in the newly selected model are deleted from the 
Member Selections list.
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To change the model associated with a workspace and update the changes pertaining to the selected model in the 
Member Selection list of the workspace:

1 Open the required workspace.

2 Click Edit Report ( ) on the pane-specific toolbar. The ChangeCAST Selector opens.

Alternatively,

Right-click on the grid and the right-click menu appears. Select Selector >Standard... from the right-click menu. The 
RPM Selector opens.
         

3 Select the required model from the Model drop-down list and click Reconcile. The Member Selections list is updated 
and the reconcile report dialog box opens.

4 Click OK to return to the RPM Selector with the updated Member Selections list.

Deleted Members in the Model

When a member is deleted in the model, the workspace opens with a system generated error message during 
runtime, as shown below:
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Click Click here for details. The dialog box opens showing the details of the changed members as shown:
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Click Reconcile to synchronize the workspace with the current state of the model. The updated workspace is 
displayed.

Else, click Cancel to exit.

Renamed Members in the Model

When a member is renamed in the model, the workspace reflects the renamed members in the run-time. But, the 
Member Selection list in the RPM Standard Selector does not display the current state of the members. To update 
the Member Selection list of the workspace:

1 Open the required workspace.

2 Click Edit Report ( ) on the pane-specific toolbar. The ChangeCAST Selector opens.

Alternatively,

Right-click on the grid and the right-click menu appears. Select Selector >Standard from the right-click menu. The 
RPM Selector opens.

3 Click Reconcile. The Member Selections list is updated and the the reconcile report dialog box opens.

4 The dialog box shows the list of all changed members. Click OK to continue.

5 Click OK in the RPM Selector to return to the updated workspace.

Important Notes on Updating the Workspace
❑ If the existing report is synchronized with the model associated with it, the following message is displayed:

“The report definition has been reconciled”
Click OK to continue.

❑ The Reconcile feature is available for users with Edit privilege for the workspace.
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❑ Custom Hierarchy members used in a report are not updated with the Reconcile feature.

❑ During run-time, you have to perform a Save operation to save the changes that occur after updating the 
workspace.

❑ Scenario member used in the workspace, if removed from the model, would result in a non-editable grid in the 
reconciled workspace.

❑ If the function based selection is used in a report, and a member is changed in the model, the updated report 
would reflect the current hierarchy and you can change the function definition as required.

❑ Saved Selections used in the workspace would be synchronized for the current state of the model.

❑ Workspace with shared dimension and/or axis can be reconciled only after removing the share feature.

❑ The Report Information section reflects the changes in the Member Selection list after updating the report.

Runtime Grid Operations 
This section describes the runtime grid operations you can perform while working with the Workspace grid. You 
can perform the following grid operations during runtime: 

❑ “Working With Pages And Panes”

❑ “Working With Reports”

❑ “Defining Advanced Runtime Grid Operations”

❑ “Improved Data Controls”

❑ “Creating Calculated Members”

❑ “Selecting Cells Across A Pane”

❑ “Using Change Rules”

❑ “Creating A Dynamic Member”

❑ “Custom Measures”

❑ “Grid Data Filters”

❑ “Save Changes”

❑ “Canceling A Query”

❑ “To save a copy of the Workspace:”

In addition to these operations, runtime grid operations can also be performed in the following ways:

❑ Using the right-click menu options.

❑ Using the toolbars. See “To save a copy of the Workspace:”. 

Working With Pages And Panes

The Workspaces module provides you the capability to perform the following page, pane related actions from the 
Workspace view:

❑ “Inserting A Page/Pane”

❑ “Defining Pane Properties”

❑ “Modifying Page/Pane Properties”

❑ “Deleting a Page/Pane”
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Inserting A Page/Pane

To insert a Page:

1 Right-click on an active page tab. The right-click menu opens. Select Insert Page.

The Page Properties windows opens.
       

2 Enter a title for the new page in the Title field.

The Page position field is not enabled when you insert pages. You can position the workspaces pages as required 
by using the appropriate arrows associated with the Page position list.

3 To add comments, enter your comments in the Add comment field and click Add. The comment that you add gets 
displayed in the Comments field. The comment is preceded by your user ID and the current date.

4 Click OK to save your specifications or click Cancel to cancel your specifications. Both these operations close the 
Page Properties window.
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To insert a pane:

1 Right-click on an active page. The right-click menu opens. Select Insert Pane. The Pane Properties window opens.

       

The Pane Properties windows consists of the following sections:

❑ General

❑ Print Options

❑ Schedule Details

❑ Advanced

You can perform the following tasks on the Pane Properties window:

❑ Specify pane properties for the workspace report. See, “Defining Pane Properties”.

❑ Set printing options for the workspace report. See “Setting Printing Options”.

❑ Define Schedule Report details. See “Working With Reports”.

❑ Perform runtime advanced settings on the grid. See “Defining Advanced Runtime Grid Operations”.

Defining Pane Properties

The General tab on the Pane Properties window allows you to define the pane properties of a workspace report:

To define properties:

1 Enter a title for the new pane in the Title field.

2 The Current Model field shows the model from which the Workspace is created. This field remains empty when no 
reports are configured.
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3 The Report Type options are not applicable when inserting a new pane. Hence, these options are disabled.

4 The Enable active filter option enables the filtering of dimension members based on access as well as auto dispatch 
of filtered scheduled report to pre-determined recipients. 
This allows you as a report publisher to design and auto dispatch a single report without the need to filter 
individual reports for individual users.

Active filter is enabled through a concept known as “Active Dimensions”. Active dimension is the dimension for 
which user access as well as recipient is been pre-determined for its members. 

The auto filtering and auto dispatch is achieved through a ‘mapping table’ in the data warehouse which contains 
the following:

• User-to-member map: This determines the access, users have to the active dimension members. The system looks 
up this information to auto filter the contents in the report for each user.

• Recipient IDs: This determines the email id’s of the recipients. The system looks up this information to auto 
dispatch the report to the pre-determined recipients in the scheduled mode in the form of email.       

The above table is set up during data warehouse creation and revised periodically. Typically, the entire 
dimensional hierarchy in terms of members of the active dimension will have a mapping defined to users and 
their respective recipient ids in this table. 

Now, you as a report designer can put all the members (present in the mapping table) of the active dimension in 
the page axis. You can then set ‘Enable active filter’ to ‘Yes’ (in Pane Properties screen) and configure this report 
as a scheduled report. Also, you choose the active dimension to be the ‘iterator dimension’. 

When the scheduled report gets generated, an email is automatically dispatched to each user, present in the 
mapping table, with the generated scheduled report as an Excel attachment. Each user receives a report with only 
the members that the user has access to as defined in the mapping table. For example, users U1 and U3 will only 
see member M1, user U2 only sees member M2 and so on.

The active dimension name set in model management will be displayed next to the Enable Active Filter option. There 
can be only one active dimension per model.
For more information on how to set a dimension as an active dimension, refer to the Administration and 
Configuration Guide.

5 The Display alerts on report field enables you to decide the visibility of the alerts in the workspace.

Select On to see the Alerts on the workspace page, else select Off.

Comments

The comments section allows you to add or delete comments for the pane that you inserted.

To add comments, enter your comments in the Add comment field and click Add. The comment that you added gets 
displayed in the Comments field. The comment is preceded by your user ID and the current date. To delete added 
comment, select the comment and click Delete.

Click OK to save your specifications or click cancel to Cancel your specifications. Both these operations close the Pane 
Properties window.

Table A-7: Sample Mapping table in the data warehouse    

User Member (active dimension members) Email ID

u1 m1 u1@comany.com

u2 m2 u2@comany.com

u3 m1 u3@comany.com

u4 m3 u4@comany.com
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Modifying Page/Pane Properties

To modify page/pane properties:

1 Right-click on an active page tab. The right-click menu opens. Select Page Properties/Pane Properties. The Page/Pane 
Properties window opens. Edit the page/pane title if necessary.

2 Reposition the pages in the workspaces using the appropriate arrows.

3 The Comments field shows the previous comments entered for the page. To delete a comment, select the comment 
and click Delete. The comment gets deleted.

4 To add comments, enter your comments in the Add Comments field and click Add. The comment that you added 
gets displayed in the Comments field. The comment is preceded by your user ID and the current date.

5 Click OK to save your changes or click Cancel. Both these operations close the Page/Pane Properties window.

Deleting a Page/Pane

To delete a page:

1 Click on the page tab that you want to delete and then right-click on that page tab. The right-click menu opens. 

2 Select Delete Page.

The application shows the following message:

All data for this page would be lost. Are you sure you want to delete this page?

3 Click OK to confirm deletion, or click Cancel to exit from the message field without deleting the page.

If you click OK, the page is deleted. All the panes saved within this page also get deleted permanently. The next 
page, if available, is displayed.

If the Workspace contains multiple pages, on deleting a page, the next page is displayed and on deleting the last 
page, the preceding page if available, is displayed.

If the page that you want to delete is the only page available in the Workspace, then the Workspace shows a single 
page and a single empty pane.

To delete a pane:

1 Right-click on the pane that you want to delete in a page. The right-click menu opens showing the Delete Pane 
option. 

2 Select Delete Pane. 

The application shows the following message:

All data for this pane would be lost. Are you sure you want to delete this Pane? 

3 Click OK to delete the pane, or click Cancel to exit from the message field without deleting the pane.

If you select OK, the application responds in the following ways based on the pane layout.

• If the Workspace contains a single pane and if you select OK, then the Workspace shows a single empty pane.

• If the Workspace contains multiple panes, on deleting any pane, the remaining panes are displayed in a stack. 
For example, consider a Workspace containing four panes. If you delete a pane, the resulting layout of the 
Workspace will be 3 pane stacked.

Setting Printing Options

When you create or work with a report, you might want to archive or share that report for further analysis or 
comparison. The RPM application provides the flexibility to save the report in an easily usable and a printable format 
like a PDF or an HTML file.
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You can also define various print properties like the orientation of the PDF report, page size, theme, and header and 
footer texts. 

You can define various properties and formatting for the PDF reports generated. The properties you define are user 
specific and would be applicable to that particular report.

To define the required print properties, click the Print Options tab in the Pane Properties window. The Pane Properties 
window opens showing the Print Options:

       

The PDF Report Options section enables you to select the orientation of the generated PDF report. In the PDF Report 
Options section,

1 The Orientation field enables you to select the orientation format for printing the report. The available options are:

• Portrait - the orientation where the width is shorter than the height. 

• Landscape - the orientation where the width is longer than the height.

The Settings section enables you to set the size and theme for the page that is to be printed. In the Settings section,

2 The Page Size field enables you to select the size of the page. The available options are:

• Letter

• A3

• A4

3 The Theme field enables you to select the theme for printing the report. The theme would determine the look of 
the page. The available options are:

• Symphony - By default, this option is selected. When you select this option the report in PDF format would 
display as shown:
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• Alphablox - When you select this option the report in PDF format would display as shown:

     

• Coleman - When you select this option the report in PDF format would display as shown:
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• Financial - When you select this option the report in PDF format would display as shown:

      

• Greyscale - When you select this option the report in PDF format would display as shown:
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• Purple - When you select this option the report in PDF format would display as shown:

      

• SpreadSheet - When you select this option the report in PDF format would display as shown:
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• Swing -When you select this option the report in PDF format would display as shown:

       

The Other options section enables you to set the desired header and footer text for the printed report. The available 
options are:

4 The Header Text field enables you to enter the text you want to see as the header of the report.

5 The Footer Text field enables you to enter the text you want to see as the footer of the report.

6 Click OK to save your settings. The browser window with the Workspace in PDF format is displayed.
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Click Save in the Internet Explorer File menu to save the report as a PDF file on your system.

Note By default, Agile Software logo will appear in the top left corner of the printed HTML or PDF file.
If you want to change the logo or insert a new image in the printed HTML or PDF file, perform the 
following steps:
1. Save the required image as logo1.
2. Copy and paste this image (logo1) in the following location:
<Drive>:\IBM\WebSphere\AppServer\installedApps\<Hostname>\RPM.ear\con
fig\pdfimages\logo1
The old logo or image is replaced by the new one.
This logo or image would appear in the top left corner of the printed file.

For more information on defining the printing properties, contact Agile Support.

Working With Reports

Any report which shows current data on request is termed as an On-demand report. A report that is updated at a pre-
defined scheduled time and which is only displayed on request without being updated at that instance is termed as 
a Scheduled report.

The ChangeCAST Application provides you the capability to create the following types of reports:

❑ On-demand Reports - A report that is run/updated on-demand by the user. This report provides an interactive view 
to the stored data and supports runtime analysis and write-backs to the datawarehouse. 

❑ Scheduled Reports - A report that is generated on a pre-defined schedule and is stored in the system in a specific 
format such as HTML. 

RPM application provides the capability to define a report as a scheduled report. The report is updated and stored 
every time the scheduler runs. So, the report is rendered faster when it is requested for, due to reduced time it 
takes to retrieve the data of the report at that instance.

For example, consider a report containing the information on sales of thermal wear in each month across various 
states of a particular region. Let us assume, the winter season spreads along the first and the last quarters of the 
year in this region. The product sales is typically high during the first and the last quarters, and considerably low 
in the second and the third quarters. So, this report would not change significantly during the second and the 
third quarters. Hence, this report can be defined as a scheduled report which would get updated once a month 
in the second and third quarters. This would in turn, reduce the rendering time for each analysis during that 
period.

This option is useful, especially when the report is very huge and the report does not change very frequently. Also, 
when you want to store a copy of the report for any further analysis.

This section describes the operations you can perform with the On-demand and Scheduled reports:

❑ “Creating an On-demand Report”

❑ “Creating A Scheduled Report”

❑ “Changing an On-demand Report to a Scheduled Report”

❑ “Changing A Scheduled Report To On-demand Report”

Creating an On-demand Report

You can create an on-demand report using the ChangeCAST Selector. Every report created in the Workspace 
module is by default an on-demand report. To create a report, see “Creating A Workspace”.
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Creating A Scheduled Report

To create a scheduled report perform the following tasks:

1 “Creating an On-demand Report”

2 “Changing an On-demand Report to a Scheduled Report”

Changing an On-demand Report to a Scheduled Report

You can change an on-demand report to a scheduled report using the Pane Properties feature of the Workspace. To 
access the Pane Properties window:

1 Right-click on an active pane in the workspace and select Pane Properties from the drop-down list. The Pane 
Properties window opens showing the General tab:

      

2 The Report type field provides the following options:

• On-Demand

• Scheduled

The default selection is the On-demand option. Select the option Scheduled. 

When you select the option Scheduled, the following message appears:

“Select the schedule from the Schedule Details tab”

3 Click OK.  The Schedule Details tab of the Pane Properties window opens:
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The Schedule Report Generation Options section enables you to select the required schedule, view the date and time of the 
schedule report generation, select a group where the first user will be used to generate the report. In the Schedule Report 
Generation Options section,

4 The Select schedule drop-down list shows all the available schedules configured by the administrator in the 
Schedule Management module. Select a suitable schedule from the drop-down list.

By default, the first schedule in the drop-down list is selected. If there are no schedules created, then the list will 
be empty. If you try to save the changes or try to exit from the window without selecting a schedule, the following 
message is displayed:

“Please select a Scheduler, if it does not exist create one to configure the Scheduled Report.”

Click OK to continue.

5 The Last run date-time field shows the date and time when the scheduled report was last generated (the last run of 
the scheduler).

6 The Next run date-time field shows the date and time when the scheduled report is next scheduled to be generated 
(the next run of the scheduler).

7 The Run as drop-down list contains all the groups that you belong to. The Run as field is disabled for a private 
workspace and will by default select the logged in user’s group. Select a group for the scheduler to run to generate 
scheduled reports.

Note The first user of the selected group is used to access the AnalyicServer and generate a scheduled report. 
Depending on the selected groups' data access privilege, the scheduled report, after the generation, may or 
may not display data.
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The Generated Report Dispatch Options section enables you to select the target destination for the generated scheduled 
report, to publish the generated scheduled report and select the format in which you want the scheduled report to 
be dispatched. In the Generated Report Dispatch Options section,

8 The Mode of delivery option enables you to select the destination where you want the generated scheduled report 
to be dispatched. The available options are:

• Inbox - enables you to dispatch the generated scheduled report to the Messages Inbox in the RPM application.
Selecting this option enables Add Recipients . For more information, see “Adding A Recipient”. 

• Mail - enables you to dispatch the generated scheduled report to an external mail ID. 
Selecting this option enables Add Recipients  . For more information, see “Adding A Recipient”. 

• Links -enables you to save the generated scheduled report in a specified folder location on the application 
server. An application link is created pointing to this location and is available in the Links module in the RPM 
application.
Selecting this option enables Select Folder . 
To specify the folder where you want to save the generated report:

• ClickSelect Folder . The Select Folder window opens:

       

• Select the folder in the Links module where you want to save the system generated application link to the 
scheduled report.

• Click Cancel to close the dialog box and return to the report without selecting the folder or click OK to save 
the selection and return to the report.

Note In the General tab, if you choose Report type as Scheduled and set Enable active filter to ‘Yes’, then only the Mail 
option will be available in the Schedule Details tab. The Inbox and Links fields are disabled. The Mail option will 
also be disabled but checked indicating that RPM Application will use this option to dispatch the 
scheduled report. Also, the Add Recipients will be disabled since this report will be dispatched to all the 
matching users looked-up from the user mapping table. For more info see the Administration and 
Configuration Guide.
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9 The Dispatch as drop-down list shows all the available options for dispatching the generated scheduled report, 
depending on the Mode of delivery you select. The available options are:

• Link to HTML - allows the dispatch of generated scheduled report as an HTML file.

• Link to PDF file - allows the dispatch of generated scheduled report as a PDF file.

• PDF as attachment - allows the dispatch of generated scheduled report as an email attachment in the PDF format.
You can define the formatting styles for the generated PDF in the Print Options tab of the Pane Properties dialog 
box.  To have the Link to PDF and PDF as attachment options enabled:

• Install the Advanced PDF Engine

• Enable the property jReportInstalled in the Properties file

• Excel as attachment - Enables you to dispatch the generated scheduled report /Active scheduled report as an email 
attachment in the Excel format.

• Generated Schedule Report: To have the Excel as attachment option enabled, you have to set the property 
canSendAttachmentInMail in the Properties file.

• Active Scheduled Report: To have the Excel as attachment dispatched to all the matching users, the user 
mapping must be done in the data warehouse. For more info see Administration and Configuration Guide.

When a report is set as an Active Filter report (in General tab) and configured to be dispatched, the Dispatch as 
drop-down list shows Excel as attachment as the only option. However, for an iterative dimension (dimension 
used in page axis) it dispatches an excel file with separate worksheet for all qualified members, for non iterative 
dimension it dispatches an excel file with a single worksheet.

• PPT as attachment - Enables you to dispatch the generated scheduled reports/active scheduled reports as an email 
attachment in a PowerPoint format. This option is available by setting the property Allow attachments 
to yes in the system.properties file.

The availability and functionality of the various Dispatch as options depending on the Mode of delivery selected is 
summarized in the following table:       

Table A-8: Availability of the Dispatch as versus Mode of delivery options    

Mode of Delivery

Inbox Mail Link

Link to HTML Available
A link to the HTML file of the 
generated report is sent to 
your Messages Inbox.

To view the HTML report, 
you need not log in to the 
RPM application, but may 
have to provide the 
Application Server login 
credentials.

Available
A link to the HTML file of the 
generated report is sent to your 
email ID.

To view the HTML file, you have 
to log in to the RPM application.

Available
A link to the HTML file of the 
generated report is sent to your 
Links module.

To view the HTML file, you 
need not log in to the RPM 
application, but may have to 
provide the Application Server 
login credentials. The 
Application Server login 
credentials are the same as the 
RPM login credentials.
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Note When the generated scheduled report has only a chart, the report cannot be dispatched as an Excel 
attachment to the Mail.

When the generated scheduled report has both chart and grid, the report is dispatched as an Excel 
attachment to the Mail with only the grid. The chart is not present in the Excel attachment.

However, if enable active filter is set to yes, then charts will be supported in Excel format.

10 The Publish field enables you to select the recipients who can view the generated report. Click Add Recipients 
 to add the recipients. 

The Add Recipients dialog box shows all the active users and groups in the system. For more information see 
“Adding A Recipient”.

The Publish option is available only when the mode of delivery is Inbox or Mail.

11 Click OK to accept your selections, else, click Cancel to exit without saving your selections.
On clicking OK, you are returned to the workspace grid which shows the scheduled report that you defined.

Link to PDF file Not Available Available
A link to the PDF file of the 
generated report is sent to your 
email ID.

To view the PDF file, you need not 
log in to the RPM application, but 
may have to provide the 
Application Server login 
credentials. The Application 
Server login credentials are the 
same as the RPM login credentials.

Available
A link to the PDF file of the 
generated report is sent to your 
Links module.

PDF as attachment Not Available Available
The PDF format of the generated 
report is sent as an attachment to 
your email ID.

Not Available

Excel as attachment Not Available Available
The Excel sheet of the generated 
report is sent as an attachment to 
your email ID.

Not Available

PPT as attachment Not Available Available
The PPT of the generated report is 
sent as an attachment to your 
email ID.

Not Available

Table A-8: Availability of the Dispatch as versus Mode of delivery options (continued)   

Mode of Delivery

Inbox Mail Link
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A scheduled report is identified with an indicator which is a Clock  button. This button is displayed on the 
pane-specific toolbar. When you move your mouse over this button, the following details for the scheduled 
report are displayed:

• Using Schedule - shows the schedule that you selected. For example, Hourly.

• Generation Status - depicts if the scheduler was able to generate the report or not in the last run. The following 
information on the generation status of the scheduled report are displayed:

• Scheduled - a scheduled report is created and the selected scheduled process has not run.

• Success - the selected scheduled process has run successfully and generated the scheduled report.

• Failed - the selected scheduled process has failed to run or failed to generate the scheduled report.

• Last run date-time - shows the date and time when the scheduled report was last generated. For details on when 
the schedule report is generated, see the above section on Generation Status.

• Next run date-time - shows the date and time at when the report is next scheduled to be generated. For details on 
when the schedule report is generated, see the above section on Generation Status.

Note If Alerts, cell notes, conditional formatting and cell highlighting has been performed on the on-demand 
report, then, after changing to scheduled reports, only the Alerts and Conditional Formatting is displayed.

Changing A Scheduled Report To On-demand Report 

You can change an existing scheduled report to an on-demand report.

1 Open an existing workspace with one of the panes containing the scheduled report.

2 Right-click on the pane and select Pane Properties.

3 Select On-demand in the Report Type field.

4 Click OK. The on-demand report is displayed on the workspace grid.

The Clock  will not be displayed on the pane-specific toolbar of the on-demand report. 

Only owners or users with Edit and Delete Objects privilege can perform this change.

Note If there were Alerts displayed in the scheduled report, then after changing to an on-demand report, the 
Alerts will be displayed.

Defining Advanced Runtime Grid Operations

You can perform the following tasks using the Advanced option on the Pane Properties window:

❑ “Setting Page Filters”

❑ “Showing Lookup Values”

❑ “Showing Images On The Grid”
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❑ “Selecting A Date”

❑ “Working With Auto Execute Feature”

❑ “Specifying Cell Value Colors And Cell Highlights”

❑ “Viewing the Grid Based on Filters”

❑ “Improved Data Controls”

Setting Page Filters

You set the number of page filters you want displayed on a row in the workspace report. 

Enter a number in the Wrap Page filters.

Showing Lookup Values

The ChangeCAST Application provides a Display lookup values option that regulates the display of runtime drop-
down lists in the grid cells when the grid loads.

To display lookup values:

1 On a workspace grid, right-click on the pane header. The right-click menu appears. Select Pane Properties. The 
Pane Properties window opens. 

2 Select Yes to Display lookup values. 

3 Click OK. The Pane Properties window closes and you are returned to the workspace grid.

Selecting Lookup Values

After you enable the option to display lookup value, you will see drop-down lists in the cell area on the workspace 
grid.
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By default, the field shows the value returned from the data warehouse for that cell. When you click on the drop-
down list, all values set by the modeler would be visible. 

You can select from the existing set of values to perform a UEV or a scenario write-back. Select a value from the drop-
down list and the value is displayed in the cell. You cannot edit this value but can select an alternate value from the 
drop-down list. 

If you want to revert back to the default value retrieved from the data warehouse, select the cell or multiple cells if 
required and right-click. Select Reset from the right-click menu. The default value is displayed. 

Note that the reset operation does not function on refreshing the grid after selecting a value from the drop-down list.

Showing Images On The Grid

RPM Application provides you the flexibility to choose to display images representing the dimension members on 
the grid. The images can be displayed as links or thumbnails on the grid. 

This option to display images on the grid helps in gaining a better understanding of the report and also helps in 
creating a self-explanatory report.

For example, consider a Sales report of a fictitious company, Wheeling Cycles. A business analyst may want to see 
the different trends in the growth rate of sales for this report. The RPM Application provides the capability to display 
thumbnails or links to depict the trends in growth rate using the Display of Images on Grid feature. 

Let us assume that we set the trend display for the growth rate as follows:

❑ Green upward arrow  to display a growth rate more than 29%

❑ Red downward arrow  to display a growth rate less than 25%

❑ Yellow rectangle  to display a growth rate between 25% and 29%

The report shows the corresponding thumbnail images on the grid as shown below:
        

The display of images thus helps to gain a quick understanding of the trends even without looking at the exact data 
on the grid.

Perform the following tasks to display images on the grid:

1 Create columns in the datawarehouse table to map the required images 

2 Create measure member is Agile Analytics

3 Place the required images at the specified location

4 Enable the option to display the images on grid

See also, “Important Notes on Showing Images on Grid”.
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Creating Columns in the Datawarehouse Table

You have to create columns in the datawarehouse table to store the required mapping URLs. The Agile Analytics 
Server would be mapped to display images on the report using these columns created in the datawarehouse.

Create the required columns in the datawarehouse table. The columns should be of the datatype ‘varchar’. For 
more information on creating the columns, contact your system administrator.

After you create the required columns in the datawarehouse, you have to update and save the schema to successfully 
map them to Agile Analytics.

To update and save the schema, perform the following tasks:

1 Start Agile Analytics and open the AnalyticWorkspace.

2 Go to the Tools menu and select Schema Explorer option. The Schema Explorer window opens.

3 Go to the Edit menu and select Lock Schema option. 

4 Select the database where you created the column and right-click. The right-click menu opens. Select Update 
Schema option. 

The schema is updated.

5 Go to File menu and select Save Schema option to save all the changes you made.

Creating Measure Member and Setting the Properties in Agile Analytics

To display images on the grid, you have to create a measure member for the same in Agile Analytics and set the 
properties for the created measure. 

To create a measure member in Agile Analytics,

1 In the Analytic workspace, double-click on the model you want to work on. The Modelers’s workspace window 
opens showing all the dimensions available.

2 Double-click on the dimension you want to select. A new window opens showing all the members available.

3 Select a parent member for the new member you want to create and right-click. Select Insert Member option from 
the right-click menu.

Alternatively, go to Insert menu and select Member.

The following warning message is displayed:
“Are you sure you want to change the model?”
Click Yes to change the model and create a new member.
Click Make Copy to create a copy of the model and then create a new member.
Click No to exit without creating a new member.

4 The member appears with the default name, <MemberN>, selected. Analyticworkspace assigns the number N, 
starting with 1, to make the member name unique.
Type the required member name and press Enter.

5 To add more members, repeat steps 4 and 5.



Agile Analytics 2.1.1

A-86 PPM & PQM User’s Guide

To set properties for the new member created,

1 Right-click on the new member created and select Properties from the menu.
The Member Properties window opens.

2 In the General tab of the member properties window, 

a Accept the default name and alias name in the Name and Alias fields.

b Enter an external key name in the External Key field in the following format:
!<measure member name>_image_lookup
where <measure member name> should be the name of the new member created.

c Select the data type as String from the Data Type drop-down list.

3 In the Formulas tab of the member properties window, you can create new formulas for the images to be displayed. 

a Select <New Formula> from the Formulas drop-down list.

b Enter the required formula in the Expression field.

c Click Apply to save to the changes.

4 In the Measure Data Maps tab of the member properties window,

a Select <New Data Map> from the Name drop-down list.

b Select the database you want to map to from the Database drop-down list.

c Select the primary table for the measure data map from the Base Table drop-down list. 
The base table defines the dimensions that participate in the query for this measure data map.

d In the Column Expression tab, 

Select the table that has the values for the measure data map from the Measure Table drop-down list.

In the Measure Column list, select the column in the table that you want to retrieve the member’s value from.

5 Click Apply to save the properties and continue. Else, click OK to save the properties and exit from the Properties 
window.

6 In the Analyticworkspace window, go to File menu and select Save Model option to save all the changes you made to 
the model and exit.

Storing Images in the Required Location

The images that are to be displayed in the report have to be stored in the specific location and this location has to be 
mapped. 

If you want to see the thumbnail image and also an enlarged image, you have to create two images of the required 
sizes and save them in the required location.

Note * The thumbnail and the enlarged image should have the same name with the enlarged image name 
suffixed with ‘_big’. Both the images have to be saved in the same location. 

* The cell size in the grid is resized to fit the largest thumbnail image on the grid. Hence, it is recommended 
that the thumbnail image size is at max 34(w) * 7(h) pixels.

By default, you can place the images at the following location:

<Drive>\Alphabloxserver\repository\themes\financial\i

The image is stored in this location and the path is mapped for the report to display the images.

If you want to change this default location, you can change the following property in the system.properties 
file:

GRID_IMAGES_LOCATION = <Location>
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where <Location> is the location where you have stored the images.

Note Printing feature is not supported when you change the default location of the image storage.

Enabling Option to Display the Images

To display the images as links or thumbnails in the grid, you have to enable the Display Images option. To enable 
this option in RPM Application, perform the following tasks:

1 On the Workspace grid, select the dimension member in the grid for which you have created and mapped images 
for, and right-click. The right-click menu appears. 

Or

Right-click on an active pane tab. the right-click menu opens.

2 Select Pane Properties. The Pane Properties window opens.

       

By default, the Display cell images as checkbox is not selected.

3 Select the Display cell images as check box. The Links and Thumbnail options are enabled. 

4 Select the required option based on how you want the image to be displayed.

• Links - Select this option to display the image name as a hyperlink on the grid cells. 

A sample grid with hyperlinks displayed is shown below:
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• Thumbnail - Select this option to display the thumbnail of the image on the grid. 

A sample grid with the thumbnails displayed is shown below:
       

5 Click on the hyperlink or the thumbnail on the grid cells to view an enlarged image. 

The image display window opens showing the image of the hyperlink or the larger image of the thumbnail:
       

Click Close to exit from the window and return to the Workspace.
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Important Notes on Showing Images on Grid
❑ RPM Application supports ‘.jpeg’, ‘.bmp’, and ‘.gif’ image formats.

❑ Printing, Conditional Formatting, Improved Data Controls, Grid Filters and functions related to Change Rules 
are not supported for reports with images displayed on the grid.

❑ Alerts are not generated for reports with images displayed on the grid.

❑ The data represented by images on the grid are not displayed when they are viewed as a chart.

❑ Functionalities like Scheduled Reports, Auto Refresh, Cell Notes, Save As, and Saved Reports are supported.

❑ You can copy the thumbnails and the larger images depending on the your internet browser settings.

Selecting A Date

The ChangeCAST application dynamically shows a calendar based on the measure’s data type. For example, if the 
measure Promotion Date contains the type as Date, then the ChangeCAST application provides a drop-down list 
that shows a calendar on the cells of the Promotion Date measure.

You can select as required from the calendar. 

To select a date,

1 Make sure you enable the Display lookup value option in the Pane Properties window. To do this, follow steps 1 
to 3 in the section “Showing Lookup Values.” 

2 The workspace grid shows a drop-down list for all the cells of the measure Promotion Date on the workspace 
Grid. Click the drop-down list. The standard ChangeCAST calendar is displayed. 

3 By default the current date and month is displayed. Select a month and date as required from the calendar See 
“Using the Calendar”.

The date that you selected appears on the cell.

Using the Calendar
❑ To select a future Year, click the  button. The Year displayed on the header of the calendar, gets incremented 

consecutively with every click of the button.

❑ To select a previous year, click the  button. The Year displayed on the header of the calendar, gets 
decremented consecutively with every click of the button.

❑ To select a future month, click the  button. The Month displayed on the header of the calendar, gets 
incremented consecutively with every click of the button.

❑ To select a previous month, click the  button. The Month displayed on the header of the calendar, gets 
decremented consecutively with every click of the button.

❑ To toggle the first day of the week, click the  button. 

❑ To select the current date and month, click 

❑ To reposition the calendar on the grid, use the drag and move feature by positioning your mouse pointer on the 
header or footer of the calendar.

❑ To close the calendar, click  button.

Working With Auto Execute Feature

Cells in a workspace or a report can have the following values or no value:

❑ Fact data

❑ User Entered Value

❑ Calculated value
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Fact data are the values directly fetched from the fact table. These values are uploaded to the datawarehouse during 
the loading of the fact and dimensional data.

A User Entered Value (UEV) is a value that a user enters in a workspace to perform what-if analysis and task planning. 
These values are initially written to a shadow table and then after a decision process, the values are written back to 
the fact table. 

A calculated value is a value that is calculated or derived from a set of other values. These calculated or derived values 
are neither written back to the shadow table, nor the fact table.

The ChangeCAST Application provides the Auto Execute feature through which you can select the cells that have 
derived values and set the Auto Execute Rules on them. The calculated or derived values are automatically 
committed to the fact table during the decision process.

For example, let us consider a report that has the measures Sales Amount and Units Sold in the Wheeling 
Cycles model. The Average Price per Unit is calculated from these two measures using the following 
formula:

Average Price per Unit = Sales Amount / Units Sold

Consider the following example table illustrates the above description with numerical values:
      

From the above table, consider the first row of values where Average Price per Unit is calculated as per the 
formula:

Average Price per Unit = Sales Amount / Units Sold

1000 = 10000 / 10

Supposedly, if you change the values of Sales Amount to 12500 and Units Sold to 25, then the corresponding 
value of Average Price per Unit also changes and the values are displayed in the table as below:

      

The UEVs on Sales Amount and Units Sold are written back to the fact table. However, the value of 
Average Price per Unit is not written back to the fact table as it is a calculated value.

Setting the Auto Execute Rule on the Average Price per Unit, will writeback its calculated value directly to 
the fact table.

You can perform the following tasks using the Auto Execute feature:

❑ Set the Auto Execute Rule. See “Setting Auto Execute Rules.”

❑ Execute the Auto Execute Rule. See “Executing Auto Execute Rules.”

Table A-9: Example to illustrate a Auto Execute feature    

Sales Amount Units Sold Average Price per Unit

Shop Mart

January 10000 10 1000

February 15000 100 150

March 80000 80 1000

Table A-10: Example to illustrate Auto Execute feature    

Sales Amount Units Sold Average Price per Unit

Shop Mart

January 12500 25 500

February 15000 100 150

March 80000 80 1000
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❑ Limiting the writeback action done through Auto Apply Rules. See “Limiting the Writeback Action.”

❑ Delete all the Auto Execute Rules. See “Deleting the Auto Execute Rules.”

Setting Auto Execute Rules

You can select a cell or multiple cells on the report and set the Auto Execute Rules so that, any derived values are also 
treated as UEVs and are written back to the fact table. To set the Auto Execute Rules:

1 Open a Workspace and select a cell or multiple cells on which you want to set the Auto Execute Rule.

2 Right-click on the selected cells and select Actions > Set Auto Execute Rules.

The Auto Execute Rule is set on all the selected cells.

Important Points on Auto Execute Rule
❑ You can execute Auto Execute Rules on a report only if the report contains a scenario dimension.

❑ There is no visual indication about the association of Auto Execute Rules to a cell or a member.

❑ Save as operation will inherit the Auto Execute Rules.

❑ The applied Auto Execute Rule is specific to that particular report. When you import a workspace or duplicate 
the cells with the Auto Execute Rules, these rules are not applied to the new workspace.

❑ If you delete a member from the report on which the Auto Execute Rules are set, then all those rules become 
ineffective thereafter.

❑ Auto Execute Rule cannot be applied on the Calculated Members created during runtime.

Executing Auto Execute Rules

Executing the Auto Execute Rules enables you to commit all the derived values for which the Auto Execute Rules are 
applied and submit it for approval and implementation. To execute the Auto Execute Rules:

1 Open the Workspace or the report on which you want to execute the Auto Execute Rules.

2 Click the  Execute button. The Create New Decision dialog box opens.
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3 Enter a title for the decision that you want to create in the Decision title field. 

4 Enter the description in the Description field.

5 The Models drop-down list shows the model to which the workspace is associated to. If the workspace has two or 
more panes, then a list of all the models associated with the workspace is displayed.
Select the required model from the Models field.

6 The Versions drop-down list shows all the versions of the Scenario member associated with the workspace pane.
Select the version of scenario you want to execute from the Versions drop-down list.

7 The Approvers field shows all the users or groups to whom you would send the specific scenario version for 
approval and implementation.
To add users or groups to the Approvers list:

• Click  Add Recipients button. The Add Recipients window opens:
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• To add recipients from the Groups' list, select one or more groups from the respective list.
Alternatively, enter the group name in the field where the text cursor is visible. That particular group name 
gets highlighted in the list. 

• Click Add. The selected groups get added to the recipients list on the right.

• To remove a recipient from the recipients list, select one or more recipients and click Remove. The selected 
recipients are removed from the list.

• To cancel your changes and to exit from the Add Recipients window, click Cancel.

• To save your changes, click OK. The Add Recipients dialog box closes and you are returned to the Create New 
Decision dialog box.

8 The Decision folder field allows you to select the folder where you want to save the decision. 
To save the decision in a specific folder, click  Select Folder button. The Select Folder dialog box opens 
showing a list of all the folders created in the application. You can drill down on the main folders to view the sub 
folders. Select a folder from the list and click OK. 

9 Click Send to send the decision for approval and commit all the UEVs and also the derived values to the fact table.
To return to the workspace without executing the Auto Execute Rules, click Cancel.

Alternatively, you can execute the Auto Execute Rules on a selected pane in the following way:

1 Open a workspace and select a cell or multiple cells on which you want to set the Auto Execute Rule.

2 Right-click on the selected cells and select Scenarios > Execute. The Create New Decision dialog box opens.

3 Follow the steps 3 to 8 from the previous description to proceed.

Note In step 5, the Models drop-down list will display the model associated with the selected pane only and will 
be a non-editable field.
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Limiting the Writeback Action

RPM application provides you the flexibility to partially limit the writeback action done through the Auto Execute 
Rules. The scope of limiting includes avoiding the writeback of null values, non-editable values, and zero values to 
the fact table. To specify these properties right-click on an active page tab. The right-click menu opens. Select Pane 
Properties>Advanced tab. The Pane Properties dialog box opens:

      

In the Auto Apply Options section,

1 The Skip null values field enables you to avoid the writeback of cells with no values or cells that are blank. 
Select Yes to refrain from writing back the cells with no values, else select No.
Yes is system default selection.

2 The Skip non-editable values field enables you to avoid the writeback of cells that have non-editable values.
Select Yes to refrain from writing back the cells with non-editable values, else select No.
No is system default selection.

3 The Skip zero values field enables you to avoid the writeback of cells that have values equal to zero.
Select Yes to refrain from writing back the cells with zero values, else select No.
Yes is system default selection.

Deleting the Auto Execute Rules

You can delete all the Auto Execute Rules that are set on the report. (You cannot delete the rules partially.)

To delete the Auto Execute Rules:

1 Open a workspace and select a cell or multiple cells.

2 Right-click on the selected cells and select Actions > Remove All Auto Execute Rules.
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Specifying Cell Value Colors And Cell Highlights 

The ChangeCAST application provides the ability to specify cell value colors, highlight cells with background and 
foreground color in the workspace grid. This feature therefore allows you to customize the presentation of the grid 
according to your preferences. You can customize:

❑ Cell Value Colors

❑ Cell Highlight

Specifying Cell Value Colors

You can specify the color of the value in the grid cell to denote the state of the grid cell value. The ChangeCAST 
application supports color coding for the following grid cell states:

❑ Unchangeable - non-editable cells

❑ Changeable - editable cells

❑ Changed - post UEV/changed rule execution

You can specify cell value colors using the Text Color Settings feature in the Workspace Pane Properties screen 
of the report.

Note  Make sure you specify different colors for each of these values. The application shows the following error 
message if a common color has been defined across the three text color states in the report:
The selected text color has already been used. Select a different color.
Click OK to proceed.

To specify cell value colors,

1 Select a pane and right-click on the pane. The right-click menu opens showing the Pane properties options. Select 
Pane Properties. The Pane Properties window opens.

The Text Color Settings section in the Pane Properties window shows the following fields:

• Unchangeable - This cell state indicates that the user cannot modify the cell value.

• Changeable - This cell state indicates that the user can modify the cell value.

• Changed - This cell state indicates that the cell value has changed because of Change Rule execution/UEV.

Each of these fields contains an Edit Color  button which on clicking opens a ChangeCAST standard color 
palette.
      

2 The application shows the settings of the cell states in a set of default colors. To change the color, click the  
Edit Color button corresponding to the cell state that you need to specify the color for.

The default color for the cell states is black. You can change these colors as required.
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3 Now select the color in the palette to which you want to associate the cell state to. Click OK after you finish 
specifying colors. The application returns you to the workspace grid, which now shows the text in the new 
selected colors. 

If you change the text colors for a workspace that contains reports on which UEVs or Change Rules have been 
executed or on which no changes have been done, the new colors are applied according to the cell states.

Font colors show the changed color regardless of whether they are changed by the user or by a formula. If a value 
in a cell is changed by a calculation resulting from a user defined change in a dependant value, affected cells will 
reflect the changed font color. For example, if you change one value which in turn changes other values, you 
would be able to view the changed values through the font color change and this applies only to Change Rule 
execution. 

Highlighting Cells

The ChangeCAST application provides you the ability to highlight individual cells, entire rows or columns. This 
feature would help you to depict logical relationships among cell values or organize the grid according to your 
preferences. 

Viewing the Grid Based on Filters 

You can toggle and view the grid values on a scheduled report based on the filters set to the page. RPM application 
provides the ability to view all the defined filters as a drop-down list on the scheduled report. 

To define this iterative list right-click on the scheduled report pane in the workspace and select Pane Properties from 
the drop-down list. The Pane Properties window opens.

Select the Advanced tab. The Advanced tab of the Pane Properties windows opens:

In the Select Dimensions to Iterate section,

1 The Maximum dimensions allowed field shows the maximum number of dimensions that can be included for iteration 
in the scheduled report 
The system default value is 1. This field is non-editable.

2 The Maximum members allowed per dimension field shows the maximum number of members that can be listed for 
each selected dimension.
The system default value is 10. This field is non-editable.
The number of dimensions displayed as drop-down lists in the resulting scheduled report would be limited to 
the number specified in the Maximum dimensions allowed field, even if more number of dimensions are chosen for 
iteration.

You can change or set the Maximum dimensions allowed and Maximum members allowed per dimensions by setting the 
following properties in the system.properties file.
* maxDimensionAllowed
* maxMembersPerDimensionAllowed

3 The Available Dimensions list shows all the dimensions that are associated with the selected model. 
Select the dimensions that you have set as a filter in the workspace.
Dimensions that are not set as filters would also appear in a drop-down list. But, would not bear any impact on 
the workspace.

If you select more dimensions than the Maximum dimensions allowed, the following message is displayed:
“Number of dimensions cannot be greater than the allowed number of 
dimension”
Click OK to continue.
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4 Click the  Add button to add the selected dimensions to the Selected Dimensions. Use the  Remove button to 
remove the selected dimensions.

5 Click OK to save your selections and return to the workspace, else, click Cancel to exit without saving your 
selections.

A sample workspace with the drop-down list available for iteration using the filter dimensions is shown:
       

Improved Data Controls

The ChangeCAST Application provides improved data controls, in addition to editable and non-editable fieldes, to 
regulate the display of data in the cells on the Workspace grid. The application provides an option called Display 
lookup values which when enabled shows the following controls on the Workspace grid cells:

❑ drop-down list of possible values

❑ Calendar control 

These dynamic data controls would apply only if the workspaces have reports that are editable.

The option to dynamically display data options is based on the Measure’s data type which could either be string or 
date. Only these data types are supported. For other data types such as Integer/Float you must convert them to a 
string for the value to be displayed in the drop-down list.

Lookup Measures

For this feature to work, you need to create a surrogate / alternate measure by name Measure_lookup, where 
Measure is the one visible on the grid (for which the user would like to see a drop-down list or a calendar widget) 
and _lookup is a standard suffix.

For example, Status (a measure) can have values say 'Success' and 'Failure'. When Status as a measure is viewed in 
the grid (either in the row /column), the user should be able to see a drop-down list containing 'Success' and 'Failure' 
in the cell. 

For the grid to display the values in the list, you must perform the following tasks in Agile Analytics: 

❑ For string values (and other data types other than date)

• Create a measure by name 'Status_lookup'.

Note The measure name devoid of the suffix '_lookup', should be the same as the measure for which the user 
wants to see multiple values.

• In the formulae tab in the Expression section enter within single quotes 'Success, Failure'. 
The delimiter comma separates 2 values and it is a must to provide the delimiter.

• To have complex values coming from datawarehouse, you can use complex functions such as 
'CONCATENATE' or you can take the help of an expert modeler.
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• Also the datatype for this measure (alternate/surrogate) should be String. 

• For other data types such as Integer / float, you must change it to string to get displayed in the front end. For 
example, if we need to display 1, 2, 3 in the front end, in the expression area enter '1,2,3' (within quotes) and 
the datatype of the measure (surrogate /alternate measure) should be of type string. 

❑ For date values (calendar control) 

• If the user wants to display a calendar control, follow the same steps as above. The only change being in the 
expressions section, from the functions drop-down list pick the function 'TODAY' and press ADD Function.

• Also the datatype for this measure (alternate /surrogate) should be of type Date.

Note In case of New member creation, you can use the same steps as above, except that the surrogate/alternate 
measure name will have <DimensionName>_<ColumnName>_LOOKUP. That is under the 
dimension in which member is getting created and each of the columns can multiple values.

Creating Calculated Members

This feature is available in the RPM Application only when the DisplayAlphabloxCalculatedMember 
property is set to true in the system.properties file.

The ChangeCAST Application provides you with the ability to dynamically create calculated members to a report in 
a grid during a runtime session. A calculated member is a dimension member whose value is calculated at runtime 
using a calculation rule that you specify when you define the calculated member.

A calculated member can be created in a model dimension with a calculation rule for computing cells that intersect 
with the calculated member. They are created dynamically and are not stored in the database or the model file. They 
are saved as metadata in the report repository when the report is saved.

The ability to create and use calculated members during runtime provides greater manipulation capability for multi-
dimensional data. Although calculated members must be based on data (such as members) that already exists in the 
model, you can create complex expressions by combining this data with arithmetic operators, numbers, and a variety 
of functions.

Calculated members allow useful analysis of the model data and are extremely useful for the definition of new 
members. For example, a retail category manager wants to determine what the operating profits of his retail 
merchandise. He uses a Retail model that contains the dimensions Customer, Product, Region, and Time and the 
measures Gross Margin, and Total Expenses; however the model does not contain a measure to ascertain the 
operating profits of the merchandise. You can create a calculated member as a measure named Operating Profits. 
where the value of Operating Profits=Gross Margin-Total Expenses. 

Working with Calculated Members

You can work with calculated members using the Calculated Member feature which is available as a right-click menu 
option on a workspace grid. The Calculated Member feature let us you perform calculations using the members and 
values currently displayed in the grid. 

The following table shows a calculation that adds a measure called Operating Profits to Measures dimension:
        

For each calculated member, you need to specify:

Table A-11: Example to Illustrate a Calculated Member    

Gross Margin Total Expenses Operating Profits

Shop Mart

January 10000 100 9900

February 5340 15 5325

March 8645 28 8617
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❑ the name for the calculated member

This will be the name of the member to appear in the grid. In the example above, the name of the calculation is 
"Operating Profits." 

❑ the dimension

The dimension where this calculated member should be added to. In the example above, the dimension is 
"Measures."

❑ an expression

The expression used to calculate the values for the newly added member. In the example above, the expression 
is: "Gross Margin" - "Total Expenses" 

Optionally, you can specify:

❑ the position

You can specify the member before which the calculated member should appear. In the example above, it is 
positioned to display after "Total Expenses." 

❑ the generation level of the calculated member

❑ the scope

You can limit the calculation to only certain members in a specified dimension.

Important points to note while working with calculated members

❑ Calculated members are only available on grids that do not contain the Scenario dimension.

❑ Sort or ranking operations cannot be performed on calculated members.

❑ Calculated members when moved to the Page axis are not visible on the Page axis.

❑ Calculated members are also available on the Chart view.

❑ Calculated members are available in Export to Excel or PDF.

Selecting Cells Across A Pane

The ChangeCAST application provides you the ability to select a range of cells across a paginated grid, while still 
retaining the previous cell selections. A paginated grid is formed to accommodate the cells in a grid that cannot be 
displayed in the visible area of the grid due to space constraints. A horizontal and vertical scroll is provided to fetch 
the rest of the cells containing the data.

To facilitate the optimal usage of the grid when values need to be entered in a large number of cells, the application 
provides you with options through which you can select a range of cells across a paginated grid without losing the 
previous cell selections after scrolling in the grid. This feature is extremely useful while entering a large number of 
values in a grid using the copy and paste or calculator features.

You can select cells in a grid in the following ways:

❑ Select a row of cells. 

❑ Select a column of cells.

❑ Select a range of cells. 

Using Change Rules

The ChangeCAST application provides you with the ability to execute Change Rules on the cells of a report during 
a runtime session. A Change Rule is used to modify the value of a non-leaf level cell thereby propagating the changed 
values to the dependent cells using the business logic embedded in the Change Routine. It also provides the flexibility 
of modifying a cell value by locking members such that the locked members do not participate in the calculation.
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Typically, a Change Rule encapsulates a Change Routine and the rule domain—the rule domain qualifies specific 
cells from the model to which the Change Rule can be applied. A Change Rule can have only one Change Routine 
associated with it.

A Change Routine is a function that is used to calculate values for dependent cells—the cells that are dependent on 
the cell value you want to modify. The values for the participating, dependent cells are calculated and propagated 
based on the business logic embedded in the Change Routine. The defined Change Routine is executed by the user 
at runtime and the cell values are propagated to the dependent cells using the scenario write-back feature.

Why Change Rules

Change Rules provide the capability of propagating the modified cell value to the dependent cells using Change 
Routines. With Change Rules, a Change Routine (Python script) can be defined that:

❑ contains the business logic to calculate the value for the dependent members based on the new value, and 

❑ performs scenario write-back on the dependent cells.

For example, let’s consider the COGS(Cost Of Goods Sold) measure member of the Wheeling Cycles model.

The value of the measure member, COGS, is calculated using the following formula:

COGS = “Units Sold” * “Stand COGS Per Unit”

Let’s assume that the current value of COGS is 1000, and the formula with the members replaced with values is as 
follows:

1000 = 100 * 10

Supposedly, if the business goal requires COGS to increase by 50%, then the value of COGS must read 1500 instead 
of 1000. To address this business need, you have to increase the value of either Units Sold or Stand COGS 
Per Unit. Typically, a user would manually change the value of either Units Sold or Stand COGS Per 
Unit (using write-back) to the desired value and arrive at the new value for COGS. With Change Rules, you can 
define a business rule using a Python script that would contain the business logic to calculate the value of Units 
Sold or Stand COGS Per Unit, and then propagate these values by performing a scenario write-back on 
Units Sold or Stand COGS Per Unit. 

After performing scenario write-back on the dependent, leaf-level members, the values are committed to the shadow 
table. The desired value for the cells is updated after executing the Change Rule.

In the example, if the business goal requires COGS to be 1500, then the script can calculate the value of Units Sold 
as follows:

Units Sold = COGS/Stand COGS Per Unit

Units Sold = 1500/10 = 150

The ChangeCAST Application performs a scenario write-back on Units Sold to write back 150 and derive the 
desired value 1500 for COGS.

Thus, Change Rules encapsulate business rules in the Change Routine formula to perform efficient business analysis. 
Further, the changed values written back to the shadow table as a result of Change Rule execution can be eventually 
written back to a fact table post the decision using decision workflows. 
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Working with Change Rules

Working with Change Rules involves associating a Change Rules to a report and then executing the Change Rules to 
arrive at the desired value for the cells. To execute a Change Rule on a cells in a report, you must perform the 
following steps:

1 Associate the Change Rule you want to execute on the report. See “Associating a Change Rule to a Report.”

2 Execute the Change Rule. See “Executing a Change Rule.”

You can also execute a Change Rule by locking members such that the locked members do not participate in Change 
Rule execution. See “Locking and Unlocking Dimension Members.”

The examples and illustrations used in Associating a Change Rule to a Report and Executing a Change Rule sections are based 
on the business scenario described below. This scenario is based on the Wheeling Cycles model.

Let’s consider a business scenario in which you want to increase the Gross Margin of a product Cougar for 
Apr-05 by 50%. The formula for Gross Margin is as follows:

Gross Margin = Sales - COGS

The measure member COGS in turn has the following formula:

COGS = “Units Sold” * “Stand COGS Per Unit”

Thus, if you want to increase the Gross Margin value, you can increase either Sales or decrease the value of 
COGS. Let’s assume we have a Change Rule “IncGrossMarginByCOGS” defined by the administrator/
modeler that increases the value of Gross Margin by decreasing COGS. In addition, the rule domain for this 
Change Rule qualifies only Apr-05, May-05, and Jun-05 members of the Time dimension for Change Rule 
execution. Further, as COGS is a calculated value it’s required to drill-down on COGS and calculate the value of either 
Units Sold or Stand COGS Per Unit. For the given scenario, let’s choose to decrease the value of 
Stand COGS Per Unit and retain the value of Units Sold. 

The sections that follow describe the steps involved in executing this Change Rule to address the business need of 
increasing Gross Margin by 50% for Apr-05.

Note You can execute Change Rules on a report only if the report contains a scenario dimension.

Associating a Change Rule to a Report

To associate a Change Rule to a cell in a report:

1 Open a workspace and open the grid which contains the cell you want to modify. The grid shown below shows 
Gross Margin values together with the dependent measure members, Sales, COGS, Units Sold, 
Stand COGS Per Unit, for the region California, product Cougar, and Customer Toys 
Express in Q2-2005.
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2 Right-click any cell or row/column header except the dimension header. For example, right-click the cell that 
shows Gross Margin for Apr-05. The right-click menu opens showing the menu options. If you select 
a dimension header or if you select both cells and row/column headers to associate a Change Rule, the system 
shows an error, “Select either members or data cells to associate Change Rule”.

3 Select Actions>Associate Rules from the menu. The Associate Change Rule to Cell window is displayed as shown:

      

4 Select the Change Rule you want to associate with the cell from the Available Change Rule list. The Available Change 
Rule list contains all the Change Rules applicable to the selected cell or members as set during the design time.

5 Click  to add the selected Change Rule to the Selected Change Rule list. Use  to remove the selected Change 
Rule. 

Note You can associate single or multiple Change Rules to cells or members. 

6 Additionally, you can click the Default rule drop-down list below the selection lists. This allows you to select a 
default change rule for the selected cell. The values available in the drop-down list are populated based on the 
selections made in the Selected Change Rule drop-down list. The default value of this drop-down list is set to None.

7 Click Cancel to close the dialog box and return to the report without associating the Change Rule.

8 Click OK to associate the Change Rule to the selected cell and to return to the report.

Note The applied Change Rule is specific to the cell or member for that particular report. The duplication of this 
cell or member in a different report does not imply the association of Change Rule for this cell or member 
in the other report.

If you want to associate a different Change Rule for the selected cell, right-click on the cell, select Actions>Associate Rules 
from the right-click menu. The Associate Change Rule to Cell dialog box loads the Change Rules associated with the cell 
in the Selected Change Rule list.

To associate a Change Rule to a cell in a report, you must have Associate Change Rule special permission. Further, you 
must be the owner of the report or the report must be published to you. 
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Executing a Change Rule

To execute a Change Rule in a workspace:

1 Open a workspace and open the grid which contains the cells you want to modify. Color coding of the cells is 
configurable at the workspace panel level in the Workspace Pane Properties page. 

       

2 Click a cell or row/column header to select the cells you want to modify. For example, click the cell that shows 
Gross Margin for Apr-05. If you select both cells and row/column headers to execute a Change Rule, 
the system shows an error, “Select either members or data cells to execute Change 
Rule”.

3 Enter the new value in the cells. For example, enter 1,500 instead of 1,000 for Gross Margin in Apr-05.

4 Click on the  part of the  button in the workspace tool bar to execute the default Change Rule 
associated with the cell. Optionally, you can also click on the drop-down list part of the  button in the 
workspace tool bar to list the associated change rules as shown below:

      

You can select one of the associated change rule and click to execute it instead of the default change rule. The grid 
refreshes post the change rule execution and shows the report with the cells that have changed as a result of the 
change rule execution. For information on how to associate Change Rules, see “Associating a Change Rule to a 
Report.”

Note If you select a dimension header to execute a Change Rule, the system shows an error, “This 
operation is supported only for cells or members selection” at the top of the 
Execute Change Rule page. 

If no default rule exists, then no action will be performed when the button is clicked. Instead, an alert 
'Select Default Change rule from cells' is displayed.
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As you can see, the grid shown above shows the changed values of Gross Margin, COGS, and Stand COGS 
Per Unit for Apr-05. Only the changed cells at the leaf-level are displayed in a different color. For example, 
Stand COGS Per Unit in the given grid. 

Note If you select multiple cells or members and then click the Execute Change Rule button, the dialog box shows 
the intersection of the rules applicable to the selected cells or members.

If you enter a value in a cells and before executing the associated Change Rule, if you select the row/column header 
for the same cells and then execute the Change Rule, all the cells of the selected row/column will be considered for 
Change Rule execution including the cells for which you entered the values earlier.

If errors occur while executing a Change Rule, then these errors will be displayed at the top of the Workspace page.

Note To execute a Change Rule on a cell or member in a report, you must have Execute Change Rule and lock member 
special permission. Further, you must be the owner of the report or the report must be published to you. 

Locking and Unlocking Dimension Members 

You can execute Change Rules by locking members such that the locked dimension members do not participate in 
the Change Rule execution. If a member is locked, a Change Routine cannot update the values for the cells where 
the locked member is participating. However, the validation of the locked cells or members is not within the scope 
of Agile Analytics. The Change Routine handles this validation using some of the Python script functions.

Consider the business scenario given in “Working with Change Rules” section. With Change Rules, you have the 
flexibility of making a runtime decision by locking either Sales or COGS and calculating the value of the unlocked 
cell. The advantage of locking members is that you can use conditional logic in the Change Routine that enables you 
to make decisions at runtime. The Change Routine must calculate values for the unlocked cells only.

Let’s assume we have a Change Rule that calculates the value of COGS if Sales is locked and vice versa. If Sales 
is locked, you can increase Gross Margin by decreasing COGS. The steps given below describe how to execute 
the Change Rule by locking Sales.

To lock a member see:

1 Open a workspace and open the grid which has the member you want to lock.

2 Right-click on a row/column header. For example, right-click on the measure member Sales in the grid. The 
right-click menu opens showing the menu options. You can select multiple row/column headers for locking. 
If you select a cell or a dimension header for locking, the system shows an error, “Select members to 
lock”. 
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3 Select Actions>Lock in the right-click menu. The selected row/column headers will display a red background 
color to indicate that the member has been locked as shown below.

       

The member Sales gets locked and the Change Routine will not be able to update the values for the cells where 
Sales is participating.

4 Click a cell or row/column header to select the cells you want to modify. For example, click the cell that shows 
Gross Margin for Apr-05. For information on how to execute a Change Rule, refer to “Executing a 
Change Rule.” The grid after executing the Change Rule is displayed as shown:

        

During Change Rule execution, if all the cells are locked, the Python script allows you to return an appropriate 
runtime error message such as “All the cells are locked cannot proceed!!!”. 
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The locked cells remain locked only till the Change Routine execution. However, if you want to save the locked 
state with the report definition, click Save State. This facilitates increased productivity and ease of use as it’s not 
required to lock members every time you open the report and execute a Change Rule. The grid loads with the locked 
row/column header displayed in red background. 

Note Locking is report specific. To lock a member in a report, you must have Execute Change Rule and lock member 
special permission. Further, you must be the owner of the report or the report must be published to you.

To unlock a member:

1 Open a workspace and open the grid which has the members you want to unlock.

2 Select single or multiple locked members (row/column headers) in the grid.

3 Right-click and select Actions>Unlock in the right-click menu. The unlocked members are displayed with the default 
color. Click Save State to save the unlocked state with the report definition. If you try unlocking a member which 
is not locked, the system shows an error, “Select locked member to unlock”.

Note If you try executing a Change Rule on a cell that has a UEV (User Entered Value), an error “Cannot 
execute a ChangeRule on a cell with value type ‘UEV Rule’” is displayed. 

Creating A Dynamic Member

The RPM application enables you to dynamically create dimension members in the Agile Analytics model and use 
it for further business analysis without the requirement to restart the application.

Let us understand the usage of Dynamic Member Addition in a sales forecasting scenario.

The need for Forecasting and Predictive Analysis

With increased competition, businesses are forced to look well ahead in order to plan their investments, launch new 
products, and decide when to close or withdraw products and so on. Sales forecasting gives manufacturers, suppliers, 
and retailers the ability to compete more effectively in the marketplace by understanding the factors that influence 
consumer behavior and by adapting their manufacturing, distribution, supply chain and marketing and advertising 
plans accordingly. 

Example

Wheeling Cycles, a fictitious company, manufactures and sells bicycles and cycling accessories. This company 
intends to prepare a sales forecast of its revenue on the basis of past sales. 

How does Wheeling Cycles forecast annual retail sales revenue for its business using the RPM application?

The time horizon that the sales forecast that Wheeling Cycles intends to cover is 2006 to 2008. The years 2006, 2007, 
and 2008 do not exist in the Wheeling Cycles model. Using the RPM application, the user can create the members 
2006, 2007, and 2008 dynamically and add them to the datawarehouse dimension table. The user can then analyze 
data from past sales and arrive at an estimate of future sales for 2006-2008 by using forecasting techniques. 

Dimensions are organized as a hierarchy in the model and when you add new members to this tree you must specify 
its position inside the hierarchy. Hence, the members 2006, 2007, and 2008 should be placed in the Time dimension 
under the AllTime level. The user can then prepare a sales forecast using relevant dimension members and measure 
members. 

Working with Adding Members to the Database Using the RPM Application

The RPM application provides you to capability to add and edit only dimension members. The application does not 
support the creation of measure dimension’s members.
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The RPM application supports creating members of type dual key and standard key hierarchies. Standard hierarchies 
are those whose dimensions contain key columns in the datawarehouse that Agile Analytics can use to generate each 
level group. Dual hierarchies contain transient members that are generated after adding group key values in the 
source datawarehouse.

For more information on Standard and Dual key hierarchies, refer the Building Models with Analytic Workspace 
guide in the Agile Analytics documentation set.

Adding a Dynamic member to the database includes the following workflows:

❑ Designing a template - This is an administrator’s task. It involves designing a template that the end user can use 
to add a member to the database during runtime. The administrator designs a template using the Application 
Pane Management module in the RPM application. For details, refer the section Designing a Template in the 
Administration Guide.

❑ Creating dimension members - This is a business user’s task. The business user uses the template created by the 
administrator to create new members in a dimension hierarchy and use these members for business analysis. 

For details on defining an application pane, see the Application Management section in the Real-time Performance 
Management Administration and Configuration Guide.

To create a new dimension member,

1 From the left navigation area, click workspaces. The Workspaces summary page opens. 

2 Click Create. The Properties page opens. See the Properties section for information on defining the properties for 
a workspaces. 

3 Import the application pane that you require. To import, see “Toggle Report Information”.
You can import the following application panes:

• Member creation pane

• Text pane

After you import the application pane that you require, the workspace grid shows the application pane template 
that you imported.

Working with a Member Creation Pane 

If you import a member creation pane template that has been designed using dimensions from a standard key 
hierarchy, then the workspace grid appears as below:
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If you import a member creation pane template that has been designed using dimensions from a dual key 
hierarchy, then the workspace grid appears as below:
      



Appendix A Workspaces

A-109

If you import a member creation pane template that has been designed using dimensions from a Dual key 
hierarchy wherein Level function has been used while selecting parent members, then the workspace grid appears 
as below:
      

You can use the member creation pane template to create a new member. 

To create a member,

1 The Parent title defined by the administrator in design time now appears on the runtime as the field title from 
where you can select a parent member.

This drop-down list is displayed only when the administrator selects parent members using the Level functions 
(dual key hierarchy) in design time. This drop-down list contains a list of parent members. Select a parent 
member under which you want a create a member. 

2 The Member title defined by the administrator in design time now appears in runtime as the field title from 
where you can create or select a member to edit. For example, in the sample application pane provided above, 
the field title is Member. 

This drop-down list shows a list of members from which you can select a member to edit.

3 The Copy member caption defined by the administrator in design time now appears in runtime as the field title 
of the drop-down list from where you can select the member the attributes of which you can copy to the new 
member you are creating. This feature is available on runtime only if the Allow member copy option has been 
selected as 'Yes' in design time. 

4 You can edit existing members by selecting a member from the Member drop-down list and clicking on Edit. The 
edit option is available only if the Allow edit option has been selected as Yes on design time.
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5 The Input data section shows the attributes for which you need to provide values. The Input Data section shows 
all the datawarehouse columns (with modified column caption names if done in design time) which have been 
selected for display (if the Display option was selected) by the administrator in the design time. Enter values as 
required. 

6 If the administrator has enabled the Lookup values option in design time, then a drop-down list will be displayed 
against that column in runtime. This drop-down list contains lookup values from which you can select values. 
For column of Date data type, the standard RPM calendar button which launches the calendar control is 
displayed. For details on creating look up measures, see “Lookup Measures”

7 The Select descendents drop-down list is displayed only for templates that are based on dual key hierarchies. 
You can reuse the existing dimension hierarchy select descendents members for the member that you are creating 
by using Select descendants option. The caption of this option is the one that is provided by the administrator 
during design time. To select descendent members, click Select.
The Descendents Details list opens. 

       

The Available Members list shows the hierarchy of the members at the selected level. 

To select the descendent members,

• Drill down in the hierarchy tree to select the descendents for the new member that you are creating. You can 
select multiple descendent members from the node member. Note that you can only add one descendent 
member from its parent member.

• Select a member and use the Add button to move your selections to the Selected Members list.

• Alternatively, you can drag and drop your selections to the Selected Members list.

• Click OK to accept your selections or click Cancel.

8 Click OK. The member is created and this member is added to the member drop-down list.

9 To edit an existing member, select the member that you want to edit from the Member drop-down list. Make the 
necessary changes and click Apply.

Working with a Text Pane
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Import a text pane template to a workspace pane. To import, see “Toggle Report Information”. 

The content of the text pane displayed on the workspace pane depends on what the administrator saves while 
creating the text pane:

❑ When you import a text pane with only textual information, the report is displayed as shown:

       

❑ When you import a text pane with the URL to the website, the report is displayed as shown:
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When you click on the URL, the corresponding web page opens. Click the  Text button to return to the URL 
view of the report. 

❑ When you import a text pane that has a link set as Active URL, the report is displayed as shown:
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Click the  Text button to go to the URL view of the report. The window opens as shown:
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The display text for each URL that the administrator has defined while creating the text pane appears as links in 
the window. 

If you have more than one URL defined, all the descriptions appear as links. When you click on the URL, the 
corresponding web page opens.

Custom Measures

The RPM Application provides you the ability to dynamically add custom measures to a runtime report. A custom 
measure is a dimension member whose value is calculated at runtime using a calculation rule that you specify when 
you define the custom measure.

The ability to add custom measures during runtime provides greater analytical capability for multi-dimensional 
data. 

For example, a retail category manager wants to determine the total operating profits of his retail merchandise. He 
uses a Retail model that contains the dimensions, Customer, Product, Region, and Time and the measure Operating 
Profits. However, the model does not contain a measure to ascertain the total operating profits of the merchandise. 
You can create a custom measure named Total Operating Profits, that would display the sum of the Operating 
Profits of all the Products.

Adding Custom Measures

Custom measures can be created at the following levels on a report:

❑ Axis level - A custom measure is created for evaluating members in a selected axis. The custom measure calculation 
is performed for all the members in the selected axis.
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❑ Dimension level - Here the custom calculation is performed across all the members of the selected dimension.

Using Arithmetic Functions in a Custom Calculation

You can use the following arithmetic functions for custom calculations:         

Creating a Custom Measure at an Axis Level

To create a custom measure,

1 Select a dimension member. 

2 Click on the AutoSum  button for a summation of all the data values for the members in the selected axis. 

Click on the drop-down list arrow next to the AutoSum button. The following arithmetic function options 
are displayed:

3 Select a function that you require. The custom measure is displayed, 

• in the last row if the selected axis was Column

• in the last column if the selected axis was Row.

Example

This example illustrates creating a custom measure on an axis. The custom measure has been created by first clicking 
on Sales and then on the AutoSum  button.

        

Custom Measure = SumOfAllRows

Calculation = Sum of all the values 

Creating a Custom Measure at a Dimension Level

To create a custom measure at a dimension level,

1 On a workspace grid, select a dimension header. 

2 Click on the arrow next to the Sigma button. The arithmetic function options are displayed. 

Table A-12: 

Arithmetic Functions Description

Sum Returns the addition of all the values for the dimension members in the selected axis. 

Average Returns the average of all the values for the dimension members in the selected axis. The average 
is the sum divided by count. 

Count Returns the count of all dimension members at the selected dimension or axis level. 

Maximum Returns the highest value of the members in the selected dimension or axis.

Minimum Returns the lowest value in all the members in the selected dimension or axis. 
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3 Select the Advanced option. The Calculation dialog box opens.

4 Enter a name for the custom measure in the Display name field.

5 Select an arithmetic function from the Calculation type drop-down list.

6 The Select dimension drop-down list shows all the dimensions present on the grid. Select a dimension to which you 
want the calculation to be applied.

If you select None, then the calculation rule is applied to all the members on the axis opposite to the selected axis.

7 Select a position to place the custom measure on grid. The options are:

• As first member - places the custom measure before the first member of the dimension selected.

• As last member - places the custom measure after the last member of the dimension selected.

Note If the calculation is applied to an inner dimension, then the custom measure is displayed either as the first 
member or last member for every dimension group.

Example

This example illustrates creating a custom measure for the Product dimension at a dimension level. 
        

This screen shot shows the calculation type, dimension, and the position of the custom measure selections.
        

The custom measure is displayed on the grid.
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Custom Measure = SumOfSales

Selected Dimension = Product

Important Notes on Custom Measures
❑ Custom measures are local to the report in which they are created.

❑ Custom measures would not be supported for asymmetric dimensions and also if the axis, on which the custom 
measures will be placed, is asymmetric.

❑ If a custom measure is added and then if any of the dimensions on the same axis is made asymmetric, the custom 
measure for that axis would be removed.

❑ To save the custom measure to a report, a save state has to be performed.

❑ A custom measure can be removed by using the Remove only option provided in the Right-click menu.

Impact of other features/operations on custom measures

The following features and operations are not supported for custom calculations:

• Saved Selections

• Shared Dimensions (Axis level calculated measures)

• Asymmetric Report (asymmetric on the same axis as the custom calculation)

• Alert

• Keep only

Grid Data Filters

Grid data filters allow you to filter the data while working on a report. Filtering is a quick and easy way to find and 
work with a subset of data in a report. A filtered range shows only the data that meets the criteria you specify while 
temporarily hiding the rest.

By defining different filters, you can compare data in multiple ways, and extract necessary information without 
wasting vital time.

The Grid Data Filter feature is explained in the following sections:

❑ “Working With Grid Data Filters”

❑ “Applying A Filter”

❑ “Removing A Filter”

❑ “Example - Using RPM Grid Data Filters to Analyze Sales Data”
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Working With Grid Data Filters

You can use filters for different purposes. 

❑ Filter data for particular numbers or text. 

❑ Filter for the highest or lowest numbers. 

❑ Create your own custom filters to find ranges of numbers, text inside other text, and more, based on certain 
conditions.

You begin by deciding what you want to see. Suppose you have a grid of sales records that lists the product, and 
region for each sale. You can focus on the sales in one region, or the sales of one product, or view only a section of 
the sales numbers that interest you.

Applying A Filter
1 To apply filters, click the Data Filter Display button. 

drop-down list filter arrows now appear to the right of the row/column headings in the grid.

2 On clicking the arrow, the following options appear:

• All - removes the filter for a particular row/column

• Top/Bottom - filters the top or bottom members by values or percentage

• Conditional - enables adding a condition to the filter

• A list of the first 15 unique values as visible in the report

Note Only the first 15 unique entries in a list appear when you click the arrow.

A column on which a filter is applied is indicated with a blue dropdown arrow.

Filter by cell values
1 Click the filter arrow. A list of the first 15 unique values in that row/column is displayed.

2 Select the value by which you want to filter data.

Filter for Top or Bottom members

You can filter the top/bottom members in a grid based on their values. For example, you might want to filter the top 
10 products by sales amounts or the bottom 5 regions by revenue. 

Note The Top/Bottom option is visible only on the column axis and not on the row axis. 

1 Click the filter arrow on the column headings, and then select Top/Bottom. 

      The Top / Bottom Filter dialog box opens.
      

2 In the drop-down in the left, select Top or Bottom as required.
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3 In the list in the middle, type a number to specify how many members you want to keep in the filtered report. 
For example, to retrieve the top/bottom 5 products, type 5.

4 In the list in the right, select Values or Percentage as required

5 Click OK.

Adding a Condition to the Filter
1 Click the arrow in the column or the row that contains the values, and click (Conditional). 

The Conditional Filters dialog box opens.
      

2 In the list on the left, select any of the following options as required: 

• Equals, does not equal 

filters for a number equal to or not equal to another value

• is greater than, is less than, is greater than or equal to, or is less than or equal to filters for a number greater than or less 
than another number

• begins with, does not begin with, end with, does not end with, contains, does not contains to filters for the beginning or end 
of a text string

If you need to find text values that share some characters but not others, use a wildcard character.

3 In the list on the right, select a number or enter the text you want. 

4 To add another criteria, click And or Or, and repeat the previous steps.

Removing A Filter
❑ To remove a filter applied to a column, 

Click the drop-down list arrow next to the column, and then click All.

❑ To remove all the filters applied on the report, click on the Data Filter Display  button again on the toolbar.

Example - Using RPM Grid Data Filters to Analyze Sales Data

When you frequently glance at the workspace grid, it is difficult to see the trends in the data. 
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You need to start filtering through the data.

Turn on Grid Data Filters

Click Data Filter Display on the toolbar. drop-down list arrows now appear in the column/row headings in the 
workspace grid.

        

Look at Sales data for a specific product

Click the drop-down list arrow to the right of Product.

In the list, click Mountain.
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You now have a filtered grid of the sales data for the product Mountain alone across time periods. Note that the other 
data in the grid is not visible as it is temporarily filtered out.

       

Find the top 3 sales 

Next, you want to see the top 3 sales for the product Mountain in the region United States.

1 In the Sales column corresponding to United States, click the arrow, and then click Top/Bottom.

The Top/Bottom Filter dialog box opens. 

2 In the list in the left, select Top.

3 In the list in the middle, enter 3.

4 In the list in the right, select Values.

5 Click OK.

You now have the top 3 sales for the product Mountain in United States in the report.

Find all sales that were less than 8,000,000

Now you want to show all sales that were less than 8,000,000- to see where future opportunities may lie. To do this, 
use the Conditional option.

First, return to the complete workspace grid:

1 In the Sales column, click the drop-down list arrow. 

2 On the list, click (All). 
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Next, apply the filter:

1 In the Sales column, click the arrow, and then click (Conditional...). 

The Conditional Filters dialog box opens. 

2 In the list on the left, select Less than. 

3 In the list on the right, type 8,000,000. 

4 Click OK. 

Now you have a list of sales that were less than 8,000,000.

Impact of other features on grid data filters

The following table outlines the impact of grid operations on grid data filters:
        

A workspace grid in its filtered state can be also be saved. 

Save Changes

The ChangeCAST Application prompts you to save any changes that you made to the Workspace grid or chart when 
you try to move to a new page or when you try to exit from the workspace grid without explicitly saving your 
changes. 

The ChangeCAST Application shows the following message that prompts you to save your changes on a workspace 
grid or chart:

        

Table A-13: Impact of grid operations on Grid Data Filters

Operation Supports grid data filters

Keep Only No

Remove Only Yes

Drill Down No

Drill Up No

Rank Yes

Sort Yes

Top/Bottom Yes

Swap Axis No

Pivot No

Changing members on Page Filters Yes

Add/Remove members using Basic/Standard Selector Yes

Move across axis No
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❑ To save your changes, click Yes. Clicking Yes in the unsaved page warning in the Workspace does not open the 
link that was clicked.

❑ To move to a page that you clicked without saving your changes, click No.

❑ To return to the page on which you made changes, click Cancel.

Canceling A Query

While working with the ChangeCAST Application, every time you perform operations that requires retrieving data 
from Agile Analytics, like loading a new workspace page, grid operations such as Drill down, Drill up, Keep Only, 
Remove Only, or, configuring a report using ChangeCAST Selector, the application shows the following dialog box:

       

This dialog box indicates that the application is querying Agile Analytics for data to load the Workspace based on 
the operation you performed. ChangeCAST Application sends a query to Agile Analytics to retrieve the data that you 
requested. 

You can choose to cancel the operation if you think that the process is taking a long time to retrieve data to the grid 
or if you wish to perform some other operation.

To cancel a query, click Cancel. The application shows the following message:

The query has been cancelled

There are various states in the Cancel message.

❑ If you click Cancel in the dialog box before the query is even transferred to Agile Analytics the application shows 
the following dialog box:

        

To cancel the query, click Cancel. 

❑ If you click Cancel in the message window when the query has already been processed by Agile Analytics, but 
before ChangeCAST Application renders the data, the application shows the following dialog box:

       

To cancel the query, click Cancel. 
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To save a copy of the Workspace:

1 Click the  Save As button. The Save Workspace window opens.

       

2 Enter a title for the Workspace in the Title field.

3 Enter a description for the Workspace in the Description field.

4 To save the Workspace in a specific folder, click the  Select Folder button. The Select Folder window opens 
showing a list of all the folders created in the application. You can drill down on the main folders to view the sub 
folders. Select a folder from the list.

5 The Copy Cell Notes field enables you to copy the cell notes of the original Workspace to the copy that you are 
saving. 

Select Yes to if you want to copy cell notes. Else, select No.

If you select Yes, then all the cell notes on the Workspace grid that you are saving are copied to the new 
Workspace.

6 Click Cancel to exit from the Save Workspace window without saving your selections or click OK to accept and save 
your selections.

All the pages or reports of the workspace are saved as a new copy of the workspace. The saved copy of the 
workspace opens showing the page you did a Save As operation on. 

You can save the Workspace in the same folder or in a different folder.

Tip Saving a copy of the Workspace with a different name is a quick way of creating a new Workspace that is 
similar to an existing Workspace.

Toolbar Buttons
The buttons assist in performing various functions related to workspaces. The Workspace has the following sets of 
buttons on the toolbar:

❑ Common toolbar buttons

❑ Pane-specific toolbar buttons
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Common Toolbar Buttons

The buttons on the common toolbar assist in performing functions related to what-if analysis of workspaces. This 
section provides detailed information on the functionality of the following buttons on the common toolbar:

❑ Pane-Specific Toolbar Buttons  

❑ Execute  

❑ Export to Data File  

❑ Export to Excel  

❑ Export to PowerPoint  

❑ Print  

❑ Collaborate  

❑ Workspace Properties  

❑ Save As  

❑ Workspace Properties  

Collaborate

The workspace enables you to collaborate with one or several recipients for information sharing and concurrent 
problem solving. 

To attach and send a workspace to one or several recipients:

1 Click the  Collaboration button. The New Message window appears. 
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When you collaborate a workspace, the recipients can enter UEVs (User Entered Values) on the workspace from 
which the collaboration was started. The UEVs can be entered only on the cells that are accessible to the recipients. 
The cells that are accessible to the recipients are displayed in a field indicating that the recipient has access to it.    

The attached Workspace in the Message can be viewed when the recipient opens the collaboration and clicks on the 
attached Workspace in the View Attachments dialog box. The runtime view of the Workspace opens as a window. 

Execute

The  Execute button enables you to execute the auto execute rules that commit all the derived values for which 
the Auto Execute Rules are applied and submit it for approval and implementation. For details, see “Executing Auto 
Execute Rules”.

Export to Data File

You can export specifically defined data that can then be used as inputs for applications like space planning. The data 
is formatted based on a predefined template that comprises specific dimensions and measures as required for your 
business needs. This template is referred to as the export template. You can use the export template to select 
members for the predefined mandatory dimensions and then export this data which can be downloaded and saved 
on your local file system. 

The predefined export template contains the following:

❑ Model information

❑ Dimensions

❑ Measures 

❑ Selection constraint rules. For example, rules that specify the level from which members can be selected in the 
export template.
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To export template driven data:

1 Click the  Export to Data File button. The Export Template dialog box opens.

        

2 The Dimension list drop-down lists all the dimension specified in the template. Select a dimension from the 
Dimension list.

3 The Dimension Members list shows the dimension hierarchy of the selected dimension. Select the members that 
you require and move them to the Selected Members list using the appropriate arrows. You can also do a function 
based selection of members. See “Adding Members to the Axes by Relationship” for details. 

For information on using the buttons to move dimension members between the Dimension Members list and the 
Selected Members list, and the Reset and Search buttons, see “Create Selection Window Components”.

When you add members, the application validates your member selection with the selection constraint rules 
specified in the template. Only the members matching the constraint rules are added, else the application shows 
a message that the selection is not allowed and specifies the level at which you should select members.

Note The pre-defined measure members are auto-populated in the Selected Members list. However, you can still 
add and remove measure members. 

4 The Export file format drop-down list shows the following supported formats for the exported data:

• Comma separated values - the values are separated by commas. This is the default selection.

• Tab delimited - the values are separated by tabs.

Select the format that you require.

5 The Data suppress options provides the following options:
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• Skip null values - does not display cells containing null values in the exported data.

• Skip zero values - does not display cells containing zero values in the exported data.

6 The Click to download export file option allows you to download the exported data file to the required location on the 
your local system. Click the Download link to save the exported data file to your local system.

7 The Links folder option allows you to download all the exported data file from the Links folder in the application. 
Click the Select folder button to specify the folder in which you want to links to be stored. 

8 The Select Folder dialog box opens showing all the folders in the Links module to which you have access. Select a 
folder that you require and click OK.

9 Click Export to export the data file or click Cancel.

Export to Excel

You can export a grid to a Microsoft Excel spreadsheet in order to perform other calculations or Excel specific 
actions. 

The reports on the current page that you are viewing are exported to Excel. For multi-pane reports in a workspace 
page, each Excel worksheet will contain a single pane report and there will be as many worksheets as the reports on 
the page that you are currently viewing. The worksheet would display the names corresponding to the report names 
on the workspace page.

To export grid data and charts to an Excel spreadsheet:

Click the  Export to Excel button on the common toolbar. The grid data and the charts are exported to Excel as 
displayed below.

        

Note Reports containing grid data and charts are exported to excel. If a report that contains indicator, text, or 
member panes is exported, the application shows the following message:
Only reports with grids and charts will be exported to excel.
On clicking OK, only the reports with grid data and charts are exported.

You can adjust the cell size for the entire grid to the exact size required to fit a data in a column. Cells are initially of 
equal size. The default size is large enough to show all data. However, cell size can be changed by moving the divider 
bars on the grid (this might cause data to be truncated). Resizing cells adjusts any column to ensure that data is 
displayed completely. The RPM application enables you to resize cells by using macros that resize and format the 
cells on the exported Excel data. 
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To load macros into the exported Excel workbook, access the renderer.properties file at the following 
location:

<RPM_APP_ROOT>/config/renderer.properties

In the renderer.properties file, set the following property to true:

ENABLEMACRO_IN_EXCEL = true

Export to PowerPoint

You can export reports to Microsoft PowerPoint. These reports are displayed as charts on the PowerPoint slides.

Only the reports on the current page that you are viewing are exported to PowerPoint.

To export grid data and charts to an PowerPoint:

Click the  Export to PowerPoint button on the common toolbar. The grid data and the charts are exported to 
PowerPoint as displayed below.

        

Note Reports containing grid data and charts are exported to PowerPoint. If a report that contains indicator, 
text, or member panes is exported, the application shows the following message:
Only reports with grids and charts will be exported to PowerPoint.
On clicking OK, only the reports with grid data and charts are exported.

Print

When you create or work with a report, you might want to archive or share that report for further analysis or 
comparison. The RPM application provides the flexibility to save the report in an easily usable and a printable format 
like a PDF or an HTML file.
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You can also define the various print properties like the orientation of the PDF report, page size, theme, and header 
and footer texts. For more information on setting the print options, see “Setting Printing Options.”

To print the workspace contents to a file:

1 Click the  Print button. The Print dialog box opens.

       

2 Select the format of the file in which you want to print the Workspace contents from the drop-down list. The 
available options are:

HTML — If you select the HTML option, the Select Pane drop-down list is disabled. This means the HTML 
document will contain all the panes of the report and are displayed in a sequence, Pane 1, Pane 2, Pane 3, and so 
on. Select HTML and click APPLY, a page is displayed as shown:
        

This is a view of a current active Workspace that can then be sent to a printer. You can print the Workspace using 
the Print button on the browser. You can also save the HTML files into a folder in the system.

Note The RPM application enables you to print the Workspace by exporting it in a format that is supported by 
Internet Explorer. The format of the printed Workspace may be slightly different from the original 
Workspace.
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PDF — You can print a report in Adobe Acrobat PDF file format. You can then print it, save it for later reference, 
or e-mail to others. 

To print a report in PDF file format, 

Select the PDF option from the File Format drop-down list. 

From the Select Pane drop-down list, 

• Select All Panes to print all the panes of a report in PDF file format.

Note The All Panes option is available only when Jreports is enabled.

• Select the pane that you want to print from the drop-down list.

Click OK. The Create PDF Report dialog box opens. Click Help on the dialog box for information on defining printing 
options.

If a grid in a report spreads beyond a page, then the report is wrapped providing a complete view of the grid. Rows 
and columns that fit in a page are displayed on one page and rest of the grid is displayed on the next page.

The Page Filters, if present, are displayed for the first set of rows and columns displayed on the first page. The 
Cell Notes, Cell Alerts, and Conditional Alerts present on the grid are also displayed in the PDF file.

A report that is printed in the PDF format appears as below:
       

Customizing the Logo 

You can customize the logo on the PDf file format. To replace the default logo with the logo that you require, 

1 Rename your logo image file as brand.gif.

2 Copy your image into the following directory:

<ALPHABLOX_INSTALL_DIR>\repository\theme\i

Note It is recommended that you use Adobe Acrobat Reader version 6.0 or 7.0.3. for viewing a PDF output of 
the report.

It is recommended that you do the following setup in the Internet Explorer File menu for printing in PDF 
format: 
Go to File > Print. Click Advanced tab and select the Print as image option.
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Refresh All

The Workspace module enables you to refresh all panes for a selected page in Workspace runtime. This feature is 
helpful when a pane uses a derived measure and needs to be synchronized whenever UEVs are entered on the related 
measure in a different pane on the same page.

To refresh all the panes for a page click the  Refresh All button.

All the panes in the page get refreshed with the data, containing the same derived measure or tuple, that you modified 
in the pane from where you performed the Refresh All function. 

For example, if you enter a UEV, and then perform a Refresh All, then all the panes that contain a relative measure of 
that UEV (derived measure or if the same tuple is used) get refreshed with the change that you made. 

The ChangeCAST Application provides the Auto Apply feature through which you can select the cells that have the 
values changed and click on Refresh in the pane tool bar or Refresh All at the workspace level. The selected cells' 
values get treated as changed values and get committed as UEVs or Scenario write-back values, as the case maybe.

Note The Refresh All function is page-specific. Multiple UEVs on different panes is supported. For example, on a 
three-pane scenario, if you enter UEVs on all the three panes, and perform a Refresh All, then all the panes 
are refreshed with the modified data.

Save

Click the  Save button in the Workspace page to save the grid actions, such as drill up, drill down, that you 
perform on the Workspace grid. 

Save As

You can save a copy of the Workspace with a different name. You can also save the grid actions, such as, drill down, 
drill up, etc., that you perform on the Workspace grid by clicking on the Save As  button.

Workspace Properties

You can define properties for the Workspace by clicking Properties . For details, see “Creating A Workspace”.

Pane-Specific Toolbar Buttons

This section provides detailed information on the functionality of the following buttons on the Pane-specific 
Toolbar:

❑ Calculator

❑ Create Alert

❑ Deleting an Operation

❑ Display Grid and Chart

❑ Edit

❑ Toggle Toolbar

❑ Execute Change Rule

❑ Import

❑ Toggle Toolbar

❑ Rank

❑ Refresh

❑ Refresh Auto On/Off
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❑ Remove UEVs

❑ Sort

❑ Toggle Report Information

❑ Toggle Toolbar

Calculator

The Calculator enables you to perform mathematical functions on the cells of the grid. The computed values are 
entered as UEVs in the selected cells. Click Calculator  to select the required function and set parameters. 

To calculate the values of the cells:

1 Select one or several cells and click the Calculator button. The Calculator dialog box appears:

        

2 Select the mathematical function to be performed on the selected cells from the Function drop-down list. The 
drop-down list shows the functions in an alphabetic order. The drop-down list contains the following 
mathematical functions:

The Table below shows the mathematical functions in the Function drop-down list:
        

Table A-14: Mathematical Functions    

Function Description

Add Calculates the sum of entered number with the contents of the selected cells.

Apply Copies the existing cell value to all the selected cells. It appears as if UEV was done on the 
selected cells.

Average Calculates the average of the selected cells and updates all selected cells with the calculated value.

Clear Updates the values in the selected cells to 0.

Constant Updates the values in the selected cells to the specified constant value.

Divide Divides the selected cells by the specified number.

Growth Applies the Growth Rate% between the start value and the last selected cell. All the cells in 
between the first and the last cell are updated accordingly.

Maximum Identifies the maximum value within the selected cells, and updates all the selected cells with this 
value.

Minimum Identifies the minimum value within the selected cells, and updates all the cells with this value.

Multiply Multiplies the selected cells by the specified number.
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3 Enter the required values for the selected function in the Value text field. The number of input parameters varies 
depending on the function chosen.

4 Optionally, select the Round to Integer checkbox to round off the cell values to the nearest integer. By default, the 
checkbox is not selected.

• Click Cancel to exit from the Calculator dialog box without making any changes.

• Click Apply to update the selected cells with the selected values.

• Click Close to close the Calculator dialog box.

The model is recalculated only when you click Refresh.

Note You can perform a calculation only on editable cells. If the cell that you selected is not editable, then the 
application shows the following message:
Calculator functions can only be applied to editable cells.

Create Alert

An Alert is a mechanism used to notify the user when a specified measure goes beyond pre-specified limits. The 
limits are the lower and/or the upper threshold values. The triggered alerts are made visible in the report using color 
coding. You can also receive alert notifications in your Alerts Inbox and through Emails.

Select a cell and click Create Alert  to create an alert for the cell. The Create Alert screen is displayed.

Prorate Takes the New Total you have entered, and system divides it by the Old Total, to calculate the 
new rate. All the selected cells are multiplied by this rate. [Rate=New Total/Old Total]

Slope The first selected cell is updated with the Start value and the last selected cell is updated with the 
End Value. For the cells falling in between, the values are calculated using the formula Updated 
Cn-1 + Slope where as [Slope=(End Value-Start Value)/No. of selected cells].

Subtract Calculates the difference between the entered number and the contents of the selected cells.

Table A-14: Mathematical Functions (continued)   

Function Description
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When an alert is triggered on a cell, the cell background color changes to the color you had specified when you 
created the alert.

You can also create an alert on multiple cells. For example, if you want to monitor percentage variations in costs for 
all products, select a range of cells and click Create Alert. 

An alert created in a report is available as an alert in all the other reports containing cells with the same participating 
dimension members as that of the current cell. 

Note Avoid adding a cell alert to a cell that has null value. 

Deleting an Operation

To delete an operation,

1 Click Delete  associated with the operation you want to delete. The operation is deleted.

or

Open the operation details dialog box by clicking on the operation title in the Report Information pane. Click Delete 
 on the summary information bar.

or 

Expand the operation. Review the details if needed, and then click Delete .

2 The application prompts you to confirm the deletion. Click OK to confirm or click Cancel.

Important Notes on Report Information

❑ You can save a report with the Report Information pane.
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❑ The Report Information pane is not displayed on printing a report.

Display Grid and Chart

Grid is a tabular view of a report with rows, columns and page filters. Chart is a graphical view of a report, such as a 
bar chart or a pie chart. Click Display grid and chart  to choose the display as required. The drop-down list 
provides the ability to choose the grid and/or chart view of the report using the following options:

❑ Grid

❑ Chart

❑ Grid and chart

Grid

Select Grid from the Display grid and chart drop-down list to display the grid view of the report. By default, this option 
is selected. 

A sample grid view is shown here:
        

Chart

Select Chart from the Display grid and chart drop-down list to display the chart view of the report.

The chart filters are displayed only when there are multiple dimensions along the rows or columns of the grid.When 
you click Display grid and chart button, all the inner most dimensions on the row/column axis display as chart axes and 
the other dimensions display as filters in the chart view. The last dimension in the column will be displayed in the 
X-axis of the chart and the last dimension in the row will be displayed in the Y-axis. If the rows or columns in the 
grid contain a single dimension, then no member will be displayed as a chart filter in the chart view.

A sample chart view is shown here:
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Note A selection on the filter in a chart is not saved by the Save or Save As feature. A filter in a chart always 
contains the first member in the dimension at that level. The chart view can display a maximum of 50 
members only.

Grid and Chart

Select Grid and Chart from the Display grid and chart drop-down list. Both the grid and the chart view of the report are 
displayed adjacent to each other. 

A sample view is shown here:
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Edit

Click Edit Report  to edit the workspace. The ChangeCAST Selector page opens. Edit as necessary. For details on 
working with the ChangeCAST Selector, see “Creating A Report”. 

Edit button is not available for Linked panes. For information on Linked panes, see “Sharing Dimensions And Axes”.

Note After you edit the report or cancel the operation, the Workspace runtime screen is displayed.

Editing an Operation

The Report information pane allows you to edit the following operations:

❑ Filter - Attribute and Value filters

❑ Top/Bottom

❑ Sort

❑ Rank

❑ Group by

To edit an operation,

1 The operation title functions as a link. Click the title, for example, Filter. A dialog box opens showing the 
operation summary information. Expand the summary information. 

       

2 Edit the operation details as required.

3 Click OK to save your changes, or click Cancel. You are returned to the workspace report.

Execute Change Rule

The Execute Change Rule  provides you with the ability to execute Change Rules on the cells of a report during 
a runtime session.

For more information on executing change rules, see “Using Change Rules”.

Import

To import a Saved Report, an Application Pane, or an Indicator, click Import . The Import window opens 
showing the folders containing reports. 
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1 The Select object drop-down list provides the following options:

• Saved Reports - A workspace into which a Saved Report is imported is similar to any other workspace except 
that the pane-specific tool bar shows only the Import and Tools buttons.

• Application Panes - For information on Application Panes, see the section on Application Pane in the Real-
time Performance Management Administration and Configuration Guide.

If the Application Pane that is imported is a Text Pane, then the pane as defined by the administrator is 
displayed on the grid as shown:
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You cannot edit a Text Pane on the grid.

If you have imported an Application Pane into a Workspace, you can create new dimension members or edit 
an existing dimension member in the Application Pane to perform an analysis. For more information, see 
“Creating A Dynamic Member”.

Note This button is not seen on the Workspace page after the Workspace is created.

• Indicators - You can import one or more indicators to a single workspace pane. Multiple indicators imported 
to a single workspace pane get placed in a horizontal alignment. 

You can drag and drop the indicators to align them as required. You can manually resize the indicators in a 
workspace pane or use the Zoom in and Zoom out options to resize the indicators.

A sample workspace pane with indicators imported is shown below:
       

2 Select the required option from the Select object drop-down list.
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3 The Select folder shows the folder structure in which the Saved Reports, Application Panes, or Indicators are saved. 
Navigate to the Saved Report/Application Pane/Indicator that you want to import and select it. 

4 Click OK to save your selections, else click Cancel.

Note If you are importing a Saved Report, the application shows the following message:
This will not update the workspace with the imported report unless 
saved. 
Click OK to continue.

5 The application shows the Workspace grid which loads the Saved Report/Application Pane/Indicator that you 
imported.

Manage Scenario

The Workspace module enables you to create a new version of the Workspace. You would want to create a new 
version of the Workspace if you want to evaluate other options.

To create a new version of the Workspace:

1 Click Manage Scenario  on the pane-specific toolbar. Alternatively, you can right-click on a cell and click 
Scenarios, and then click Manage Scenario. The Manage Scenario dialog box appears.

       

2 In the Create new scenario option, click Yes if you want to create a new scenario. By default, the value is set to No. 
When the value is set to No, New Scenario title field would be empty and it is mandatory to enter a version title in 
the New version title field before clicking OK. Also, Select folder value cannot be changed when the value is set to No.

3 If you are creating a new scenario, enter the Scenario title in the New scenario title field. The default value would be 
the current scenario title appended with ‘_copy’.

4 Enter the version title in the New version title field. The version title should be unique for that scenario.The default 
value would be v1.

5 The Copy values from version drop-down list allows you to copy UEVs from available versions of the current scenario 
member. Select the appropriate version from this drop-down list and the UEVs will be copied into the new 
version of the new scenario or the new version of the current scenario depending on whether you are creating a 
new scenario or a new version of current scenario respectively. Default value of this drop-down list is set to None.

6 The default folder for Select folder is the folder where the scenario that you are working on exists. To change the 
folder, click Folder and select a different folder in the Select folder window. Depending upon the access type of the 
current scenario, public or private folders will be accessible.
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7 Click OK to create the new version. This new version would be available for use as a regular member in the 
ChangeCAST Selector under the scenario member being used in the Workspace. Click Cancel to exit from the 
Create New Version dialog box without creating a new version.

Examples

1 Consider a workspace where Pane 1 uses Scenario A - version a, selected on Page axis (selected through Children 
function and if applicable, Descendents/Leaves functions) and Pane 2 uses Scenario A - version a, selected on 
Row axis (selected through Children function and if applicable, Descendents/Leaves functions). If you create a 
new version b for Scenario A, then Pane 1 will show Scenario A - version b (version a will also be available in the 
drop-down list), and Pane 2 will show Scenario A - version a and b on rows (version a will be appended).

2 Consider a workspace where Pane 1 uses Scenario A - version a, selected on Page axis (selected through Children 
function and if applicable, Descendents/Leaves functions) and Pane 2 uses Scenario A - version a, selected on 
Row axis (selected through absolute or explicit member selections). If you create a new version b for Scenario A, 
then Pane 1 will show Scenario A - version b (version a also in drop-down list), and Pane 2 will only show 
Scenario A - version a in the row axis.

3 Consider a workspace where Pane 1 uses Scenario A - version a, selected on Page axis and Pane 2 uses Scenario 
A - version b, selected on Page axis. (The above are selected through Children function and if applicable, 
Descendents/Leaves functions in Pane 1 and explicit or absolute member selections have been made in Pane 2.). 
If you create a new version c for Scenario A, then Pane 1 will show Scenario A - version c, and pane 2 will show 
Scenario A - version c in the Page axis as the current selection and version a and b would also be available in the 
drop-down lists in their respective panes.

4 Consider a workspace where Pane 1 uses Scenario A - version a, set on Page axis and Pane 2 uses Scenario B - 
version b, set on Page axis selected through absolute or explicit selections. If you create a new version c for 
Scenario A, then Pane 1 will show Scenario A - version c (version a also in drop-down list), and Pane 2 will show 
Scenario B - version b. 

5 Consider a workspace where Pane 1 uses Scenario A - version a and Scenario B – version b set on Row axis 
irrespective of absolute or function selection. If you create a new scenario, Scenario C, with base version c based 
on Scenario A – version a, then Pane 1 will now display Scenario C – version c in the row axis and the Scenario 
C and its version will replace both Scenario A and Scenario B and their respective version members.

Based on the above examples, the following are applicable:

❑ If a function (children/descendents/leaves) has been used to select the scenario version, then the system will 
append the newly created version to the list of the existing versions in the grid following the above documented 
behavior (Examples 1, 2 and 3 above)

❑ If no function (children/descendents/leaves) has been used to select the scenario version (Example 2 and 4 
above), then the system will

• Replace the scenario version with the newly created version if on Page Axis

• Not append the newly created version if on Row or Column axis.

❑ If multiple scenario members are being used, then only that scenario member will get affected for which a new 
version is being created (Example 4 above)

❑ The newly created scenario parent and its version member will replace existing scenario parents (if present) and 
their version members (Example 5 above).

Note You can abort the manage scenario process by clicking ‘Cancel’ and return to the report.
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Rank

The Rank feature allows you to rank the values of members of a selected dimension used in the grid based on the 
criteria that you define in the Rank window. You can choose to rank values of the dimension members either in 
ascending or descending order. The rank is displayed in the runtime grid as a new row/column.

As a prerequisite to working with the rank feature, make sure that surrogate members for all the dimensions 
members are created in the model that you are working with. Also, ensure that a new formula with a value equal to 
1 is defined while creating surrogate members for the dimensions.

Note While performing a rank operation on a dimension, say for example, Time, which contains a datatype that 
is different from the defined surrogate rank member, you could encounter a DataTypeMismatch error in 
the rank column. To avoid this error, use the following formula while creating the surrogate rank member 
for Time dimension:
Measure.@
To apply a rank operation on members in a custom hierarchy, specify a rule domain for the associated 
surrogated member.
Example: Time.*

To rank members in a dimension:

1 On a workspace grid, select a header in the dimension you want to rank. Click Rank . The Rank window 
opens.   

        

2 Enter a title in the Title field for the rank row/column that would be displayed on the grid.

3 The In order field enables you to choose the order in which the rank should be applied on the grid. The available 
options are:

• Ascending

• Descending

• None
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If you choose None, the rank column would follow no order and the ranking would be displayed randomly 
against the members where they occur on the grid. 

4 Use the options in the Position drop-down list to specify the position at which you want the rank column to be 
displayed on the grid. The available options are:

• After current member

• Before current member

5 To apply the rank to a group’s hierarchical level and to preserve the hierarchical grouping after ranking, select 
the Preserve hierarchy structure for ranked members option.

6 Preserve Grouping is applicable when you are ranking members from multiple dimensions. The Available 
Dimensions list shows the dimensions whose members would be re-arranged based on the sort criteria being 
defined.

To preserve grouping of members in a specific dimension, select the dimensions as required from the Available 
Dimensions list and move the selections to the Selected Dimensions list.

• To accept your selections, click OK. You are returned to the workspace grid to which the rank that you defined 
is applied.

• To return to the workspace grid without applying the rank, click Cancel.

Examples

Consider the following grid. This grid represents the Average Sales Price and the Gross Margin in all quarters of the 
year 2003 for the regions Rio De Janeiro and British Columbia. The Time dimension members are placed on the row 
axis, while Region and Measure dimension members are placed on the column axis. Note that Measure dimension 
members are placed in the inner dimension on the column axis. 

Let us rank the measure Avg Sales Price for the region Rio De Janeiro.
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1 Select Avg Sales Price under Rio De Janeiro and click on Rank . The Rank window opens.

       

2 Enter a title for the rank operation. This title is displayed on the header under which the ranks assigned to the 
values are displayed on the grid.

3 From the In order drop-down list, select Ascending.

4 Click OK.

Observe that the values of Average Sales Price are ranked and the rank is displayed in the runtime grid as a new row/
column beside Avg Sales Price column.

       

Let us look at a case where the ranking feature is applied to a grid on which a measure member is placed as an outer 
dimension member on the column axis. Observe that the measure Gross Margin is placed on the outer dimension 
of the column axis.
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If you now apply the ranking feature to the values of Gross Margin by selecting Rio De Janeiro, observe that the 
values of Gross Margin are ranked and the rank is displayed in the runtime grid as a new row/column beside Rio De 
Janeiro column.

        

Removing a Ranking Order

If a rank sequence has been set up and you want to see the members in their original order, then you can remove the 
rank sequence as follows:

To remove a ranking order:

Click Rank  on the pane-specific toolbar. The Rank window opens. Click Remove. The members on the workspace 
grid revert back to their original order.

Sorting and Ranking on the Same Axis

You can sort and rank members on the same axis. 

The order in which the members rearrange in the grid depends on the last applied operation and the sort and rank 
functions behave in the following ways:

❑ If sort was applied first in ascending order and rank is applied next in ascending order, then rank's order would 
be applied and vice versa. 

❑ If sort is applied first and then rank and the resulting order (of rank) does not change the sort order, then the sort 
button would be displayed.

❑ If rank is deleted, then the members should rearrange according to the applied sort and the Sort button should be 
displayed.

Example to illustrate sorting and ranking members on the same axis

Let us sort and rank the measure Avg Sales Price for the region Rio De Janeiro in the grid below.
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Sort on Avg Sales Price for the region Rio De Janeiro by following the instructions provided in the examples in 
the section “Sorting Dimension Members”. Next, rank the values of Avg Sales Price as explained in the examples 
in the section “Rank”. 

After you apply the sort and rank feature, observe that the values of Average Sales Price are sorted and ranked as 
displayed below.
         

Refresh

To recalculate a model and reload a grid after entering a UEV, click Refresh .

The grid is reloaded.

You can do multiple UEVs and then click Refresh.

The ChangeCAST Application provides the Auto Apply feature through which you can select the cells that have 
the values changed and click on Refresh in the pane tool bar or Refresh All at the workspace level. The selected 
cells' values get treated as changed values and get committed as UEVs or Scenario write-back values, as the case 
maybe. 

Refresh Auto On/Off

Retrieving data values from Agile Analytics for the operations performed on the grid requires some time depending 
on the size of the report. Based on your requirements you can either choose to set the workspace to automatically 
retrieve data values and load the report for every operation you perform, or manually refresh the report to retrieve 
data values after all the required set of operations.

The RPM application provides the flexibility to choose the automatic querying of data values from Agile Analytics 
using the Auto Refresh On/Off feature.

Click the Auto Refresh On/Off  button to toggle between the Auto Refresh On/Off state. By default, the Auto Refresh 
feature is set to On. The disabled state of Auto Refresh On/Off  indicates the Off state of the Auto Refresh feature.

When the Auto Refresh feature is set to Off:

❑ The workspace opens showing only the dimension member names on the report, without any data values.

❑ Functions like Top/Bottom, Sort or Rank are not applied. You can refresh the grid to view the values based on 
the functions applied on the grid.

❑ The Off state of the Auto Refresh feature would not impact the Scheduled reports.

❑ An editable grid opens as a non-editable grid.

❑ The imported reports will not inherit the Off state of the Auto Refresh feature.

Why you would want to set the Auto Refresh feature to Off:

❑ When you want to view the structure of the report with the dimension members, children, or sibling names even 
before viewing their values.

For example, consider a report from the Wheeling Cycles model which has the members 1994, 1995, 1996, 1997, 
and 1998 under the dimension AllTime. If you want to see the various members under the year 1996 and drill 
down on one of the quarters, huge reports would take a long time to retrieve data and load the report after every 
operation you perform. Setting the Auto Refresh operation to Off, will display the grid with only the member 
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names and no values, and thus, eliminates the time that the report takes to load the data values for every 
operation.

❑ When you want to set a combination of filters and then view the values for the entire set of filters instead of auto-
refreshing the report for every filter you select.

For example, consider a report from the Wheeling cycles model where you have defined the dimensions 
Region, Measures, and Customer for the page filter axis. Currently, let us assume you have selected the 
following filter dimension members:

• Brazil from the Region dimension

• Sales from the Measures dimension

• Bike Emporium from the Customer dimension

Now, changing the above definitions to Canada, Units Sold and Bicycle Warehouse in the respective 
dimension drop-down list results in the report being loaded after change in each dimension. This means that the 
report is loaded with data values twice before the actual report for the defined set of filters is displayed. To view 
the data values for the entire filter set, you can set the Auto Refresh feature to Off.

Remove UEVs

To remove a UEV you entered, select the cell on which the UEV was entered and click Remove UEVs  on the pane-
specific tool bar. You can select multiple cells to remove multiple cells in a single Remove operation.

Sort

The application allows you to rearrange the members of dimensions in a workspace grid by providing the sorting 
feature. You can use the sort feature to:

❑ sequentially sort members in a report based on the values of a single/multiple columns or rows

❑ sort dimension members by their corresponding member names

Click Sort  on the pane-specific toolbar to specify how you want to sort the items.

To sort members in a workspace grid,

1 Open the workspace you want to use and on the report grid select the column/row headers on which you want 
to base your sort.

2 Click Sort   on the pane-specific toolbar. The Sort window opens.

Note If you click Sort  without selecting a row/column header to sort, the application shows the following 
error message:
Select row or column header to sort.
Click OK to proceed.
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3 Select what kind of sorting you want to do.

• To sort by data values, retain the default By data value selection. See “Sorting by Data Value”.

• Select By member name to sort the list of members alphabetically. See “Sorting by Member Name”.

Note All grid actions that result in a query change, except for the Swap Axis operation, would not preserve the 
sort.

Sorting by Data Value

You can sort by data values either in ascending or descending order.

If you select to sort by data value, the Sort window appears as shown above:

1 The Sort by and Then by drop-down lists the member combinations from each row/column you selected to sort on. 

These drop-down lists allow you to select more than one column/row to perform the sort operation. 

Select the members you want to sort on based on your order of importance starting with Sort by and followed by 
Then By drop-down lists.

Note The display of the number of Sort by and Then By drop-down lists is controlled by the following system 
property:

MAX_SORT_DROPDOWN_ALLOWED = 3 
The default value is 3 and the application allows you to set a maximum value of 5.

The member combinations (columns/rows) displayed in the Sort by and Then by drop-down lists would be 
in the same order as selected from the grid.

2 You can select the order in which the sort should be applied to the grid. The available options are:
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• Ascending (default selection)

• Descending

While performing a multi row/column sorting, you can select only a single order of sorting, either ascending or 
descending. For example, if you select ascending as the sort order for the column/row that you selected from the 
Sort by drop-down list, then any further column/row selections would also be sorted in ascending order. 

3 To apply the sort to a group’s hierarchical level and to preserve the hierarchical grouping after sorting, select the 
Apply sort at each hierarchy level option. 

4 Preserve Grouping is applicable when you are sorting members from multiple dimensions. The Available 
Dimensions list shows the dimensions whose members would be re-arranged based on the sort criteria being 
defined.

To preserve grouping of members in a specific dimension, select the dimensions as required from the Available 
Dimensions list and move the selections to the Selected Dimensions list. 

A sort indicator is displayed on the rows/columns that are sorted. To reverse the order of the sort, click on the sort 
indicator. For multi-header sorting, this operation only reverses the sort order (ascending to descending and vice 
versa) for the entire sort group and does not reverse the nesting order of the headers used in a multi-header sort.

❑ To remove the sort operation, click Remove.

❑ To accept your selections, click OK. You are returned to the workspace grid to which the sort that you defined is 
applied.

❑ To return to the workspace grid without applying the sort, click Cancel.

Important points to note while working on data value sort

❑ The application allows you to select a member combination only once from the sort drop-down lists for a sort 
operation. Else, you are prompted to select different members for further selections.

❑ For a multi-column/row sort operation, make sure you select the dimension members from the same axis.

❑ Any sort operation defined in the runtime is reflected in the second page of the RPM Selector. See “Multi-column 
sort applied to a workspace report” under Examples.

Examples

Note All the examples display a cross section of the Workspace to provide a focused view.

Single column sort applied to a workspace report

This example illustrates a sort operation on a single column. In the grid given below, the column United States 
represents the sales for United states. This column is selected to sort on.
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The following grid illustrates the resultant grid after the sort operation is performed on United States. Note that the 
cell values are sorted in ascending order and a sort indicator illustrates the operation.

        

Multi-column sort applied to a workspace report

This example illustrates a sort operation on multiple columns on the grid. In the grid given below, the column Adult 
Helmet are selected to sort on.

Note For all the nested columns/rows in a multi-header sort, the sorting would be applied only in the context of 
the common values in the preceding sorted column/row. 

       

The sort criteria is defined as illustrated below.
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The following grid illustrates the resultant grid after the sort operation is performed on the Sales of Adult Helmet. Note 
that the cell values are sorted in ascending order and a sort indicator illustrates the operation.

         

For a multi column sort, as illustrated above, the values of the first selected column, Sales of Adult Helmet, is sorted in 
ascending order. The second selected column, Margin is sorted next for the repeating values in the preceding sorted 
column, in this case, for the sales values of 600,000.

The sort criteria defined for this sort operation is reflected in design time as illustrated below.
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Note that the based on dimension for the above sort criteria is Product.

You can do the following on design time:

❑ Click the Edit button to edit a based on criteria for the sort operation 

❑ Click the More button to add further sort criteria and to select a based on dimension

Sorting by Member Name

The sort feature enables you to sort based on member names either in the ascending (A-Z) or descending (Z-A) 
order on the workspace grid.

If you select to sort dimension members by member names, the Sort window changes dynamically to display as 
shown below:

      

1 The Sort drop-down list shows the dimensions that are on the axis opposite to the axis from which the Sort 
window was launched. Select the dimension that you want to sort by.

2 Select either Ascending (default) or Descending as the sort order.

3 Click Remove to remove the previously applied sort.

Click OK to see the sorted results on the workspace grid.

Click Cancel to return to the workspace grid without applying the sort.

Examples

Note All the examples display a cross section of the ChangeCAST Workspace to provide a focused view.

Sorting by member names 
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Consider the following grid. This grid represents the Average Sales Price for the regions Rio De Janeiro, British 
Columbia, Ontario, and Illinois for the months Jan, May, Aug, and Nov in the year 2003. Time dimension members 
are placed on the row axis, while Region and Measure dimension members are placed on the column axis. 

       

Let us sort the Time dimension members by member names in ascending order. 
       

An Ascending order Sort button is displayed on Avg Sales Price to indicate that an ascending order (A-Z) sort has 
been performed.

Toggle Report Information

Report Information enables showing information pertaining to the operations applied and events performed on the 
report. Report information shows information pertaining to the following operations and events in a format:

• Filter

• Top/Bottom

• Sort

• Rank

• Grid Data Filters

• Custom Measures

• Saved Selections

• Grouping

• Drill Up/Drill Down

To display report information:

On a workspace report, click Report Information  on the pane-specific toolbar.

The Report Information  functions as a toggle. You can hide or display report information as required by clicking 
on this button. You can also refresh the report information with any events performed on the grid by clicking on this 
button.

The report information is displayed in the Report Information pane as shown below:
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A summary of the operation details is displayed on the Report Information pane. The operations are displayed 
sequentially in the order in which they are applied. The text is truncated for lengthy information and hence you can 
mouse over the information to view the complete details.

You can perform the following tasks from the Report Information pane: 

❑ “Toggle Toolbar”

❑ “Create Alert”

Toggle Toolbar

Click Toggle Toolbar  to toggle the display of buttons on the pane-specific toolbar or use the Toggle Toolbar option 
in the right-click menu. 

The toggled state of the display of buttons can be saved for the Workspace using the Save option. For more 
information, see “Workspace Properties”.
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